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MMDSHelp 

Welcome to MMDS for Windows 

This online help file will offer you help with the MMDS for Windows software suite. You can find help 
by clicking on one of the tabs in the left-side frame of this Help program… 

 

 Table of Contents: The Table of Contents displays topics in a hierarchy. Double-click on a topic to 
display its help contents. 

 

 Index: You may scroll through the index until you find a topic about which you want help. Choose a 
topic by double-clicking it. 

 

 Search: You may enter keywords for a search. Choose a topic from the search results by double-
clicking on that topic. 

 

What is MMDS for Windows? 

MMDS for Windows is a suite of software provided by NCHS to help coders input ICD-10 cause of death 
codes for statistical purposes. MMDS for Windows is a 32-bit Windows © application that takes the place 
of any previous versions of MMDS software distributed by NCHS. Three main programs make up the 
MMDS software suite: SuperMICAR, MICAR200, and ACME/TRANSAX. An older data-entry 
program, PCMICAR, has been set aside in favor of the more robust SuperMICAR. 

 

SuperMICAR Automates data entry and medical cause-of-death data processing, including 
reporting procedures, full-screen data entry and editing, and additional 
information processing. SuperMICAR is designed to automatically encode 
medical cause-of-death data into numeric entity reference numbers in 
accordance with the rules expressed in Part 2g of the Vital Statistics Instruction 
Manual (VSIM) series. SuperMICAR output is used by later programs to 
classify causes of death to their International Classification of Death (ICD) 
codes. SuperMICAR only runs on IBM-compatible personal computers. 

 

MICAR200 Automates the multiple cause coding rules (see Part 2b of the VSIM series) and 
assigns ICD codes to each entity. 

 

ACME/TRANSAX Applies World Health Organization (WHO) rules to the ICD codes determined 
by MICAR200 and selects an underlying cause of death (see Part 2a and 2c of 
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the VSIM series). Facilitates the tabulation and use of multiple cause-of-death 
data. Through the application of the ICD linkage and modification rules, 
ACME/TRANSAX translates the axis of classification from an entity to a record 
base. 

 

System Requirements 

The MMDS for Windows software (SuperMICAR, MICAR200, and ACME/TRANSAX) requires 
user PCs to be running a 32-bit operating system (Windows95, Windows98, WindowsNT, 
Windows2000) with at least the following minimum hardware specificiations: 

• IBM or IBM-compatible PC. 

• Pentium 166 MHz processor. 

• 32M RAM 

• Hard Drive with adequate available space (100MB of free space is recommended) 

• Color monitor, with screen resolution set to 800 x 600 pixels or greater, using standard Windows 
(small) fonts. 

• CD-ROM drive for installation (not required, but highly recommended). 
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Help! – Accessing MMDS Help Topics 

An important feature of the MMDS for Windows software suite is the integrated electronic help 
documentation (which you’re now viewing). This help documentation explains how to use the programs 
and offers users help with common tasks. While running one of the programs in the MMDS suite, either 
press {F1} or Press {Alt+H} to jump directly to the help "Contents" view. From the contents view, you 
can choose the "Index" tab to find a help topic by keyword. You can choose the "Search" tab to perform a 
more exhaustive search through all the help topics. 

 

 

Contents: The "standard" Windows help view, listing the contents of the online help in Table of Contents 
format. By pressing the forward arrow (>>) in the contents view, you can read through the help files in 
topic order, much like you would read through a book. 

 

Index: The index view allows you to search through a list of indexed words for a specific term (e.g., 
"Delete"). The index will list any topic titles containing that term throughout the online help 
documentation for the MMDS suite. 

 

Search: To use the search function, go to Help Contents view and click the "Search" tab. The search view 
allows you to search a database containing every word in the entire online help files. While the index lists 
only topic titles, the search database also searches the text WITHIN the individual help topics. Very 
specific terms (ones that might appear within a topic but not in the topic title) can be found using the 
Search window. 
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About: The "about" box gives important information about the version number for the MMDS 
program(s). This information can be vital to our technical support staff assisting you with any program 
difficulties. The "about" box is also a fast way to find the NCHS technical support phone number. 

 

Technical Support for MMDS Software 

If you’re having difficulty using the MMDS software, your state’s System Manager may be able to 
help. The System Manager generally has greater knowledge of state-level activities and may know 
more about your particular situation (e.g., data paths and file names). 

 

Another good source of information is this help documentation you’re reading now. This 
documentation offers help and detailed instructions for using all three programs of the MMDS software 
suite (SuperMICAR, MICAR200, and ACME/TRANSAX). The help documentation also includes a 
section to help System Managers understand more technical aspects of the MMDS software (working 
with paths, repairing files), and additional support documents that you may find useful. 

 

If after reading the help documentation you still have questions about any of the MMDS programs, or 
if you need to order additional NCHS software, please call or e-mail NCHS at: 

Software Helpline: 1-800-642-8908 

E-mail: MICAR@CDC.GOV 

 

Or, if you have data entry or coding questions: 

Nosology Helpline: 1-800-235-1830 

E-mail: ICD10@CDC.GOV 

 

SuperMICAR 

Purpose of SuperMICAR Help Documentation 

The SuperMICAR section of this help documentation is intended for data entry and data processing 
personnel. It contains instructions for using SuperMICAR to enter cause-of-death information and to 
process that information, including reject processing. It is organized to help SuperMICAR users (even 
new users) perform common data entry tasks. Therefore, most of the topics in this help documentation 
contain all of the instructions necessary to perform a given task at once. 
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Basic Steps for using SuperMICAR 

SuperMICAR is designed to allow both data entry and data processing through the menu system. When 
collecting and processing data through SuperMICAR, certain steps should be followed in order to 
guarantee the best results with the least wasted time. What follows is a general outline of the 
MINIMUM data entry and processing steps for SuperMICAR. SuperMICAR contains several utilities 
and reports that are helpful in validating data and tracking data entry and processing. For more about 
these useful functions, see Expanding SuperMICAR Functionality. 

 

1. Start SuperMICAR (see Starting SuperMICAR). 

 

2. Open a certificate file (see Creating a New SuperMICAR File or Opening an Existing SuperMICAR 
File). This step opens a file so that data can be entered and processed. You can either open an existing 
file or create a new file. With very few exceptions, every function of  SuperMICAR requires that a file 
be opened before the function can be performed. 

 

3. Edit the certificate file header information as needed (see Creating a New SuperMICAR File). The 
header information contains constant data that is the same for every record in the certificate file, such 
as the data year and the state code. 

 

4. Add certificates to the certificate file (see Adding Certificates Using SuperMICAR). This is the main 
data entry process. Data can also be read into SuperMICAR from properly formatted files. Information 
on importing and exporting data is contained in the System Manager’s Guide (See Importing from an 
ASCII File, Exporting to ASCII Files). 

 

5. Correct marked misspellings/illegible entries (see Correcting Misspellings/Illegibles). This function 
allows the user to go directly to those records that were marked as having misspelled or illegible words 
and correct them. Someone other than the person who entered the certificates should correct the 
misspellings and/or illegibles. This function may be used before processing the file. 

 

6. Process the certificate file. When a file is processed, SuperMICAR attempts to assign entity reference 
numbers (ERNs) to the medical causes of death that were listed in the certificate file. The three types 
of processing that can be done using SuperMICAR are explained below. 
Note: If any editing has been done to the file (including adding additional information), the entire file 
must be processed (see Processing Records using SuperMICAR) before "Generate MICAR200" (step 
7) is possible. 

A. Process the entire file (see Processing Records using SuperMICAR). This process 
attempts to assign entity reference numbers (ERNs) to all of the medical causes of death 
for each record in the open certificate file. This process is done wholly by SuperMICAR, 
requiring no input from the user. 
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B. Process the rejects (see Processing SuperMICAR Rejects). Processing rejects - an 
optional step in processing - requires a trained MICAR data entry coder. Under reject 
processing, SuperMICAR displays any records that were rejected by the Processing 
Records function. A trained coder stepping through the rejected records can examine 
each record and make the changes necessary to allow the record to be coded. In order to 
preserve the original data, modifications can be made on the Additional Information 
Screen (see Adding/Editing Additional Information).  

 

C. Process Additional Information (see Processing AI using SuperMICAR). This function 
processes just the certificates with AI. 
Note: If any editing has been done to the file (including adding additional information), 
the entire file must be processed (see Processing Records using SuperMICAR) before 
"Generate MICAR200" (step 7) is possible. 

 

7. Generate MICAR200 file (see Generating a MICAR200 File from SuperMICAR). This file is used by 
other MICAR software to continue the process of encoding cause-of-death data. 

 

8. Create backup(s): 

A. Create a SuperMICAR backup (see Creating SuperMICAR Backups) and proceed to 
further processing using MICAR200. 

or 

B. Create a backup for shipment to NCHS (see Creating SuperMICAR Backups for NCHS). 
This function creates a compressed ("zipped") file that can be shipped to NCHS. The 
compressed file contains all of the files that were created by SuperMICAR (including the 
MICAR200 file generated in the previous step). 

 

9. Close the certificates file (see Closing a SuperMICAR File). 

 

10. If there are other certificate files to process, repeat steps 2 through 7. 

 

11. If there are no more files to process, exit SuperMICAR (see Exiting SuperMICAR). 
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Flow Chart: Steps in SuperMICAR Processing 
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Expanding SuperMICAR Functionality 

In addition to the basic SuperMICAR functions, most of the following functions can be used at any 
time with SuperMICAR. Most of these functions require a certificate file to be open. See the individual 
help topics for more details. Note that additional SuperMICAR functions are described in the System 
Manager’s Guide section of this help documentation. 

 

1. View and edit the certificates in a file (see SuperMICAR Editing: An Overview). This function 
allows the user to edit information in the certificate database, which may be necessary at any time. 

 

2. Delete a certificate while editing (see Deleting SuperMICAR Certificates While Editing a 
Certificate File). This function allows the user to remove a record from the certificate file or delete 
several certificates at once. This function also allows the user to remove a block of several records 
from the certificate file. Use this option if an error has occurred and several certificates have been 
entered into the wrong file. 

 

3. Generate a sequence check (see Generating a SuperMICAR Sequence Check). This function 
generates a report that checks the sequence of the certificate numbers in the file. It is useful in 
determining if all of the records that should be in the file have been entered, if unwanted records 
have been entered, or if records have been entered with an incorrect certificate number. This 
function can be used at any time, but is most useful between data entry and processing to 
determine if the file is complete. 

 

4. Print a list of errors detected during last processing (see Printing a SuperMICAR Error Listing). 
This function prints a report listing all of the certificates that were not completely processed by 
SuperMICAR. This report may be useful to the person who will perform reject coding. 

 

5. Print selected certificates for review (see Printing a Single SuperMICAR Certificate). 

 

6. Create a daily backup (see Creating SuperMICAR Backups). Backups should be made to prevent 
accidental loss of data. NOTE: Backups should be made daily! Backing up data is the only 
protection available against losing data due to a failed computer system. At a minimum, it is good 
practice to back up the certificate file at the end of every day - periodically throughout the day 
would be even better. 

 

There are more Menu Options and functions available in SuperMICAR than will be used by data entry 
personnel. Some of these other Menu Options and functions will be used by the system manager. 
System Managers will find more detailed instructions in the System Manager’s Guide section of this 
help documentation. 
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Getting Started in SuperMICAR 

Starting SuperMICAR 

1. To start using SuperMICAR, double-click the SuperMICAR icon 
on your desktop. 

  

2. The main menu screen will be displayed. See Using SuperMICAR Menus for 
more details on the main screen and the Menu Bar. 

 

When the main screen appears, SuperMICAR is ready to use (see Creating a New SuperMICAR File 
or Opening an Existing SuperMICAR File). SuperMICAR will "remember" the last file that was 
opened, so unless the previous file was specifically closed (see Closing a SuperMICAR File) the last 
file will be open and ready each time SuperMICAR is started. 

 

About the SuperMICAR Main Screen 

The main screen of SuperMICAR has several useful features: 

  

 



 14 

1. At the top of the main screen will be the title - SuperMICAR. This line will also show the name of 
the current file if one is open (see Opening an Existing SuperMICAR File). On the far right of this 
first line you’ll also find the standard Windows controls for minimizing, maximizing, and exiting 
windows programs. 

 

2. The second line of the screen contains the Menu Options available in SuperMICAR. By looking 
under these Menu Options (e.g., clicking on "File" or pressing {Alt+F}) you’ll reveal available 
SuperMICAR functions. Note that functions currently unavailable will be "grayed out" indicating 
that they are inactive. See Using the SuperMICAR Menu System for more details. 

 

3. The bottom line of the SuperMICAR screen is the status bar, which displays the following 
information: 

A. In the bottom left corner, you’ll see a note about the {F1} key. Pressing {F1} will display 
the MMDS online help feature. The online help is designed to offer you the most 
appropriate help available for the function you’re using at that time. Accessing additional 
help topics is easy by searching by topic or keyword (See Help! - Accessing MMDS 
Help Topics). 
 
The lower left corner also displays useful information concerning the current process. For 
example, if you are editing a certificate, the lower left corner displays a message 
describing the field in which the cursor is located. 

 

B. In the bottom center, you’ll find a box that displays the status of the coder statistics 
option (on/off). 

 

C. In the bottom  right corner is a clock showing the current time and date. 

 

Using the SuperMICAR Menu System 

The functions of the MMDS software are available through a standard Windows drop-down menu 
system. This menu system allows users quick and easy access to various MMDS software functions. 

 

In addition to using the mouse to access menu items, there are two ways to access the menu:  

 

Alt+key: Pressing and holding the {Alt} key and then pressing the underlined letter key of a main 
menu item (e.g. "F" for the File Menu, "E" for the Edit Menu) will display the drop-down 
menu for that menu. Then you can use the up arrow and down arrow keys to highlight an 
item on the menu. Press {ENTER} to select the highlighted option. Use the left arrow 
and right arrow keys to open the submenus under each main menu option. Pressing 
{ESC} from a dropped-down menu closes the menu. Pressing {ESC} from the main 
screen will exit the program. 
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Hotkeys: Many functions can also be performed by pressing an associated Hotkey or "shortcut" 
key. The Hotkey assignments are shown on each drop-down menu and are also listed in 
the Master Hotkey List. Pressing a Hotkey will immediately access the associated 
function. For example, pressing {F2} will select the Open Existing File function. Hotkeys 
are a fast, easy way to access functions in the MMDS software. As users become familiar 
with the programs in the MMDS software suite, they will probably find the hotkeys 
convenient to use. 

 

To select a function from a drop-down menu: 

1. Use the mouse to choose the desired function by moving your mouse cursor over the appropriate menu 
item and left-clicking, or 

2. Use the up arrow and down arrow keys to highlight an option, or press the (underlined) letter of the 
desired function. The active (selected) function is highlighted. Pressing the selection letter will move 
the highlight bar to the corresponding function option. 

 

Not all functions are available at all times. In order to prevent users from selecting functions that 
should not be accessed during a particular process, the menu system will make certain functions 
available (active) or unavailable (inactive). When an option is inactive, it cannot be selected (the 
highlight bar will skip over that item and it's Hotkey will not function). 
For example: When a file is open, users will not be able to gain access to the Tools | Option screen. 
The open file must first be closed - because changing options can have a direct impact on opening and 
closing files. 

 

Creating & Opening Files in SuperMICAR 

Creating a New SuperMICAR File 

There are two ways to open a certificate file for use with SuperMICAR. The first way is by Creating a 
New Certificate File (see below). The second way is to Open an Existing File (see Opening an 
Existing SuperMICAR File). Before data can be entered into a certificate file, a file must be created 
and opened. To create a new certificate file: 

 

1. From the main screen, press {Alt+F} to select the File Menu Option. 
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2. Use the up and down arrow keys to highlight the New File Function and press {ENTER}. 

  

 

3. If a file is currently open, a message window will be displayed. 

A. To close the currently open file and open a new one, press {Y} and go on to step 4. 

 

B. To cancel opening a new file and keep using the currently open file, press {N}. The main 
screen will be re-displayed. Continue using SuperMICAR normally. 

 

4. A window will be displayed requesting a filename. Type in the desired 7-character filename 
(without the extension) and press {ENTER}. If a file with that name already exists in the data 
directory, a message will prompt you to choose a different name. A filename MUST be 7 
characters with no file extension (Example: NC03001). See File Naming Conventions for 
information on suggested file name conventions. 
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5. To accept the name for the new file, press "OK." A second window will then be displayed asking 
to confirm the name for the new file. To accept this name for the new file, press {Y} and the Edit 
Header Information Screen will be displayed. To reject this name, press {N} to return to the File 
Name dialog box. 

  

6. The Specify Header Information screen will be displayed (remember that the header information 
will be the same for each record in the file). After filling out all of the fields on the Header 
Information Screen, press {OK} to create the new file, or {ESC} to cancel creation of the file. For 
specifics on the Header Information fields, see below. 

  

 

Shipment Three characters to identify the batch when the file is sent to NCHS. The first 
character can be either alpha or numeric; the second and third characters must be 
numeric. 

 

Lot #  A number from 1-9999. 
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Section # A number from 0-9. This may prove very useful if you divide batches. 

 

Data Year Four-digit year from the death certificate. 

 

State Code A two-letter abbreviation identifying the state from which the death certificate 
originates. (For a full list of these codes, see NCHS State Code List). If the 
program does not recognize the code, it will display an error message and then 
show a pick-list of states. Entering a question mark {?} in this field will also 
cause the pick-list of states to be displayed. 

 

Coder Status A number from 0-9 used to identify the status of the coder. 

 

Example: Codes for a batch of certificates being processed for data year 2000, from the 
State of Alaska, with shipment number U03, lot 0002, and coder status 1 would 
have the following entries: 
Shipment U03 
Lot # 0002 
Section 5 
Data Year 2000 
State Code AK 
Coder Status 1. 

 

7. To save the header information and open the database file for use, press {ENTER}. The main 
screen will now show the new filename at the top. 

 

8. To exit the Header Information screen without saving, press {ESC}. The main screen will be re-
displayed. 

 

Opening an Existing SuperMICAR File 

Follow the steps below to open an existing SuperMICAR file: 

1. From the main screen, press {Alt+F} to select the File Menu Option. 
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2. Use the up and down arrow keys to highlight the Open Function and press {ENTER}. 

  

 

3. If a file is currently open, a message window will be displayed. 

A. To close the currently open file and open a new one, press {Y} and go on to step 4. 

 

B. To cancel opening a new file and keep using the currently open file, press {N}. The main 
screen will be re-displayed. Continue using SuperMICAR normally. 
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4. From the file open dialogue box use the {TAB} key to activate the listed files. 

  

 

5. Use the up and down arrow keys to highlight the desired file. Press {ENTER}. 

 

6. The main screen will be re-displayed with the name of the open file at the top. 

 

Entering & Saving Certificate Data 

Adding Certificates Using SuperMICAR 

In order to add certificates, the following actions must have already been performed: 

Opening a file (New Certificate File or Open an Existing File). 

 

Adding certificates to a file is the primary data entry function. Use the instructions below to add 
certificates to an open file. Note that I &O data can no longer be entered using SuperMICAR. 

 

1. From the main screen, press {Alt+E} to select the Edit Menu Option. 

 

2. Use the up and down arrow keys to highlight the Certificate Function and press {ENTER}. 
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3. The Certificate Information Screen will be displayed. See the SuperMICAR Hotkey List (or press 
Alt-F1) as a useful reference for editing shortcuts. 

  

 

4. Enter the certificate information in the corresponding fields on the screen. NCHS rules on how the 
data should be entered have been provided within each field description (check on the leftmost 
panel of the status bar, or "hover" your mouse over the field). Remember, the {TAB} and 
{SHIFT+TAB} keys can be used to move from field to field. 

 

Certificate - Enter the certificate number. The certificate number is usually in the upper right hand 
corner of the death certificate. It is also called the State File Number on the certificate. The 
abbreviation (INC) indicates that the certificate contains more information than could be typed in 
the fields on the screen. 

Note: If a user tries to create a duplicate certificate number (certificate already exists in current 
file), a message window will be displayed informing the user of the problem. In this case, the 
window will ask whether to overwrite the original record or not. 

 

Sex - Type M for Male, F for Female, or U for Unknown. If Sex is not stated on the certificate, 
determine sex by name. Enter a U for Unknown. The numeric codes for sex may also be entered 
here (e.g., "1" for male). 
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Date of Death - The date of the descendant’s death as reported on the death certificate. Give it in 
the following format: MM/DD, where MM = the month (01-12, 99) and DD = the day of the 
month (01-31, 99). The year will be automatically supplied from the header information. Dates 
after the current date will not be accepted. If any element of the date of death is unknown, enter 
"99." For example, enter "99/99" for a totally unknown date of death. 

 

Age: Number of Units - Enter the number for age of the decedent. The units of time (years, 
months, minutes, etc) will be entered in the Unit field (Example: For 27 years old, type 27; for 3 
days, type 3).  

 

Age: Unit - The units of time for the Age: Number of Units field. Units will be given in minutes, 
hours, days, months, or years. Type {?} and press {ENTER} to obtain a list of valid units. 
Highlight the desired unit name with the arrow keys and press {ENTER} to select it. If this field is 
left blank, the age unit will default to YEARS. 

A. If the Age (Number of Units) entry on the certificate has an entry of "few minutes" or 
"few hours" on the certificate, leave the Age (Number of Units) field on the screen blank 
(will default to "Unknown" - 999) and enter the appropriate Unit. 
For example: If the certificate reports age as "few minutes," leave the Age (Number of 
Units) field blank and type MINUTES in the UNIT field. 

 

B. If age is not reported on the certificate, derive the decedent's age from the Date of Birth 
and Date of Death entries on the certificate. 

 

C. If Age and the Date of Birth entries on the certificate are blank, leave the Age (Number 
of Units) field blank on the screen. Enter the UNIT as indicated on the certificate or type 
UNKNOWN if units are not indicated. 

 

D. If age cannot be determined from the certificate, but entries of "newborn," "infant," etc. 
On the certificate indicate an age of less than 1 year old, leave the Age (Number of Units) 
field on the screen blank and type HOURS in the UNIT field. 

 

E. Disregard fractions reported in the number of units for age on the certificate. 

 

F. If the number of units on the certificate is reported with "approximately," "about," etc., 
enter the number only. 

 

State of Death - SuperMICAR will automatically fill in the state code using the header 
information. NOTE: The state code can only be changed using the Edit/Browse Header Info 
Function, but use caution when doing so - this can cause the state file to have an improper file 
name. 
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Cause of Death, Part I - Type in the cause of death exactly as it appears on the death certificate. 
Do not make any alterations. If any word or words in the Cause of Death are illegible, type 
ILLEGIBLE in place of the illegible words. All other legible words should still be entered. 

A. Be sure to include any numbers in the Cause of Death section of the certificate. The 
following formats can be used for the numbers: number and dot; number, dot, space; or 
number and space. Failure to enter the Cause of Death information correctly WILL 
CAUSE ERRORS in the data. Examples: 

1.Myocardial Infarction (number and dot) 

1. Myocardial Infarction 2. Severe Pneumonia (number, dot, space) 

1 Myocardial Infarction (number and space) 

The above examples would be typed in exactly as they appear: 

I(a) 1.MYOCARDIAL INFARCTION 

I(a) 1. MYOCARDIAL INFARCTION 2. SEVERE PNEUMONIA 

I(a) 1 MYOCARDIAL INFARCTION 

 
B. If the I(b), I(c), I(d), "due to" or "as a consequence of" lines are deleted or marked 

through on the certificate, press {Alt+D} on the matching line of the Certificate 
Information Screen. This will cause the I(b), I(c), or I(d) to disappear and indicates that 
the line number or "due to"/"as a consequence of" phrase was marked out. 

 
C. Following is a list of symbols and their meanings, as commonly used on the Cause of 

Death sections of a death certificate. 
 

# "Fracture." Substitute for the word "fracture." Example: For "Leg #," type "LEG 
FRACTURE." 

  "Decreased." Substitute for the word "decreased." Example: For "  blood pressure," type 
"DECREASED BLOOD PRESSURE." 

  "Increased." Substitute for the word "increased." Example: For "  hemorrhaging," type 
"INCREASED HEMORRHAGING." 

 "Hour." Substitute for the word "Hour." Example: For "1 ," type "1 HOUR." 
 

 
"Secondary to." Substitute for the words "secondary to." Example: For "Pneumonia  
Gunshot wound," type "PNEUMONIA SECONDARY TO GUNSHOT WOUND." 

1° "Primary." Substitute for the word "primary." Example: For "1°colon cancer," type 
"PRIMARY COLON CANCER." 

2° "Secondary to." Substitute for the words "secondary to." Example: For "Pneumonia 2° 
cardiorespiratory infection," type "PNEUMONIA SECONDARY TO 
CARDIORESPIRATORY INFECTION." 

  "With." Substitute for the word "with." Example: For "Heat stroke  myocardial 
infarction," type "HEAT STROKE WITH MYOCARDIAL INFARCTION." 
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  "After." Substitute for the word "after." Example: For "Spontaneous bleeding  tracheal 
tube removal," type "SPONTANEOUS BLEEDING AFTER TRACHEAL TUBE 
REMOVAL". 

  "Without." Substitute for the word "without." Example: For "Three weeks  taking 
medication," type "THREE WEEKS WITHOUT TAKING MEDICATION." 

w/ "With." Substitute for the word "with." Example: For "Heat stroke w/ myocardial 
infarction," type "HEAT STROKE WITH MYOCARDIAL INFARCTION." 

w/o "Without." Substitute for the word "without." Example: For "Three weeks w/o taking 
medication," type "THREE WEEKS WITHOUT TAKING MEDICATION." 

 
Duration - Type in the interval between the onset of the condition and death exactly as it appears on the 
death certificate. Do not make any alterations. Example: 3-4 WEEKS, 2 1/2 MONTHS, etc. 

A. Duration may be reported using units of time (YEARS, MONTHS, WEEKS, DAYS, HOURS, etc.) 
or with words such as BRIEF, CHRONIC, CONGENITAL, MOMENTS, NEWBORN, etc. 

 
B. Some of the special symbols listed under Cause of Death, Part I also apply to the Duration field. 

See Special Symbols in SuperMICAR. 

 

C. If a number other than a "1" or a "2" appears with a degree symbol (Example: 8°) in the Duration, 
ignore the number and symbol. Do not enter the number and symbol. 

 
Cause of Death, Part II - Type in any other significant conditions that are listed in the Cause of Death 
section of the death certificate in the order as reported. 

A. If more than one entry for Part II is listed on the certificate, enter the information in the order it 
appears on the certificate Try to duplicate the information exactly as it is reported, using whatever 
punctuation is used on the certificate. 

 
B. All abbreviations and symbols listed in Special Symbols in SuperMICAR also apply to Cause of 

Death, Part II. 

 
Was an Autopsy Performed? – Enter the single-character code for whether an autopsy was 
performed or not. Typing a question mark {?} will display the following pick-list of valid choices: 

N No 

Y Yes 

U Unknown 

 Blank 

Use the arrow keys to highlight the desired entry and press {ENTER} to select it.  

 



 25

Were Autopsy Findings Available? – Enter the single-character code for whether any autopsy 
findings were available. Typing a question mark {?} will display the following pick-list of valid 
choices: 

N No 

Y Yes 

U Unknown 

 Blank 

Use the arrow keys to highlight the desired entry and press {ENTER} to select it.  

 

Tobacco Use Contribute to Death? – Enter the single-character code for whether or not tobacco 
use contributed to death. Typing a question mark {?} will display the following pick-list of valid 
choices: 

N No 

Y Yes 

P Probably 

U Unknown 

C Not on certificate 

 Blank 

Use the arrow keys to highlight the desired entry and press {ENTER} to select it.  

 

Pregnancy: – Enter the single-character code for any conditions of pregnancy of the decedent. 
Typing a question mark {?} will display the following pick-list of valid choices: 

1 Not pregnant within past year 

2 Pregnant at time of death 

3 Not pregnant, but pregnant within 
42 days of death 

4 Not pregnant, but pregnant 43 days 
to 1 year before death 

7 Not on certificate 

8 Not applicable 

9 Unknown if pregnant within last 
year 

 Blank 

Use the arrow keys to highlight the desired entry and press {ENTER} to select it.  
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Manner of Death - Type in the code for the Manner of Death listed on the certificate. Type a 
question mark {?} and press {ENTER} to display the following pick-list of valid manner of death 
codes: 

N Natural 

A Accident 

S Suicide 

H Homicide 

P Pending Investigation 

C Could Not Be Determined 

 Blank 

Use the arrow keys to highlight the desired entry and press {ENTER} to select it. Leaving this 
field blank will default to Not Specified. 

 
Date of Surgery - Date of surgery. Used only for states that have a specific surgery item on the 
certificate. If the certificate states that the date of surgery is unknown, then enter "99/99/9999" for 
the year. If a date is given, enter MM/DD/YYYY where MM = two-digit month, DD = two-digit 
day, and YYYY = four-digit year. A blank for date of surgery is valid. 

A. If "yes" is entered in the "Was operation performed" item on the certificate and no Date 
of Surgery is specified, type SURGERY as the last condition in Part II. Separate 
SURGERY from any other items in Part II with a semicolon (;). For example, if "yes" is 
entered, the certificate data should be entered as follows: 

I(a) CARDIAC ARREST 

 (b) BREAST CANCER 

 (c) 

 (d) 

II PNEUMONIA; SURGERY 

 
B. If "yes" is entered in the "Was operation performed" item on the certificate and surgery 

(or a named type of surgery) is recorded elsewhere on the certificate, do not add 
SURGERY to Cause of Death, Part II. For example, if "yes" is entered with a specific 
type of surgery already named, the certificate data would be entered as follows: 

I(a) CARDIAC ARREST 

 (b) BREAST CANCER; MASTECTOMY 

 (c) 

 (d) 

II PNEUMONIA 
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C. If "yes" and a date of surgery are entered in the "Was operation performed" item on the 
certificate, do not enter SURGERY in Cause of Death, Part I or II. Enter the date of the 
surgery in the Date of Surgery field. 

 

D. If diseases, injuries, or named surgeries are reported in the "Was operation performed" 
block, enter these diseases, injuries, or named surgeries as the last entry in Cause of 
Death, Part II. 

 

E. The date of surgery cannot be after the date of death, so SuperMICAR will not allow 
such an entry. 

 

Activity Code – Single-digit code for the activity the decedent was undertaking when death 
occurred. Typing a question mark {?} will display the following pick-list of valid activity codes: 

0 While Engaged in Sports Activity 

1 While Engaged in Leisure Activity 

2 While Engaged for Income 

3 While Engaged in Other Types of Work 

4 While Resting, Sleeping, Eating, or engaging in other vital activities 

8 While Engaged in Other Specified Activity 

9 During Unspecified Activity 

Use the arrow keys to highlight the desired entry and press {ENTER} to select it. Leaving this 
field blank will default to Blank. 

 

Date of Injury – Month (01-12, blank), day (01-31, 99, blank), and year (0000-2400, 9999, blank) 
injury occurred (Ex: 01/01/1992). If the certificate reports the date of injury as unknown, then 
enter '99/99/9999'. 

A. If the date of an injury or external cause appears anywhere on the certificate except the 
Duration section of Part I, enter the date of that injury or external cause here. 

 

B. If a span of time is reported for month, day, or year for the injury, enter the earlier date. 
Example: January 1-7, 1989 would be typed in as 01/01/1989. 

 

C. The Date of Injury cannot be after the date of death, so SuperMICAR will not allow such 
an entry. 
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Time of Injury – This field can hold up to 4 digits that comprise a valid time (0000-2400, 9999, 
blank) for the unit of time field (immediately following). Typing a question mark {?} in the unit 
field will display the following pick-list of valid time units: 

A AM 

P PM 

M Military Time 

 Blank 

Use the arrow keys to highlight the desired pick-list entry and press {ENTER} to select it.  

 

Injury at Work? - Type the appropriate code according to what was reported on the death 
certificate. 

Y Yes 

N No 

U Unknown 

 Blank 

 

Place of Injury – Type the full text in the Place of Injury field as it appears on the death 
certificate. After validation of this field, the code assigned to this entry will be displayed to the 
right of the field in parentheses. Valid Place of Injury Codes are the following: 

A Home 

B Farm 

C Residential Institution 

D Military Residence 

E Hospital 

F School, Other Institution, Administrative Area 

G Industrial and Construction 

H Garage/Warehouse 

I Trade and Service Area 

J Mine/Quarry 

K Street/Highway 

L Public Recreation Area 

M Institutional Recreation Area 
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N Sports and Recreation Area 

O Other Building 

P Other Specified Place 

Q Unspecified 

 Blank 

 

 

Injury Description - Type in the description exactly as it appears on the death certificate. 

 

Transportation Injury – This field can hold up to thirty (30) characters. Typing a question mark 
{?} and pressing {Enter} will display the following pick-list of valid Transportation codes: 

DR Driver/Operator 

PA Passenger 

PE Pedestrian 

Enter the full text or use the arrow keys to highlight the desired entry and press {ENTER} to 
select it. 

 

Certifier – This field can hold up to thirty (30) characters. Typing a question mark {?} and 
pressing {Enter} will display the following display (display ONLY) list of valid Certifier codes: 

D Certifying Physician 

P Pronouncing & Certifying Physician 

M Medical Examiner/Coroner 

You may choose to type in the full text for an individual legally allowed to certify. Or you may 
use one of the standard codes for the certifier by typing in the code (this field has a display box 
only, not a pick-list). After you’re done viewing the display list, press the "OK" button with your 
mouse or press {Esc} to close the display list box. 

 

State Specific Data – Optional (for use by the states). This field can hold up to 30 characters of 
state-specific data. Consult your System Manager for details about how to use the State-Specific 
Data field. 

 

Record Count - The status bar at the bottom of the screen indicates both the current record being 
edited, as well as the total number of certificates in the current file. 
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5. When you are through entering data for this certificate, press {CTRL+ENTER} or {PgDown}. 
The certificate will be saved and a blank screen for a new record will be displayed. 

 

6. The Add Certificate Information screen will be re-displayed with all but one of the fields blank 
(the certificate number field will contain data). The certificate number will be automatically 
incremented by the program. Go to step 4 above to enter field information for another certificate. 

 

7. To exit the Add Certificate Function, either press the {ESC} key or press Alt-F9. If you press 
{ESC} or {Alt-F9} from a certificate screen that contains unsaved data, a message box will ask 
whether you want to save the certificate information before leaving Edit mode. 

 

8. The main screen will be redisplayed. 

 

What Constitutes Additional Information? 

In the past, additional information was defined as information gathered as a result of queries to the 
physician, results of investigations by coroners or other officials, traffic accident reports, etc. These 
definitions still hold true in SuperMICAR. However, the SuperMICAR Additional Information screen 
is used for these and other types of data. 

 

Specifically, AI includes any information or changes of information made to the original certificate. 
SuperMICAR assumes that preserving the original death certificate information is important, and 
therefore, any changes to that information are made on the Additional Information Screen. These 
changes can be made in several different places for several different reasons. 

 

Adding Certificates with AI: 

While adding certificates to a database file, additional information from police reports, pending 
investigations, or coroner's reports may be included with the original certificate. This information 
can be entered during the Add Certificates Function by accessing the Additional Information 
screen from the Certificate Data screen. To access the AI screen, press {F9}. 
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Browsing Certificates with AI: 

Specific causes of death are questionable under certain circumstances. When these special cases 
are encountered, many states send the physician(s) query letters asking for confirmation or 
clarification of the death conditions. The results of these query letters can be entered by accessing 
the AI screen from the Edit Certificates Function. To access the AI screen from the Edit/Browse 
Certificates screen, press {F9}. 

 

Reject Processing: 

When processing rejected records through the SuperMICAR reject processor, it is often necessary 
to make changes to the certificate information in order to get the record to process completely. 
These changes may consist of supplying a correct spelling for a misspelled word, adding 
punctuation to divide two terms, re-ordering the terms on a line, or selecting an external cause of 
death from the External Cause prompts (Note: External Cause prompts should only be used by a 
qualified MICAR coder). All of these changes should be made on the AI screen so that the 
original certificate data can be preserved unchanged. During processing, the Reject Editing screen 
will appear, allowing the user to make changes. From the Reject Editing screen, press {F9} to 
access the AI screen. For more information on reject processing, see Processing SuperMICAR 
Rejects. During reject processing, if an AI entry for a certificate already exists, the AI screen will 
be displayed by the reject processor, bypassing the Reject Editing screen altogether. 

 

It is important to remember that SuperMICAR will process only the information on the AI screen if an 
AI entry for a particular certificate exists. This means that for any certificate that has both original 
information and additional information, changes to the original certificate will have no effect on 
SuperMICAR's attempts to match causes of death to their medical entity reference numbers. Only 
those changes made on the AI certificate will be processed. Of course, for certificates that have no AI 
information, the data on the original certificate is processed. 
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Accessing the Additional Information Screen 

In order to view any AI (see What Constitutes Additional Information), the following actions must 
have already been performed: 

Opening a file (New Certificate File, or Open an Existing File). 

 

Each record in a SuperMICAR file can have two separate screens of information associated with it. 
The first screen, the Certificate Information screen, should contain the cause of death data as it 
appeared on the death certificate. Certified copies of the death certificate information could be taken 
from this screen. The second screen, the Additional Information (AI) screen, contains the overriding 
information that will be processed by SuperMICAR. 

  

 

You cannot jump directly to an AI screen. To access an AI screen, you must first navigate to the 
associated record/certificate (see Finding a SuperMICAR Record). From there, you can press {F9} to 
view the AI screen associated with that certificate. Even from the AI view, you cannot jump directly to 
a new AI record - To find a different AI record you must first close any currently-open AI screen by 
pressing {Esc} and then navigate to the desired certificate in normal edit view. From there you can 
again press {F9} to see the associated AI screen for that certificate. In standard edit certificate view, if 
a particular certificate has associated AI, a red indicator will appear in the status bar along the bottom 
of the screen: 
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The information on the AI screen may be different than that on the Certificate Information screen in 
cases where information needs to be added to the record as the result of queries. Changes in the record 
may also be required to assist the SuperMICAR processor in assigning Entity Reference Numbers to 
the medical conditions on the record. For most records, SuperMICAR will process the original 
information as it appears on the Certificate Information screen. When the AI screen is first invoked, the 
information from the original screen is copied onto the new screen. After this, the AI screen will 
always retain the changes made to it separately from the Certificate Information Screen. 

 

NOTE: Once a record has an associated AI certificate, changes made to the original certificate will 
have no effect on SuperMICAR's processing. Any corrections made to data on the Certificate 
Information screen should also be made on the AI screen to assure that the record processes correctly. 

 

Spelling & Illegibles 

Correcting Illegibles in SuperMICAR 

Certificates may fail to process because they contain words that were entered as "ILLEGIBLE" during 
data entry. This can be corrected through the use of SuperMICAR's Illegibles function. The Illegibles 
function checks for the word "Illegible(s)" or "Unintelligible(s)" in the cause fields (including Part II), 
duration fields, and the injury description field. The Illegibles function allows you display and correct 
those records in which illegible words were found. 

1. From the main screen, press {Alt+T) to select the Tools Menu Option. 
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2. Use the up and down arrow keys to highlight the Illegibles function. Press {ENTER}. 

  

 

3. A window will be displayed: 

  

A. To check illegibles, press {C}. After checking the illegibles, SuperMICAR will display a 
report window showing the certificates that contained illegibles. You may either press 
{Alt-P} to print this report or {Alt-C} to close the form without printing. 

 

B. To edit illegibles, press {E}. The edit certificates screen will be displayed for each 
certificate that contained illegibles. You can edit those records to correct the illegibles 
(see Editing SuperMICAR Records). After the final illegible has been edited, a message 
box will indicate that the illegibles check is completed. Press {ENTER} to continue. 

 

4. The main SuperMICAR screen will be re-displayed. 
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Correcting Misspellings in SuperMICAR 

As fields in the certificate edit screen are filled in, SuperMICAR automatically checks the spelling of 
terms and other appropriate fields. If SuperMICAR detects a potentially misspelling, the spelling check 
box is displayed, showing the misspelled word along with a list of the most likely correct word spellings. 
At that point, you have three choices: 

A. Press the button to accept the current word as is, with no changes. 

B. Retype the word in the box and press {Enter} to have SuperMICAR check the new word 
against its correct word list. 

C. Choose the correct word spelling from the list of potential matches offered by SuperMICAR. 

 

At any time, you can also run the spellcheck routine to check the spelling on EVERY certificate in the 
current file [NOTE: You cannot access the Tools | Spelling function directly from the Edit Certificate 
screen… to access the spellchecker, first close the Edit Certificate screen by pressing {Esc} and then 
follow the directions below. When searching for misspellings, SuperMICAR checks the words in the Part 
I Cause of Death fields, the Part II Cause of Death field, and the injury description field. To use the 
SuperMICAR spelling function: 

 

1. From the main screen, press {Alt+T) to select the Tools Menu Option. 
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2. Use the up and down arrow keys to highlight the Spelling function. Press {ENTER}. 

  

 
3. A spelling check box displays each misspelled word and, in the background, the certificate edit 

screen for that record. The certificate edit screen is shown only to provide a context for the 
spelling error; all spelling changes must be made in the Spelling Check box itself. For each 
misspelled word, you will have three choices: 

 

A. Press the button to accept the current word as is, with no changes. 

B. Retype the word in the box and press {Enter} to have SuperMICAR check the new word 
against its correct word list. 
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C. Choose the correct word spelling from the list of potential matches offered by SuperMICAR. 

  

 

4. After the final misspelling, a message box will indicate that the spelling check is completed. Press 
{ENTER} to continue. 

 

5. The main SuperMICAR screen will be re-displayed. 

 

Processing & Generating a MICAR200 File 

SuperMICAR Processing: An Overview 

Processing is how SuperMICAR converts the entered cause of death information into NCHS's Entity 
Reference Numbers (ERNs). There are three phases of processing in SuperMICAR: Record 
Processing, Reject Processing, and Additional Information Processing. It is intended that these three 
processing operations be performed to insure that the certificate data is processed correctly. The three 
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operations are: 

 

Record 
Processing 

The first phase of SuperMICAR processing produces output for all certificates in the database 
that are perfectly correct. It marks the certificates containing errors as rejects. This process 
runs in a batch mode without user interaction. 

 

Reject Processing The second phase of SuperMICAR processing is an interactive session in which only the 
rejects from the Record Processing are run. A trained MICAR coder can help SuperMICAR 
processing by changing the data on the certificate using MICAR data entry rules, making 
additions on the AI screen, or selecting external cause codes from the External Cause 
prompts. The results of Reject Processing are merged with the results of Record Processing to 
produce a complete MICAR file. NOTE: Proper use of the External Cause Prompts requires 
training in MICAR data entry. If the user has not been trained, he or she should not use the 
External Cause Prompts. 

 

Additional 
Information 
Processing 

The third phase of SuperMICAR processing is designed to allow the user to process any 
certificates that were changed as the result of collecting additional information. Additional 
Information, in this sense, is any information that was provided after reject processing was 
completed. When Additional Information processing is selected, only those certificates that 
have been modified since the rejects were run will be processed. 

 

For instructions for selecting and using each of these processing options, see the following help 
sections: 
Processing Records using SuperMICAR  
Processing SuperMICAR Rejects  
Processing AI using SuperMICAR  

 

Processing Records using SuperMICAR 

Before records can be processed using SuperMICAR, the following actions must have already been 
performed: 

 

Opening a file (New Certificate File or Open an Existing File). 

Note: the file must have certificates in it to process. 

 

The user does not need to do anything while the processing is occurring. After the processing is 
finished, the user can generate a batch error listing (see Generating SuperMICAR Reports) and then 
perform any editing needed (see the help section on Editing Functions in SuperMICAR) or process the 
rejects (see Processing SuperMICAR Rejects).  
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To process all the records in a file: 

1. From the main screen, press {Alt+P} to select the Process menu option. 

 

2. Use the up and down arrow keys to highlight the Process All Records function and press 
{ENTER}. 

  

 

3. A progress bar will be displayed on the screen showing what percentage of the data file has been 
processed. 

 

4. The certificate number for the certificate currently being processed is displayed in the progress 
dialog box. 

 

5. No other activity is needed during processing. 
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6. When the processing is complete, a Processing Results report will be displayed. 

  

A. To print out a copy of the Processing Results  report, click on the "Yes" button. 

 

B. To continue without printing, click on the "No" button or press {ESC}. 

 

7. The main screen will be re-displayed. 

 

Correcting SuperMICAR Rejects 

Note: Correcting SuperMICAR rejects is an optional step in the process of using SuperMICAR. 
Correcting rejects requires training - more than just an understanding of basic medical terminology. 
Correcting SuperMICAR rejects should generally be done by a trained underlying cause coder. 

SuperMICAR may reject a record for any of several reasons. A word may be misspelled, two separate 
terms may be listed on a single line with no punctuation between them, or an external cause may be 
embedded in the record, just to name a few. Unlike ACME, SuperMICAR does not generate messages 
corresponding to the reason for processing failure. This section provides some general instructions for 
correcting SuperMICAR records during processing. 
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Two Terms on a Line 

If two separate terms appear on a single line with no divider to separate them (a divider can be a 
punctuation mark or any of several words that indicate a division, such as AND or WITH), they may 
be processed as a single term and thus produce a reject. In this case, place a semicolon (;) between the 
two terms and save the certificate. This will solve most problems of this variety. 

Example: II. DIABETES MELLITUS END STAGE RENAL DISEASE 

enter: DIABETES MELLITUS; END STAGE RENAL DISEASE; 

 

Misspelling/Unrecognized Terms, Extraneous Information 

If a misspelled or unknown term appears in a record, simply type over the old term (you can toggle 
between insert and overwrite mode by pressing the {Insert} key) to give the certificate the correct 
spelling for the term. In other cases, a word may appear that has no significance to a death certificate - 
such as a person's name or the name of a hospital or city. In these cases, access the Additional 
Information (AI) screen and delete the unnecessary information. SuperMICAR will process the AI 
information instead of the original certificate data. 

Example: Ib. ARTERIOSCLEROTIC HRT DX 

enter: ARTERIOSCLEROTIC HEART DISEASE or ASHD 

 

Dates and Times 

Under most circumstances, SuperMICAR will automatically pull dates and times from a line and will, 
under certain circumstances, use them to generate a proper duration for the term. But because dates and 
times can be written in so many ways, SuperMICAR will sometimes miss a date or time. If this occurs, 
access the additional information screen for the certificate and remove the date or time from the line. If 
appropriate, use the deleted date to supply a duration code for the term (if one is not already provided). 

Example: II. DIED 25 DAYS AFTER MITRAL REPAIR AND CORONARY BYPASS 
SURGERY 

enter: MITRAL REPAIR; CORONARY BYPASS SURGERY  

 

Example: Ib. ESSENTIAL HYPERTENSION 4 YRS 

enter: ESSENTIAL HYPERTENSION and in DURATION block: 4 YRS 

 

External Causes 

If SuperMICAR encounters an external cause that it cannot interpret, the record will be rejected for 
manual multiple cause coding. Proper use of the External Cause Prompts require training in MICAR 
data entry. If this training has not been completed, DO NOT use the external prompts. If the user is 
certified in MICAR data entry, access the Additional Information screen for the certificate and use the 
external cause prompts to generate a code that indicates the external cause. (See Processing 
SuperMICAR Rejects for information on the external cause prompts.) 
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Multi-Line Terms 

Many certificates contain terms that flow from one line to the next. SuperMICAR makes an attempt to 
identify these terms and bring them together, but sometimes it fails to recognize the condition. In that 
case, access the Edit screen for the certificate, position the cursor on the line that should be connected 
with the previous line, and press Alt+D to delete the line number for that line, indicating that the two 
lines should be considered as one for the purpose of processing it. 

 

Two Lines Flowed Together 

Because SuperMICAR attempts to flow lines together, it will from time to time flow two lines together 
that should be left separate. This often occurs when a line is improperly formatted, perhaps ending with 
a modifier that should be applied to a prior lead term. In these cases, access the Additional Information 
screen and re-format the first line, putting modifiers prior to the terms that they modify. Another 
condition that may cause lines to be run together improperly occurs when the last character on a line is 
a punctuation mark, such as a comma, semicolon, or period. To correct errors of this variety, simply 
remove the punctuation mark. (This often occurs when periods are used to divide the letters in an 
abbreviated term, such as C.O.P.D. The periods are not necessary and can all be deleted.) 

 

Processing SuperMICAR Rejects 

Before records can be processed, the following actions must have already been performed: 

Opening a file (New Certificate File, or Open an Existing File). 

The file must have been processed already (see SuperMICAR Processing: An Overview). 

Please note that the file must have certificates in it to process. 

 

Note: Processing SuperMICAR rejects is an OPTIONAL step of SuperMICAR processing, and 
should not be performed by anyone who is not at least a trained UC (Underlying Cause) coder. 

 

In Processing Rejects, SuperMICAR will stop the processing whenever a term that it cannot translate is 
encountered. At the user's option, the user may edit the cause of death information and process the 
rejected record again. NOTE: This Function cannot be used until the Process All Records Function has 
been used. See Correcting SuperMICAR Rejects for more details. The details of Processing Rejects are 
as follows: 

1. From the main screen, press {Alt+P} to select the Process menu option. 
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2. Use the up and down arrow keys to highlight the Process Rejects Function and press {ENTER}. 

  

 

3. A progress bar will be displayed on the screen showing what percentage of the data file has been 
processed. 

A. When SuperMICAR finds a mismatch or an error, a message window will be displayed. 
To make a correction, press {Y}. To accept the error as correct and continue with the 
processing, press {N} (the record is marked as correct and will not be re-processed 
during future reject runs). To cancel editing of the error and return to processing, press 
{ESC}. To exit without any further processing, press {Y}. 

 

B. If the {Y} key is pressed to make corrections, the user will be returned to the Certificate 
Information screen (refer to Adding Certificates, for a description of the Certificate 
Information screen) or the Additional Information Screen, whichever is most appropriate 
(refer to Editing Additional Information for a description of the AI screen). 
SuperMICAR will fill the fields on the screen with certificate information. Make changes 
to the fields as described in ENTERING AND SAVING CERTIFICATE DATA.  

 

C. When {F6} is pressed, a Processed Output screen will be displayed. Press {ESC} to 
return to the Enter Certificate Information screen.  



 44 

 

D. The user must look at the data line and determine if the entry is an external cause. If the 
item is an external cause, the external cause prompts will need to be used to generate an 
External Cause Code for the Cause of Death. 

 

NOTE: Proper use of the External Cause Prompts requires training in MICAR data 
entry. If the user has not been trained, he or she should not use the External 
Cause Prompts. Press {ESC} to return to the Certificate Information screen. 

 

To access the external cause prompts: 

 

1) If the AI screen is not already displayed, access it by pressing {F9}. (External cause 
prompts are only available through the AI screen.) Position the cursor on the 
appropriate line for the external cause. Put two greater than signs {>>} in the field at 
the point to enter the external cause. Immediately upon putting in the second greater 
than sign, the prompt screen will be displayed. 

 

The box listing the options for each external cause will have an Enter Selection field and a Cancel 
Button.  

 

To enter an external cause simply type in the one to two letter/number code next to the external 
cause in the Enter Selection field (alternatively, you can double-click on the list item you wish to 
select.). 

 

Repeat this process as each new menu appears. When the complete external cause code has been 
entered, the Certificate Information Screen will be re-displayed with the external cause code in the 
Cause field. (For more information about external cause codes, refer to Part 2g manual) 

 

4. When the processing is complete, a report will be displayed. 

A. To print out a copy of the coding stats report, click on the Print button 

 

B. To abort, press {ESC}. 

 

5. The main screen will be re-displayed. 
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Processing AI using SuperMICAR 

Before records can be processed, the following actions must have already been performed: 

Opening a file (New Certificate File, or Open an Existing File). 

The file must have been processed already (see SuperMICAR Processing: An Overview). 

Note: the file must have certificates in it to process. 

 
Sometimes, Additional Information will be received after the certificates have been processed (as in a 
pending investigation, for example). In these cases, the user should edit the certificate's Additional 
Information and then, if desired, process the AI.  
Note: Whenever any editing is done on a certificate (including adding AI), the "Generate MICAR200 
File" option is not available (grayed out) until all the records have been processed using "Process All" 
(see Processing Records using SuperMICAR). After all the records have been re-processed, the 
MICAR200 file can again be generated (see Generating a MICAR200 File from SuperMICAR), then 
the file should be backed up and sent to NCHS. 

To process Additional Information: 

1. From the main screen, press {Alt+P} to select the Process Menu Option. 

 

2. Use the up and down arrow keys to highlight the Process Additional Information Function. 
Press {ENTER}. 
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3. A progress bar will be displayed on the screen showing what percentage of the data file has 
been processed. 

A. When SuperMICAR finds a mismatch or an error, a message window will be displayed. 
To make a correction, press the {Y} key. To continue with the processing, press the {N} 
key. 

 

B. If the {Y} key is pressed to make corrections, the Additional Information Screen will be 
re-displayed. See Correcting SuperMICAR Rejects for information on how to make 
corrections. 

 

4. When the processing is complete, a report will be displayed. 

A. To print out a copy of the coding stats report, click on the Print Button 

 

B. To abort, press {ESC}. 

 

5. The main screen will be re-displayed. 

 

Generating a MICAR200 File from SuperMICAR 

Before a MICAR200 file can be generated, the following actions must have already been performed: 

Opening a file (New Certificate File, or Open an Existing File). 

Note: the file must have certificates in it to process. 

 

The file must have been processed already (see SuperMICAR Processing: An Overview). 

 

After the certificate file has been processed, a MICAR200 file may need to be generated. The 
MICAR200 file contains all of the processed entity reference numbers and their identifying 
information. Ask your System Manager if this file should be generated. 

1.  From the main screen, press {Alt+P} to select the Process menu option. 
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2.  Use the up and down arrow keys to highlight the Generate MICAR200 File function. Press 
{ENTER}. Note: If the Generate MICAR200 File function is not available (grayed out), it’s 
because the file has not been processed since last editing. First run Process All (see Processing 
Records using SuperMICAR) and then try to generate the MICAR 200 file. 

  

 

3.  A window will be displayed. 

A. To generate a MICAR200 file containing information for all the certificates in the 
database, press {A}. 

 

B. To generate a MICAR200 file containing information for only those certificates that have 
been reprocessed (edited) since the previous export, press {E}. This is most often used 
after processing Additional Information, since in these cases, the primary MICAR200 file 
has already been shipped for processing and only the certificates that have changed need 
to be exported. 

 

4.  A progress bar will be displayed showing the percentage of the certificates that have been 
exported to a MICAR200 file. 

 

5.  When the MICAR200 file is complete, the main screen will be re-displayed. 
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Generate Reject Database 

This function, formerly a function of the separate UtilsMICAR program, has now been 
incorporated directly into SuperMICAR. Other important UtilsMICAR functions (e.g., queries) 
have also been incorporated directly into SuperMICAR, so UtilsMICAR is no longer maintained 
as a separate program. 

  

 

Choosing this function will create a new SuperMICAR database containing only SuperMICAR 
records that match certificates in a MICAR200 (.MRJ) or ACME (.ARJ) rejects file that the user 
specifies. Note that this does not remove the records from the current SuperMICAR file; the 
current SuperMICAR file is left unaffected. 

 

In order for this function to work, there must already be a MICAR200 Rejects file (MRJ, created 
in MICAR200) or an ACME Rejects file (ARJ, created in ACME). The user must specify the 
appropriate rejects file to generate a SuperMICAR rejects database. Certificate numbers from this 
MICAR200 or ACME rejects file are used to determine which records (from the current 
SuperMICAR file) are included in the new SuperMICAR rejects file.  



 49

  

 

The user must provide a filename and header information for the new "rejects-only" SuperMICAR 
file. 
 

SuperMICAR Backups 

Creating SuperMICAR Backups 

Because data security is an important issue, sites may have different backup procedures. Ask your 
System Manager for more specific instructions on the proper types and times for using backup 
procedures. 

 

Before backups can be made, the following actions must have already been performed: 

Opening a file (New Input File or Open an Existing Input File). 

 

After processing the data files, a backup should be made of the files that have been used and generated 
by SuperMICAR. All of the data and the associated files will be backed up. It is also recommended to 
run a backup at the end of each day. To create SuperMICAR backups: 

 

1. From the main screen, press {Alt+B} to select the Backup menu option. 
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2. Use the up and down arrow keys to highlight the Backup All Files Function and press {ENTER}. 

  

3. A Backup Dialog box will appear with a display box containing the Backup Directory, any drives 
on your computer, and an option to choose another location. Click to select one of those 
destinations.  

  

 

4. Once your destination is selected, you may Click on the Start button to begin the backup, the 
Close button to abort the Backup or the Help button to use the online help system. 
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Note: This Backup Dialog box contains a checkbox to "Remove files when done." Checking this 
box will cause the current data file and associated files to be backed up (into your <Backup> 
directory) and then REMOVED from your <Data> directory (see Setting SuperMICAR Options). 
Once the files are removed from your <Data> directory, you cannot open them using 
SuperMICAR without first restoring them (see Restoring from SuperMICAR Backups). 

 

5. Clicking on the Start button will begin the backup process (filename.SBK). If a previous backup 
exists, you will be prompted to either abort the backup or replace the previous backup. If you 
choose to replace the previous backup, that prior backup file will be renamed before the current 
backup is performed (filename.SB$); Thus one accidental "replace" during backup can still be 
recovered (see the topic on Recovery Files in the System Manager’s section for more 
information). While the backup is underway, the title of the dialog box will change to "Working." 
When the backup is complete a "Backup Successful" message will appear. 

 

6. The main screen and Menu Bar will be re-displayed. 

 

Creating SuperMICAR Backups for NCHS 

Because data security is an important issue, sites may have different backup procedures. Ask your 
System Manager for more specific instructions on the proper types and times for using backup 
procedures. 

 

Before backups can be created, the following actions must have already been performed: 

Open a file (New Certificate File, or Open an Existing File). 

Note: the file must have certificates in it in order to create the backup. 

 

After all editing and processing has been finished, backups of the certificate data should be made. The 
backups should be sent to NCHS for further processing. This Function will create a ssyy###.SUP file 
(ss = state code, yy = year, ### = shipment number) containing the MICAR200 file and other 
associated files. The filename information will be pulled automatically from the Header information, 
which one important reason the header information (particularly the shipment number) must be 
updated for each batch. 

 

1. From the main screen, press {Alt+B} to select the Backup menu option. 
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2. Use the up and down arrow keys to highlight the Backup for NCHS function and press {ENTER}. 

  

3. A Backup Dialog box will appear with a display box containing the Backup Directory, any drives 
on your computer, and an option to choose another location. Highlight the desired backup 
destination. 

  

4. Once your destination is selected, you may Click on the Start button to begin the backup, the 
Close button to abort the Backup or the Help button for more information 
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5. Clicking on the Start button will begin the process of creating the backup file. A seven-character 
filename (filename.SUP) is automatically assigned to your backup file based on information 
gathered from the header of the current file. 
The format of the filename: SSYY###.SUP (SS = state, YY = year, ### = shipment number). 
If a previous backup exists, you will be prompted to either abort the process or to continue. If you 
continue, the older backup will be replaced. While the backup is underway, the title of the dialog 
box will change to "Working" and when the backup is complete a Backup Successful message will 
appear. 

 

6. The main screen and Menu Bar will be re-displayed. 

 

Restoring from SuperMICAR Backups 

At some point it may be necessary to restore a data file from a backup (see Creating SuperMICAR 
Backups). For the Restore from Backup function to be active, you cannot have a file currently open 
(see Closing a SuperMICAR File). To use SuperMICAR’s Restore function to retrieve data from a 
backup file: 

 

"Restore From Backup" restores files from the backup (or other chosen) directory to the current data 
directory. Therefore, it is advisable to verify the current data path before you move through the steps 
for restoring a file. See Setting SuperMICAR Options to verify (or change) current path settings. 

 

1. From the main screen, press {Alt+F} to select the File Menu Option. 
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2. Use the up and down arrow keys to highlight the Restore function and press {ENTER}. 

  

 

3. A dialog box for Restoring From Backup will be displayed. This is similar to the dialog for Open 
File and works the same way. 
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4. Choose the backup file (a file with a .SBK extension) to restore from. You can change the 
selection in the "Files Of Type" field to choose from among types of valid backup files (e.g., 
.SBK, .SUP, .SB$, SU$). The available files will be listed in the List of Files. Once the desired file 
is highlighted, press {ENTER}. The available files will be listed in the List of Files. Once the 
desired file is highlighted, press {ENTER}. 

 

Note: If the file you are restoring already exists, a cautionary message will be displayed. 
If you proceed further, the files currently on your hard drive will be replaced with those 
from the backup. Restoring over previous files should be rare, usually only occurring 
when a file has become corrupted. Exercise caution as data loss can result from errors in 
this step. 

 

5. A Restore dialog box will appear and its title will change to "Working" while the restore is 
underway. 

 

6. After the restore is complete, the main screen and Menu Bar will be re-displayed. 

 

Editing Functions in SuperMICAR 

SuperMICAR Editing: An Overview 

SuperMICAR has several functions that can be used to edit a certificate file and the data it contains. 
The most commonly used Function for this will be the Edit Function (see Editing SuperMICAR 
Records). Other common functions that will be used to edit certificate data are: 
Editing SuperMICAR Header Information, 
Adding/Editing Additional Information, 
 Finding a SuperMICAR Record. 

 

Editing SuperMICAR Header Information 

Before header information can be edited, the following actions must have already been performed: 

Opening a file (New Certificate File or Open an Existing File). 

 

The steps below are used to edit the certificate file's header information. This Function can be used 
only when a certificate file is open. 

 

1. From the main screen, press {Alt+E} to select the Edit Menu option. 
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2. Press {H} to edit Header Information. For more information on the parameters for the header 
fields, see Creating a New SuperMICAR File. 

  

3. After editing the header information, press {OK} to save the header information and return to the 
main screen (the filename will appear at the top of the screen). The new header information will be 
applied to all certificates in that file. 

 

4. To exit the header information screen without saving the changes, press {ESC}. 

 

Editing Additional Information 

The procedure for editing Additional Information in SuperMICAR is covered in the section on 
Entering and Saving Certificate Data (see Adding/Editing Additional Information). 

 

Finding a SuperMICAR Record 

Before the Find a Record Function can be used, the following actions must have already been 
performed: 

Opening a file (New Certificate File or Open an Existing File). 



 57

Note: The file must have certificates in it to be searched. 

 

The Find a Record Function allows the user to find (jump to) a particular certificate quickly. This is 
especially useful when editing certificate data in a large file. To find a specific record: 

1. While the Certificate Information screen is displayed (see Editing SuperMICAR Records), press 
{F5}. 

 

2. Type in the certificate number (leading zeros are optional) of the desired certificate and press 
{ENTER}. 

A. If the certificate number is in the currently open file, data from that certificate will be 
displayed. 

 

B. If the certificate number is not in the currently open file, a message will be displayed. 
Press {ENTER}. 

 

3. The Certificate Information Screen will be re-displayed. 

 

Showing Processed Output in SuperMICAR 

In order to use the Show Processed Output Function, the certificate file must first be processed (see 
Processing Records Using SuperMICAR). This Function shows the ERN codes that were generated for 
the cause(s) of death listed on the certificate. 

1. While the Certificate Information Screen is displayed (by using the Edit Certificates function), 
press {F6} to Show Processed Output. 

 

2. A window listing the cause(s) of death and the ERNs generated will be displayed. 

 

3. When finished viewing the window, press the {ESC} key. The Certificate Information Screen will 
be re-displayed. 

 

Deleting Records in SuperMICAR 

Deleting SuperMICAR Certificates 

SuperMICAR also offers the ability to delete certificates, either individually or in groups, from the 
database. Warning: Once certificates are deleted, THEY ARE GONE FROM THE SUPERMICAR 
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DATABASE. The only way to recover deleted certificates is to restore from an existing backup of the 
file (assuming that a backup file containing the certificate in question exists). See Creating 
SuperMICAR Backups, Creating SuperMICAR Backups for NCHS, Restoring from SuperMICAR 
Backups, or ask your System Manager for more information on backing up and restoring files. 

 

There are two ways to delete certificates from SuperMICAR's database. See Deleting SuperMICAR 
Certificates While Editing a Certificate File for the procedure to delete one certificate at a time. See 
Deleting Several SuperMICAR Certificates at Once for the procedure to delete any number of 
certificates in a database file, up to the highest certificate number entered. 

 

Deleting SuperMICAR Certificates While Editing a Certificate File 

The steps below can be used when the Certificate Information screen is displayed. The steps allow you 
to delete the currently displayed certificate from the certificate file. 

1. Access the Certificate Information screen for the desired certificate. For specific instructions, see 
Editing SuperMICAR Records. 

 

2. Press {F8} to delete the current certificate. 

 

3. A message box will ask you to confirm deletion of the displayed certificate record. 

A. To delete the certificate from the certificate file, press {Y}. The next certificate in the file 
(if available) will then be displayed. 

 

B. To cancel the deletion, press {N}. The certificate will not be deleted. 

 

Deleting Several SuperMICAR Certificates at Once 

If the Delete Records Function is used when the Certificate Information screen is not displayed, the 
user can delete a group of certificates at once. Note that this is a sequential deletion - you can only 
delete a contiguous block of certificates (e.g., 1-20, 457-493) and all certificates in that range will be 
deleted. 

1. From the main screen, press {Alt+E} to select the Edit Menu Option. 

 

2. Use the up and down arrow keys to highlight the Delete Certificates Function. Press {ENTER}. 

 

3. A window will be displayed asking for the range of certificate numbers to delete. 

 



 59

4. Type in the certificate number of the last (ending) certificate to be deleted and press {ENTER}. If 
the beginning and ending certificate numbers are the same, only that one certificate will be 
deleted. 

 

5. Another message will be displayed requesting confirmation to delete the specified records. 

A. To delete the records, type {Y}. 

B. To cancel the deletion, type {N}. 

 

6. A message box will ask if you wish to delete more records. 

A. To delete another group of certificates, type {Y} and repeat the steps above. 

B. To exit and re-display the main screen, type {N}. 
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Deleting an Entire Batch 

Delete 
This new feature under the File menu allows the user to delete an entire batch. A batch consists of 
all files with that filename (with any extension - excluding backup files). 

  

 

All files with that name, in the directory selected, will be deleted. Note that this batch deletion is 
limited to the directory the user specifies and that any backup files will not be deleted (although it 
is strongly recommended that backup files be stored only in the backup directory). 
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Generating SuperMICAR Reports & Printing 

Generating SuperMICAR Reports 

Different functions can be used to generate SuperMICAR Reports: 

The sequence check, which helps identify missing, extra, duplicate, or out-of-sequence certificates, can 
produce a number of different reports depending on what type of information is desired. By running a 
sequence check, you can produce a standard report, a series report, or an actual report (see 
Generating a SuperMICAR Sequence Check). 

 

Various reports can also be generated using the View/Reports menu: 

SuperMICAR Error Listing  

Non-Blank Place of Injury Listing  

Non-Unit Durations Listing  

 

For help with printing, see the following topics: 

Printing a Single SuperMICAR Certificate  

Printing All Certificates using SuperMICAR  

 

Generating a SuperMICAR Sequence Check 

The Sequence Check Function creates a file (named filename.SSQ) containing a report showing 
certificate numbers in one of three different formats. 

• A ‘’standard report" will display all of the missing certificate numbers in ascending order. 

• A "series report" (the default choice) will display all of the missing certificate numbers in 
ascending order, grouped into series based on the first digit (e.g., all certificates beginning with 
"1" would be grouped together). 

• An "actual report" is a report showing all of the certificates actually present in the database. 
Rather than being a "missing certificates" report (like the "standard report"), the actual report 
shows the certificates that are actually present in the database. 

Together, these reports can reveal if there are missing, extra, duplicate, or out-of-sequence certificates 
in the database file. The Sequence Check can be used only when a file is currently open. To use the 
sequence check: 

1. From the main screen, press {Alt+T} to select the Tools Menu Option. 

 

2. Use the up and down arrow keys to highlight the Sequence Check Function. Press {ENTER}. 
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3. A window will be displayed requesting a beginning certificate number and an ending certificate 
number. SuperMICAR automatically fills in the first and last certificate numbers for the current file. 
To change these certificate numbers: 

A. Use the {TAB} key to place the cursor in the desired field. 

B. Type in either the beginning certificate number (the starting certificate number for the 
sequence check), the ending certificate number (the ending certificate number for the 
sequence check), or both. Click "OK." 

  

C. Choose the type of report you wish to generate (standard, series, or actual) in the options 
box. Series report is the default. 
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4. The output of the sequence check (filename.SSQ) will then be displayed. Use the up and down arrow 
keys to scroll through the output (or {Page Up} and {Page Down}). Press the {ESC} key to close the 
output window. Click the Print button to print the report. 

 

"Total Prior Records" = the # of records in the file BEFORE the Beginning Certificate Number. 

"Total Future Records" = the # of records in the file AFTER the Ending Certificate Number. 

 

SuperMICAR Error Listing 

The Error Listing Function generates a list of any errors detected during processing. To use the Error 
Listing Function, there must be an open certificate file and the certificates must have already been 
processed. 

 

1. From the main screen, press {Alt+R} to select the View/Reports Menu Option. 

 

2. Use the up and down arrow keys to highlight the Error Listing Function and press {ENTER}. 

 

3. At the "Viewing File" window, press the "Print" button. SuperMICAR will print out a listing that 
will include any errors generated. 
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Non-Blank Place of Injury Listing 

This function (found under View/Reports) displays the certificate number, place of injury code 
and place of injury text for all certificates with non-blank place of injury entries. This function was 
designed primarily for use at NCHS to help improve the quality of place of injury coding. 

Note that this Non-Blank Place of Injury Listing function does not allow editing. It merely gives 
users a report of certificates where Place of Injury is not blank. 

  

 

Non-Unit Durations Listing 

This Non-Unit durations report can be used to identify entries into the "duration" field that do not 
contain accepted units in SuperMICAR. These may be certificates with duration values but 
without duration units ("unitless" durations) or they may be certificates with duration units that are 
misspelled or unacceptable (e.g., "minues" instead of "minutes"). 

 

To see a listing of certificates with problematic duration units: 
 

1. From the main screen, press {Alt+R} to select the View/Reports Menu Option. 

 

2. Use the up and down arrow keys to highlight the Non-Unit Durations Listing option and press 
{ENTER}. 
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3. At the "Viewing File" window, press the "Print" button to send the report to your printer. 
SuperMICAR will print out a listing that will include any errors generated. Press "Close" to close 
the report. 
 

Printing a Single SuperMICAR Certificate 

To print a single certificate from SuperMICAR: 

 

1. From the main screen, press {Alt+E} to select the Edit Menu Option. 

 

2. Use the up and down arrow keys to highlight the Edit Certificates function and press {ENTER}. 

 

3. A Certificate Information Screen will be displayed. See Finding a SuperMICAR Record for help 
with finding the specific certificate to print. 

 

4. With the desired certificate displayed, press {F7}. At the confirmation box, press "OK." The 
certificate will be sent to the printer. 

 

5. When printing is finished, the main screen will be re-displayed. 

 

Printing All Certificates using SuperMICAR 

SuperMICAR has a Print All Certificates function. To print all certificates using SuperMICAR: 

1. From the main screen, press {Alt+V} to select the View/Reports Menu Option. 

 

2. Use the up and down arrow keys to highlight the Print All Certificates function and press 
{ENTER}. 

 

3. A message box will ask for confirmation of printing ALL certificates. 

A. To print ALL certificates, press {Y}. 

B. To cancel the printing and return to the main screen, press {N}. 

 

4. When printing is finished, the main screen will be re-displayed. 
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SuperMICAR Tools 

SuperMICAR Filter 

The Filter function, found under the Tools menu, allows the user to perform queries on 
SuperMICAR files. Using "filters," SuperMICAR can search files for records meeting certain 
conditions and generate subsets of records that meet those conditions. For example, a state might 
search an entire file to find all of the certificates (records) where a particular field (e.g., "place of 
injury") is blank. 

 

 

For the filter option to be available, a SuperMICAR file must be open. To enter the first parameter, 
click on the scroll arrow in the parameter box and select the field to be defined (for example, to set 
a search for specific causes of death). Similarly, choose the operator and value for the query. 

 

NOTE: The list of operators is customized according to the parameter chosen. This allows the user 
to select only appropriate operators for a given parameter. For example, if "Cause of Death" 
(which corresponds to more than one field on the certificate) is chosen, the user can select the 
operator "All Lines = (equal to)." This would return records where ALL of the fields match 
(equal) the requested value (e.g., empty). This should prove especially helpful for users who want 
to search a file for certificates (records) where ALL of the Cause of Death lines are blank. 
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Filters can be set for up to 3 criteria/expressions. To enter additional criteria before applying the 
filter, click on the logic button. Then select the next criteria and define whether it will look for 
records satisfying BOTH expressions ("AND") or look for records satisfying EITHER expression 
("OR"). Records can also be specifically EXCLUDED from the query results ("NOT"). 

 

Note: Large files and complex searches might take a few minutes, please be patient (in the future a 
progress bar may be added). 

 

After a query is run, a dialogue box will give the option to create a new database from the results 
set of the query. If new database files are to be created, the user must provide a filename. 
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Rename AI Database 

This function, found under the Tools menu, allows the user to create a new database containing 
only the records with additional information. 

  

 

CAUTION: THIS WILL DELETE THE PARENT FILE. Most states will NOT want to use 
this function - precisely because it deletes the original file. 

  

 

This function was designed primarily for use at NCHS to create AI-only files. This function 
requires the user to provide a filename and header information for the new AI-only file. 
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Setting SuperMICAR Options 

SuperMICAR stores information entered at setup, such as Data Path, Tables path and Backup path. 
This information rarely needs to be changed after setup, but if necessary the Tools | Options menu 
allows this to be changed. 

 

To change the SuperMICAR path information: 

1. Use Alt+T to open the Tools menu and use Down arrow or mouse to select Options. 

 

2. Use the up and down arrow keys to highlight Options and press {ENTER}. The Options Menu 
will be inactive if a file is currently open. Close the current file (see Closing a SuperMICAR File) 
to access the Options Menu 

  

 

3. Enter the corrected Data Path, Table path, and Backup path. You can either type the information in 
or use the browse buttons to search for the correct file paths. 
Note: The "Coder Statistics" checkbox should generally remain unchecked (as shown above). 

 

Changing Certificate Digits in SuperMICAR 

One of the tools in SuperMICAR is a function that allows a user to change any of the digits in a 
range of certificate numbers. Note that when this function is invoked, all of the digits in the chosen 
range are changed to the new value. 
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To access this utility, choose Tools | Change Certificate Digits. 

  

 
If changing the chosen digit(s) for a particular certificate would create a duplicate certificate 
number (which is, of course, not permissible), then the potential duplicate is avoided according to 
the choice the user makes in the dialogue box… 
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Understanding the "radio button" choices for dealing with duplicates: 
"Don't change it" If the user chooses this option, then the new digit is simply not 

assigned. The current numbers of both certificates are retained. 
"Delete it" If the user chooses this option, the certificate for which the digit 

change was requested is instead simply deleted – rather than 
changing its digit(s). 

"Delete the other 
record" 

If the user chooses this option, the digit change is carried out 
regardless – the certificate number that would have been an 
impediment is deleted. 

 

Build an ARJ File using SuperMICAR 

Sometimes a user might want to create an ARJ file manually (rather than wait for SuperMICAR to 
create the ARJ file). It is for such times that the Build an ARJ File function were created. 
1. From the main screen, press {Alt+F} to select the File menu option. 
2. Enter the 2-digit abbreviation for the state. 
3. Enter certificate numbers, one at a time, into the Certificate Number field on the dialogue 
box. Pressing {Enter} after each certificate number will add the certificate to the list. 
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4. Press "Build" to create the ARJ file, or press "Cancel" to cancel without creating the file. 
5. For the ARJ file to be created, you must enter a 7-character filename. 
Suggested filename format: ssyyS## where ss = the 2-digit state abbreviation, yy = the 2-digit 
year, and ## = its numerical sequence (e.g., 01 for first manual ARJ, 02 for second manual ARJ). 
6. Choose "Yes" to create the new file, or "No" to cancel. 

 

 

Exiting SuperMICAR 

Closing a SuperMICAR File 

A certificate file will normally be closed when the user is ready to start on a new batch of certificates 
(which involves creating a new certificate file, as described in Creating a New SuperMICAR File. At 
other times, SuperMICAR will require that the certificate file be closed to perform some of the menu 
functions. In any case, closing a SuperMICAR file is very easy: 

1. From the main screen, press {Alt+F} to select the File Menu Option. 

 

2. Use the up and down arrow keys to highlight the Close File Function and press {ENTER} (or 
press Ctrl-F4). 

 

3. The currently open file will be closed. The filename will disappear from the top of the screen. 
SuperMICAR is now ready to open another file for processing. 

 

Exiting SuperMICAR 

There are numerous ways to exit SuperMICAR. For shortcut keys such as {Alt+X} and {ESC}, see the 
Master Hotkey List). 
To exit SuperMICAR through the File Menu: 

1. From the main screen, press {Alt+F} to select the File Menu Option. 
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2. Use the up and down arrow keys to highlight the Exit SuperMICAR Function and press 
{ENTER}. 

  

3. A message window will be displayed. 

A. To exit SuperMICAR, press {Y}. The SuperMICAR program will close. 

 

B. To cancel the exit, press {N}. The main SuperMICAR screen will be re-displayed. 
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MICAR200 

Purpose of MICAR200 Help Documentation 

The MICAR200 software uses output files created from SuperMICAR. MICAR200 handles mainly 
processing functions, so the software requires very little user interaction. The topics in this section of 
the help documentation will help guide users through the various MICAR200 functions to create files 
for use with the ACME/TRANSAX software. 

 

Basic Steps for Using MICAR200 

The MICAR200 software uses output from SuperMICAR (see the SuperMICAR section of this help 
documentation for more information) to (1) assign entity reference number (ERNs) to any unassigned 
text and (2) convert those ERNs to ICD codes. This help documentation will help you process an 
output file from SuperMICAR through the MICAR100 process and the MICAR200 process to create 
the two files (.MRJ and .AIN) used by ACME/TRANSAX for creating the TRANSAX output file. 
That TRANSAX file, the end result of the processing done by the MMDS software, is then sent to 
NCHS for statistical use. 
 

Because there is no data entry into MICAR200, very little user interaction is required to perform these 
processing tasks. The program assigns ERNs (a process formerly handled in MICAR100) and then 
assigns ICD-10 codes (a process formerly handled in MICAR200) to certificate data elements. The 
general outline to follow in this manual is given below. 

 

1. Start MICAR200 (see Starting MICAR200). 

 

2. Open a 10N file (see Opening a MICAR200 File). This step opens the output from SuperMICAR 
(*.10N) for processing in MICAR200. 

 

3. Process all records (see Processing a MICAR200 Input File). When a file is processed, the initial 
(MICAR100) processing assigns entity reference numbers (ERNs) to the medical causes of death 
that were listed in the certificate file. The second (MICAR200) step of processing then assigns 
ICD10 codes. 

 

4. Close the input file (see Closing a MICAR200 File). 

 

5. If there are more 10N files to process, repeat steps 2 through 5. 
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6. Exit MICAR200 (see Exiting MICAR200). At this point you should proceed to using the 
ACME/TRANSAX program. For detailed information about using ACME/TRANSAX, see the 
ACME/TRANSAX section of this help documentation. 

 

Getting Started in MICAR200 

Starting MICAR200 

1. To start using MICAR200, double-click on the MICAR200 
icon on your desktop.   

2. The main menu screen will be displayed. See Using the MICAR200 Menu 
System for more details on the main screen and the Menu Bar. 

 

About the MICAR200 Main Screen 

The main screen of MICAR200 has several useful features: 
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1. At the top of the main screen will be the title - MICAR200. This line will also show the name of 
any currently open file (see Opening a MICAR200 File). On the far right of this first (top) line, 
you’ll also find the standard Windows controls for minimizing, maximizing, and exiting programs. 

 

2. The second line of the screen contains the Menu Options available in MICAR200. By looking 
under these Menu Options (e.g., clicking on "File" or pressing {Alt+F}), you’ll reveal available 
MICAR200 functions. Note that functions currently unavailable will be "grayed out" indicating 
that they are currently inactive. See Using the MICAR200 Menu System for more details. 

 

3. The bottom line of the screen is the status bar, which displays the following information: 

A. In the center, you’ll see a note about the {F1} key. Pressing {F1} will display the MMDS 
online help feature. The online help will offer you the most appropriate help available for 
the function you’re using at that time. 

 

B. In the lower right corner is a clock showing the current time and date. 

 

C. The lower left corner of the screen displays information concerning the current process. 
For example, during record processing, the information in the lower left corner of the 
screen will indicate that MICAR200 is currently processing records. 

 

Using the MICAR200 Menu System 

The functions of the MMDS software are available through a standard Windows drop-down menu 
system. This menu system allows users quick and easy access to various MMDS software functions. 

 

In addition to using the mouse to access menu items, there are two ways to access the menu:  

 

Alt+key: Pressing and holding the {Alt} key and then pressing the underlined letter key of a main 
menu item (e.g. "F" for the File Menu, "P" for the Process Menu) will display the drop-
down menu for that menu. Then you can use the up arrow and down arrow keys to 
highlight an item on the menu. Press {ENTER} to select the highlighted option. Use the 
left arrow and right arrow keys to open the submenus under each main menu option. 
Pressing {ESC} from a dropped-down menu closes the menu. Pressing {ESC} from the 
main menu will exit the program. 

 

Hotkeys: Many functions can also be performed by pressing an associated Hotkey or "shortcut" 
key. The Hotkey assignments are shown on each drop-down menu and are also listed in 
the Master Hotkey List. Pressing a Hotkey will immediately access the associated 
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function. For example, pressing {F2} will select the Open Existing File function. Hotkeys 
are a fast, easy way to access functions in the MMDS software. As users become familiar 
with the programs in the MMDS software suite, they will probably find the hotkeys 
convenient to use. 

 

To select a function from a drop-down menu: 

5. Use the mouse to choose the desired function by moving your mouse cursor over the appropriate menu 
item and left-clicking, or 

6. Use the up arrow and down arrow keys to highlight an option, or press the (underlined) letter of the 
desired function. The active (selected) function is highlighted. Pressing the selection letter will move 
the highlight bar to the corresponding function option. 

 

Not all functions are available at all times. In order to prevent users from selecting functions that 
should not be accessed during a particular process, the menu system will make certain functions 
available (active) or unavailable (inactive). When an option is inactive, it cannot be selected (the 
highlight bar will skip over that item and it's Hotkey will not function). 
For example: When a file is open, users will not be able to gain access to the Tools | Option screen. 
The open file must first be closed - because changing options can have a direct impact on opening and 
closing files. 
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Opening a MICAR200 File 

Only files with the extension .10N can be used as MICAR200 input files. To open an input file (10N 
format): 

 

1. From the main screen, press {Alt+F} to select the File Menu Option. 

  

2. Use the up and down arrow keys to highlight the Open File function and press {ENTER}. You 
cannot open more than one file in MICAR200. If a file is already open (the filename will be 
displayed in the status bar at the top of the main screen), you must close that file (see Closing a 
MICAR200 File) before opening another file. 

 

3. A file selection window with the following fields will be displayed: 

Look In: 
Used to select the directory of files to be listed. Defaults to the current MICAR200 Data Path 
as set in Tools|Options (see Setting MICAR200 Options). Clicking on the list arrow at the 
right side of that field will allow you to browse through directories. 

List of 10N files: 
Displays all valid (*.10N) files in the currently directory. 
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File Name: 
Allows user to enter a specific filename or will display the name of the selected file. 

Files of Type: 
Restricted to 10N file type only. 

OK and Cancel Buttons: 
Used to accept selected file or to cancel open file operation. 

  

 

4. To select a file from the List of 10N files for processing, do the following: 

A. Use the {TAB} key to put the cursor in the List of 10N files and use the up and down 
arrow keys to highlight the desired filename. The list will scroll up or down to display 
additional files. Press ENTER to proceed with opening the selected file. 

or 

B. Use the mouse to click on the file shown in the List of 10N files and either double-click on 
the file or click on the OK button to proceed with processing the selected file. 

 

NOTE: You can only select one file. Choosing multiple files at once is not possible. 

 

5. Once a valid file has been selected, the file will be opened. The main screen will be re-displayed 
with the name of the selected file at the top of the screen. 

 



 80 

Sequence Check 

Running a Sequence Check Using MICAR200 

After an input file has been selected, you should run a sequence check to ensure that all of the 
certificates are present in the file. In order to run a sequence check, you must have a MICAR200 file 
open (filename in the title bar at the top of the screen). To run a MICAR200 sequence check: 

The Sequence Check Function creates a file (named filename.SSQ) containing a report showing 
certificate numbers in one of three different formats. 

• A ‘’standard report" will display all of the missing certificate numbers in ascending order. 

• A "series report" (the default choice) will display all of the missing certificate numbers in 
ascending order, grouped into series based on the first digit (e.g., all certificates beginning with 
"1" would be grouped together). 

• An "actual report" is a report showing all of the certificates actually present in the database. 
Rather than being a "missing certificates" report (like the "standard report"), the actual report 
shows the certificates that are actually present in the database. 

Together, these reports can reveal if there are missing, extra, duplicate, or out-of-sequence certificates 
in the database file. The Sequence Check can be used only when a file is currently open. To use the 
sequence check: 

7. From the main screen, press {Alt+T} to select the Tools Menu Option. 

 

8. Use the up and down arrow keys to highlight the Sequence Check Function. Press {ENTER}. 

 

9. A window will be displayed requesting a beginning certificate number and an ending certificate 
number. ACME automatically fills in the first and last certificate numbers for the current file. To 
change these certificate numbers: 

A. Use the {TAB} key to place the cursor in the desired field. 

B. Type in either the beginning certificate number (the starting certificate number for the 
sequence check), the ending certificate number (the ending certificate number for the 
sequence check), or both. Click "OK." 
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C. Choose the type of report you wish to generate (standard, series, or actual) in the options 
box. Series report is the default. 

10. The output of the sequence check (filename.SSQ) will then be displayed. Use the up and down arrow 
keys to scroll through the output (or {Page Up} and {Page Down}). Press the {ESC} key to close the 
output window. Click the Print button to print the report. 

  

"Total Prior Records" = the # of records in the file BEFORE the Beginning Certificate Number. 

"Total Future Records" = the # of records in the file AFTER the Ending Certificate Number. 
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Processing 

Processing a MICAR200 Input File 

MICAR200 processing uses an input file consisting of ERNs (Entity Reference Numbers) to create an 
output file (*.AIN) of ICD codes for use by ACME/TRANSAX. Under certain conditions, MICAR200 
will also produce a MICAR Reject file (*.MRJ). Processing time will depend on the size of the input 
file and the speed of the computer used. For the processing function to be active, you must have a file 
currently open. To start processing a MICAR 200 input file (*.10N): 

 

1. From the main screen, press {Alt+P} to select the Process Menu Option. 

 

2. Use the up and down arrow keys to highlight the Process All Records function and press 
{ENTER}. 

  

 

3. MICAR200 will begin generating ICDs for the certificates. A progress bar will be displayed 
showing what percentage of the input file has been processed. 
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4. To halt processing, press the {ESC} key. If processing is halted, a message window will be 
displayed. Press {ENTER}. 

 

5. When MICAR200 finishes processing, a "Process Completed" box will display. Press {ENTER} 
to return to the main screen. 

 

Viewing Stats and Rejects 

Viewing Reports in MICAR200 

Because the primary purpose of MICAR200 is processing – the program has no editing functions –any 
results of that processing can be important to users. Different functions can be used to generate various 
MICAR200 Reports: 

 

The processing performed by MICAR200 can actually be divided into two distinct steps: MICAR100 
processing and MICAR200 processing. A certain level of coding is the goal by the end of each step. 
Therefore, it can prove helpful to view reports of the processing as it moves through these steps. 

 

By the conclusion of MICAR100 processing, the program will have attempted to push every condition 
on the certificates to the level of ERN (Entity-Reference Numbers) – an internal reference schema that 
can be cleanly correlated to ICD codes. For instructions on viewing a summary of the MICAR100 
processing, see Viewing the MICAR100 Statistical Summary. 

 

By the conclusion of MICAR200 processing, the program will have attempted to push every condition 
on the certificates to the level of ICD codes. For instructions on viewing a summary of the MICAR200 
processing, see Viewing the MICAR200 Statistical Summary. 

 

During both steps of processing (MICAR100 and MICAR200 processing), various problems (e.g., term 
not in dictionary) can cause the certificate to be rejected. For help on how to display a report of these 
"MICAR rejects" using MICAR200, see Viewing MICAR Rejects Using MICAR200. Note that the 
very same report can be viewed using the ACME/TRANSAX program (see Viewing MICAR Rejects 
Using ACME/TRANSAX). 

 

 

Viewing the MICAR100 Statistical Summary 

During the Process All Records function (see Processing a MICAR200 Input File), MICAR200 
generates a MICAR100 statistical file (filename.1ST). This file contains information about the records 
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that were processed. To view the MICAR100 Statistical Summary file: 

1. From the main screen, press {Alt+V} to select the View/Reports Menu Option. 

 

2. Use the up and down arrow keys to highlight the View MICAR100 Statistics function and press 
{ENTER}. 

 

3. A report window will be displayed. 

  

 

4. Use the {Page Up} and {Page Down} keys, or the scroll bars and mouse, to scroll through the 
report. To print the report, press the "Print" button. To exit the report, press the {ESC} key or the 
"Close" button. 

 

5. The main screen will be re-displayed. 

 

Viewing the MICAR200 Statistical Summary 

During the Process All Records function (see Processing a MICAR200 Input File), MICAR200 
generates a MICAR200 statistical file (filename.2ST). This file contains information about the records 
that were processed. To view the MICAR200 Statistical Summary file: 

1. From the main screen, press {Alt+V} to select the View/Reports Menu Option. 
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2. Use the up and down arrow keys to highlight the View MICAR200 Statistics function and press 
{ENTER}. 

 

3. A report window will be displayed. 

  

 

4. Use the {Page Up} and {Page Down} keys, or the scroll bars and mouse, to scroll through the 
report. To print the report, press the "Print" button. To exit the report, press the {ESC} key or the 
"Close" button. 

 

5. The main screen will be re-displayed. 

 

Viewing MICAR Rejects Using MICAR200 

After you’ve processed all records (see Processing a MICAR200 Input File), you can review the 
MICAR reject file in ACME input file format. 
Note: You can only view MICAR Rejects if a MICAR Reject file (*.MRJ) was created during 
processing. 

To view the MICAR Rejects: 

1. From the main screen, press {Alt+V} to select the View/Reports Menu Option. 
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2. Use the up and down arrow keys to highlight the View MICAR Rejects function and press 
{ENTER}. 

 

3. A report window will be displayed. 

 

4. Use the {Page Up} and {Page Down} keys, or the scroll bars and mouse, to scroll through the 
report. To print the report, press the "Print" button. To exit the report, press the {ESC} key or the 
"Close" button. 

 

5. The main screen will be re-displayed. 

 

MICAR200 Options 

Setting MICAR200 Options 

MICAR200 stores information entered at setup, such as Data Path, Tables path and Backup path. This 
information rarely needs to be changed after setup, but if necessary the TOOLS | Options menu allows 
this to be changed. 
Note: MICAR200 options cannot be changed while a file is open (the Options function will be "grayed 
out"). To activate the Options function, first close the current file. 
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To change the MICAR200 setup information: 

1. Use Alt+T to open the Tools menu. 

 

2. Use the up and down arrow keys to highlight Options and press {ENTER}. The Options Menu 
will be inactive if a file is currently open. Close the current file (see Closing a MICAR200 File) to 
access the Options Menu. 

  

 

3. Enter the corrected Data Path, Table path, and Backup path. You can either type the information in 
or use the browse buttons to search for the correct file paths. 

 

Note: The MICAR200 Options box also holds the setting for the Multiple cause coding flag. Check the 
box to ENABLE Multiple Cause coding during MICAR200 processing, or uncheck the box to 
DISABLE Multiple Cause coding during MICAR200 processing. 

 

Exiting MICAR200 

Closing a MICAR200 File 

Before accessing some functions (e.g., re-setting the data path), you must close an open MICAR200 
file. To close a MICAR200 file: 

1. From the main screen, press {Alt+F} to select the File Menu Option. 
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2. Use the up and down arrow keys to highlight the Close File function and press {ENTER}. 

 

3. The currently open file will be closed. The filename will disappear from the status bar at the top of 
the main screen. To open a new file, see Opening a MICAR200 File. 

 

Exiting MICAR200 

There are numerous ways to exit MICAR200. For shortcut keys such as {Alt+X} and {ESC}, see the 
Master Hotkey List). 
To exit MICAR200 through the File Menu: 

1. From the main screen, press {Alt+F} to select the File Menu Option. 

 

2. Use the up and down arrow keys to highlight the Exit MICAR200 Function and press {ENTER}. 
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3. A message window will be displayed. 

A. To exit MICAR200, click "OK" or press {Enter}. The MICAR200 program will close. 

B. To cancel the exit, click "Cancel" or press {Esc}. The main MICAR200 screen will be re-
displayed. 
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ACME/TRANSAX 

Purpose of ACME/TRANSAX Help Documentation 

The ACME/TRANSAX section of this help documentation is intended to help users of 
ACME/TRANSAX use the program functions to create a final TRANSAX output file (.TRX) for 
shipment to NCHS. The Process ACME Input File function uses the output from the MICAR200 
software (.AIN files and .MRJ files) to identify ACME rejects (.ARJ file) to be reconciled. When all 
ACME rejects are reconciled, ACME will create a TRANSAX input file (.TIN). The TRANSAX 
processing uses this TRANSAX input file to create the final TRANSAX output file (.TRX) for 
shipment to NCHS for statistical use. The primary responsibility for users of ACME/TRANSAX is to 
use the program to process Multiple Cause codes and, where necessary, edit the codes so that there are 
no errors (ACME Rejects) in the processing. Most of the individual topics in this help documentation 
contain all of the instructions necessary to perform a given task at once. 

Basic Steps for Using ACME/TRANSAX 

Below are the general procedures for using ACME/TRANSAXs Menu Options and functions. It may 
be necessary at times to alter the overall process. Contact your supervisor for more site-specific 
information. 

1. Create a new data file OR open a data file for processing (see Creating a New ACME Input File or 
Opening an Existing ACME Input File). The input file is the file containing the certificate data. 
The user will need to select an input file every time ACME/TRANSAX is started or when a new 
batch of data is being used. 

 

2. (Optional): Print MICAR rejects. Data files that have been generated using SuperMICAR, run 
through MICAR200 processing, and then opened in ACME/TRANSAX may have MICAR 
rejects. If necessary, these MICAR rejects may be printed out before coding (see Viewing MICAR 
Rejects Using ACME/TRANSAX). 

 

3. Edit MICAR rejects. If the selected file has any MICAR rejects, these rejects must be edited 
before any ACME or TRANSAX processing is performed (see Editing MICAR Rejects Using 
ACME/TRANSAX). Many users will find the Superview feature (see The Three "Faces" of 
ACME Editing) very helpful for editing MICAR rejects. 

 

4. Edit and correct the ACME Input File. This step will only be necessary if the file has been created 
new using ACME/TRANSAX. In such cases, adding certificates (see Adding Certificates Using 
ACME/TRANSAX) or other editing may be performed on existing certificates (see Editing an 
ACME Input File). 

 

5. Check the file sequence. A sequence check will tell the user if there are any certificates missing 
from the batch. This check assumes that all of the certificate numbers are sequential. See Running 
a Sequence Check on an ACME Input File. 
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6. Process an ACME File. This is the processing stage of ACME, where the input file is processed 
and an underlying cause of death is determined. See Processing an ACME Input File. 

 

7. View ACME statistics. The results of the processing can be viewed to determine how many 
records have been rejected and why those records have been rejected. If there are rejects, the Run 
option will be inactive and the Editing ACME Rejects function will become active. See Viewing 
ACME Stats. 

 

8. Edit ACME rejects. If ACME processing uncovers any errors - ACME rejects - those records must 
be edited to eliminate the ACME rejects (see Editing ACME Rejects).  

 

9. Process ACME Rejects. If any ACME rejects were edited, those previously-rejected records will 
need to be processed before TRANSAX processing is possible. See Processing ACME Rejects.  
Note: If any records are (still) rejected during processing of ACME rejects, those lingering ACME 
rejects must be corrected (step 8 - Edit ACME Rejects) and processed (step 9 - Process ACME 
Rejects) before TRANSAX processing is available. 

 

10. Run TRANSAX processing. TRANSAX processing (the final part of ACME/TRANSAX 
processing) will process the ACME output, performing manipulations of the data to generate 
record-axis data. See Processing a TRANSAX File. 

 

11. View TRANSAX statistics. The final step in processing a batch of data is to examine the 
TRANSAX statistics for any mistakes or discrepancies. See Viewing TRANSAX Stats. 

 

12. View the Rare Causes file (see Viewing Rare Causes) to determine if there were Rare Causes in 
the batch. 

 

13. Create backups. Backups of the processed data from an open file should be made to prevent 
accidental loss of data. First use the Backup All Files menu item to insure that all of the data and 
the associated files will be backed up. 
NOTE: Backups should be made daily (backups can be made with incomplete files)!. See Creating 
ACME/TRANSAX Backups. Files that have been completely processed into TRANSAX (.TRX) 
files can then be backed up for sending to NCHS using the Send to NCHS function (see Creating 
ACME/TRANSAX Backups for NCHS). 

 

14. Exit ACME/TRANSAX. At this point, the data has been processed and the user can either exit 
ACME/TRANSAX (see Exiting ACME/TRANSAX) or begin processing a new batch. To process 
a new batch, simply start the process described above over again. 
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Flow Chart: Steps in ACME/TRANSAX Processing 
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Expanding ACME/TRANSAX Functionality 

In addition to the basic ACME/TRANSAX functions, most of the following functions can be used at 
any time with ACME/TRANSAX. Most of these functions will require that a certificate file be open. 
See the individual description of each utility for more details. Note that additional ACME/TRANSAX 
functions are described in the System Manager’s Guide section in this help documentation. 

 

1. Browse through and edit the certificates in a file (see Editing an ACME Input file, Editing MICAR 
Rejects Using ACME/TRANSAX, or Editing ACME Rejects). The edit functions allow you to 
edit information in the certificate database, which may be necessary at any time. 

 

2. Find a specific record in a file (see Finding an ACME Record). This function is available only 
when browsing through the certificates and allows the user to display a particular record by 
specifying its certificate number. 

 

3. Delete a certificate while editing (see Deleting an ACME Certificate While Editing). This function 
allows the user to remove a record from the certificate file. Note: certificates should not be deleted 
using ACME/TRANSAX if the file originated in SuperMICAR - because re-processing the file 
using MICAR200 (see Processing a MICAR200 Input File) would cause the certificate to 
reappear. 

 

4. Running sequence checks (see Running a Sequence Check on an ACME Input File and Running a 
Sequence Check on a TRANSAX Output File). This function generates a report that checks the 
sequence of the certificate numbers in the file. It is useful in determining if all of the records that 
should be in the file have been entered, if unwanted records have been entered, or if records have 
been entered with an incorrect certificate number. This function can be used at any time, but is 
most useful between data entry and processing to determine if the file is complete. 

 

5. Perform a daily backup (see Creating ACME/TRANSAX Backups). This function creates a 
backup copy of the open certificate file either on your PC’s hard drive or on a floppy. Backing up 
data is the only protection available against losing data due to a failed computer system. It is a 
good idea to back up the certificate file at the end of every day. 

 

There are more Menu Options and functions available in ACME/TRANSAX than will be used by data 
entry personnel. Some of these other Menu Options and functions will be used by the system manager. 
System Managers will find more detailed instructions in the System Manager’s Guide section of this 
help documentation. 
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Getting Started in ACME/TRANSAX 

Starting ACME/TRANSAX 

1. To start using ACME/TRANSAX, double-click on the 
ACME/TRANSAX icon on your desktop. 

  

2. The main menu screen will be displayed. See Using the ACME/TRANSAX 
Menu System for more details on the main screen and the Menu Bar. 

NOTE: Changes in record formats have made it critical that data from different calendar years be 
processed using different versions of ACME/TRANSAX. To help make this clear, different versions of 
ACME/TRANSAX have been given different color icons. 

 

ACME/TRANSAX icons and corresponding data years: 

2005 data 
(orange) 

 

2004 data 
(burgundy) 

 

2003 data 
(light blue) 

  

2002 data 
(red) 

  

2001 data 
(yellow)   
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About the ACME/TRANSAX Main Screen 

The main screen of ACME/TRANSAX has several useful features: 

  

 

1. At the top of the main screen will be the title - ACME/TRANSAX. This line will also show the 
name of any currently open file (see Opening an Existing Input File). On the far right of this first 
(top) line, you’ll also find the standard Windows controls for minimizing, maximizing, and exiting 
programs. 

 

2. The second line of the screen contains the Menu Options available in ACME/TRANSAX. By 
looking under these Menu Options (e.g., clicking on "File" or pressing {Alt+F}), you’ll reveal 
available ACME/TRANSAX functions. Note that functions currently unavailable will be "grayed 
out" indicating that they are currently inactive. See Using the ACME/TRANSAX Menu System 
for more details. 

 

3. The bottom line of the screen is the status bar, which displays the following information: 

A. In the center, you’ll see a note about the {F1} key. Pressing {F1} will display the MMDS 
online help feature. The online help will offer you the most appropriate help available for 
the function you’re using at that time. 
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B. In the lower right corner is a clock showing the current time and date. 

 

C. The lower left corner of the screen displays information concerning the current process. 
For example, during record processing, the information in the lower left corner of the 
screen will indicate that ACME/TRANSAX is currently processing records. 

 

Using the ACME/TRANSAX Menu System 

The functions of the MMDS software are available through a standard Windows drop-down menu 
system. This menu system allows users quick and easy access to various MMDS software functions. 

 

In addition to using the mouse to access menu items, there are two ways to access the menu:  

 

Alt+key: Pressing and holding the {Alt} key and then pressing the underlined letter key of a main 
menu item (e.g. "F" for the File Menu, "E" for the Edit Menu) will display the drop-down 
menu for that menu. Then you can use the up arrow and down arrow keys to highlight an 
item on the menu. Press {ENTER} to select the highlighted option. Use the left arrow 
and right arrow keys to open the submenus under each main menu option. Pressing 
{ESC} from a dropped-down menu closes the menu. Pressing {ESC} from the main 
menu will exit the program. 

 

Hotkeys: Many functions can also be performed by pressing an associated Hotkey or "shortcut" 
key. The Hotkey assignments are shown on each drop-down menu and are also listed in 
the Master Hotkey List. Pressing a Hotkey will immediately access the associated 
function. For example, pressing {F2} will select the Open Existing File function. Hotkeys 
are a fast, easy way to access functions in the MMDS software. As users become familiar 
with the programs in the MMDS software suite, they will probably find the hotkeys 
convenient to use. 

 

To select a function from a drop-down menu: 

1. Use the mouse to choose the desired function by moving your mouse cursor over the appropriate menu 
item and left-clicking, or 

2. Use the up arrow and down arrow keys to highlight an option, or press the (underlined) letter of the 
desired function. The active (selected) function is highlighted. Pressing the selection letter will move 
the highlight bar to the corresponding function option. 

 

Not all functions are available at all times. In order to prevent users from selecting functions that 
should not be accessed during a particular process, the menu system will make certain functions 
available (active) or unavailable (inactive). When an option is inactive, it cannot be selected (the 
highlight bar will skip over that item and it's Hotkey will not function). 
For example: When a file is open, users will not be able to gain access to the Tools | Option screen. 
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The open file must first be closed - because changing options can have a direct impact on opening and 
closing files. 

 

 

Setting ACME/TRANSAX Options 

ACME/TRANSAX stores information entered at setup, such as Data Path, Tables path and Backup 
path. This information rarely needs to be changed after setup, but if necessary the TOOLS | Options 
menu allows this to be changed. To change the ACME/TRANSAX setup information: 

1. Use Alt+T to open the Tools menu. 

 

2. Use the up and down arrow keys to highlight Options and press {ENTER}. The Options Menu 
will be inactive if a file is currently open. Close the current file (see Closing an 
ACME/TRANSAX File) to access the Options Menu. 

  

 

3. Enter the corrected Data Path, Table path, and Backup path. You can either type the information in 
or use the browse buttons to search for the correct file paths. 
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Creating, Opening, and Restoring ACME/TRANSAX 
Files 

Creating a New ACME Input File 

To create a new ACME input file using ACME/TRANSAX: 

1. From the main screen, Press {Alt+F} to select the File Menu Option. 

 

2. Use the up and down arrow keys to highlight the New Input File function and press {ENTER}. 

 

 

3. A window will be displayed requesting a filename. Type in a valid, 7-character filename (without 
the extension) and press {ENTER}. The extension will be automatically added by 
ACME/TRANSAX. The filename you choose should be meaningful to you and to other users of 
the same file. For example, NCHS uses the following format for filenames when processing 
MICAR data from states: 

[ssddnnn] 

ss = 2-character state abbreviation (see NCHS State Code List). 

dd = 2-digit data year. 

nnn = 2- or 3-digit shipment number. This number is unique for each file. 
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Thus: IN93076 has IN as the 2 character state abbreviation, 93 as the 2 digit data year, and 076 as 
the shipment number. 

 

4. When the file is created, the Specify Header Information screen will be displayed. The header 
information will be the same for each record in the file. Fill in the appropriate header information 
as follows: 
 

Shipment Three characters to identify the batch when the file is sent to NCHS. The first 
character can be either alpha or numeric; the second and third characters must be 
numeric. 

 

Lot #  A number from 1-9999. 

 

Section # A number from 0-9. This may prove very useful if you divide batches. 

 

Data Year Four-digit year from the death certificate. 

 

State Code A number identifying the state from which the death certificate originates. (For a 
full list of these codes, see NCHS State Code List). If a two-letter abbreviation 
for a state is entered, the program will automatically insert the correct NCHS 
state code. If the program does not recognize the abbreviation, it will display an 
error message and then show a of states. Entering a question mark {?} in this 
field will cause a pick-list of states to be displayed. 

 

Coder Status A number from 0-9 used to identify the status of the coder. 

 

Example: Codes for a batch of certificates being processed for data year 1988, from the 
State of Alaska, with shipment number U03, lot 0002, and coder status 1 would 
have the following entries: 
Shipment U03 
Lot # 0002 
Section 5 
Data Year 2000 
State Code 02 
Coder Status 1. 

 

5. When the coder status has been entered, press {ENTER} or click "OK" to save the header 
information. The main screen will be re-displayed with the new filename at the top. 
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6. To exit the Specify Header Information screen without saving, press {ESC} or click "Cancel." The 
main screen will be re-displayed. 

 

Opening an Existing ACME Input File 

To open an existing ACME Input File Using ACME/TRANSAX: 

1. From the main screen, press {Alt+F} to select the File Menu Option. 

 

2. Use the up and down arrow keys to highlight the Open File function and press {ENTER}. You 
cannot open more than one file at a time using ACME/TRANSAX. If a file is already open (the 
filename will be displayed in the status bar at the top of the main screen), you will be prompted to 
close that file before opening a new one: 

A. To close the current file and choose a new file to pen, press {Y} to continue with opening 
an existing input file. 

 

B. Press {N} to cancel opening a different file and keep the current file open. The main 
screen will be re-displayed with the open filename in the status bar at the top of the 
screen. 

 

3. A file selection window with the following fields will be displayed: 

Look In: 
Used to select the directory of files to be listed. Defaults to the current ACME/TRANSAX 
Data Path as set in Tools|Options (see Setting ACME/TRANSAX Options). Clicking on the 
list arrow at the right side of that field will allow you to browse through directories. 

List of AIN files: 
Displays all valid (*.AIN) files in the currently directory. 

File Name: 
Allows user to enter a specific filename or will display the name of the selected file. 

Files of Type: 
Type of files allowed (e.g., .AIN, .TRX). 

OK and Cancel Buttons: 
Used to accept selected file or to cancel open file operation. 
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4. To select a file from the List of AIN files for processing, do the following: 

A. Use the {TAB} key to put the cursor in the List of AIN files and use the up and down 
arrow keys to highlight the desired filename. The list will scroll up or down to display 
additional files. Press ENTER to proceed with opening the selected file. 

or 

B. Use the mouse to click on the file shown in the List of AIN files and either double-click on 
the file or click on the OK button to proceed with processing the selected file. 

 

NOTE: You can only select one file. Choosing multiple files at once is not possible. 

 

5. Once a valid file has been selected, the file will be opened. The main screen will be re-displayed 
with the name of the selected file at the top of the screen. 

 

Restoring from ACME/TRANSAX Backups 

Occasionally, it may be necessary to restore a data file from a backup (see Creating 
ACME/TRANSAX Backups). ACME/TRANSAX has a Restore From Backup function that will 
recover data from a backup file. It is strongly recommended that users create a backup file after each 
file is processed and also at the end of each day. To restore from an existing ACME/TRANSAX 
backup: 

1. From the main screen, press {Alt+F} to select the File Menu Option. 
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2. Use the up and down arrow keys to highlight the Restore From Backup function and press 
{ENTER}. 

 

3. A file selection window will be displayed. Refer to Opening An Input File for instructions on how 
to use the file selection window. The directory displayed will be the one specified by the Data 
path. 

  

 

4. Choose the backup file (a file with a .ABK extension) to restore from. The available files will be 
listed in the List of Files.  
Note: In addition to .ABK files, ACME/TRANSAX can also restore from .ZIP, .AB$, and .ZI$ 
filetypes, if they exist in the chosen directory. 
Once the desired file is highlighted, press {ENTER}. If the file you are restoring already exists, a 
cautionary message will be displayed. If you proceed further the files currently on your hard drive 
will be replaced with those from the backup. (Restoring over previous files should be rare, usually 
only occurring when a file has become corrupted. Exercise caution as data loss can result from 
errors in this step.) 

 

5. A Restore dialog box will appear and its title will change to "Working" while the restore 

 

6. The main screen and Menu Bar will be re-displayed. 

 

Viewing MICAR Rejects Using ACME/TRANSAX 

Before MICAR rejects can be viewed, the following actions must have already been performed: 

Opening a file (see Opening an Existing ACME Input File). 
Note: Once the MICAR rejects have been edited (see Editing MICAR rejects using 
ACME/TRANSAX), you will no longer be able to view the MICAR rejects using 



 103

ACME/TRANSAX. 

 

It is recommended that the MICAR rejects file be viewed and/or printed before any editing is 
performed. To view The MICAR rejects file: 

1. From the main screen, press {Alt+V} to select the View/Reports Menu Option. 

 

2. Use the up and down arrow keys to highlight the View MICAR Rejects function and press 
{ENTER}. 

 

3. A report window will be displayed. Use the {Page Up} and {Page Down} keys, or the scroll bars 
and mouse, to scroll through the report. 

  

 

4. To print the report, press the "Print" button. To exit the report, press the {ESC} key or the "Close" 
button. 

 

5. The main screen will be re-displayed. 
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Editing and Saving Certificate Data Using 
ACME/TRANSAX 

The Three "Faces" of ACME Editing 

As the main interface many users have with the ACME/TRANSAX program, the look of the 
ACME Edit Screen is important. The ACME Edit Screen has three distinct looks depending on the 
mode of operation chosen by the user: the standard ACME Edit Screen, the ACME Edit Screen 
in Superview, and the ACME Edit Screen with ACME Messages turned ON 

These three distinct modes (the three "faces" of ACME) do not change the usability of the 
program or the functions available, but they are designed to display different information, as 
detailed below. 

 

1. ACME Edit Screen in standard mode. 

The standard mode is the default setting for the ACME Edit Screen, so every time the user enters the 
ACME Edit Screen it will show the standard look (see screenshot below). This highly interactive grid 
allows users to edit data either in the grid itself or in the string line above the grid. For more 
information  
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2. ACME Edit Screen in Superview mode. 

By pressing Alt-S, the user will enter the Superview mode of the Edit Screen (see screenshot below). 
In Superview mode, the standard ACME grid is replaced with SuperMICAR information for that 
particular certificate. While editing in the ACME grid can not be done while Superview mode is on, 
users can edit the string line above the SuperMICAR information. In order for any SuperMICAR 
information to be displayed, of course, there must be a corresponding SuperMICAR file present in the 
correct directory. Note that Superview gives preference to any SuperMICAR AI (Additional 
Information) on the current certificate and thus displays the AI information rather than the original 
SuperMICAR certificate information. Essentially, the Superview mode allows ACME/TRANSAX to 
reach "back" into SuperMICAR files and display that information without ever leaving 
ACME/TRANSAX. Alt-S acts as a toggle to turn the Superview mode on and off, and pressing the 
"Esc" key always returns to standard edit mode. 

 

If the certificate has associated Additional Information, ACME change the background color of the 
certificate information area and will display the Additional Information for that certificate. When AI 
is displayed, a “Show Orig.” button on the Superview screen will toggle the view back to the original 
certificate information. 
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3. ACME Edit Screen with ACME Messages turned ON. 

By pressing Alt-M, the user will enter the ACME Messages mode of the Edit Screen (see screenshot 
below). In ACME Message mode, the standard ACME grid is replaced with a box showing the 
ACME Reject Error Messages for that certificate. While editing in the ACME grid cannot be done 
while ACME messages are turned on, users can edit the string line above the ACME messages. If 
there are no ACME Reject Error Messages for a certificate, the message box will be empty. Alt-M 
acts as a toggle to turn the ACME Messages on and off, and pressing the "Esc" key always returns to 
standard edit mode. 
NOTE: Once TRANSAX Processing has been completed (see Processing a TRANSAX File), the 
ACME Messages for that batch of certificates will be deleted. In that case, ACME Messages would 
simply be blank. 
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Fields on the ACME Edit Screen 

  

 

Certificate Number Field 

The field contains the death certificate number. This field is required for all records. The field accepts 
numeric values only, and the input must be six digits long. The field can only be edited when adding a 
new record. When adding a new record, the value initially placed into the field is one greater than the 
last record in the file. This field is always in replace mode, and characters cannot be inserted. 

 

 

Entity Axis Codes Field 

This field contains a single line representation of all of the ICD codes contained on the record. The 
individual codes are separated by the following delimiters, indicating where the next term is located on 
the record: SPACE (next code on same line); SLASH (‘/’) (next line); ASTERISK (‘*’) (part II).  

 

This field contains the same data that the Grid contains, and is simply displayed differently. This field 
can toggle between insert mode and replace mode by pressing the INSERT key. The current mode for 
this field is displayed in the lower right hand corner of the screen. This field can accept any text. 
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ICD Code Grid 

The grid is an eight by six array, which displays the ICD codes in a spreadsheet format. Lines a-e 
contain Part I data, while the last line contains Part II data. The individual cells of the Grid can contain 
one (and only one) ICD code. The ICD-10 code must be in the format A####, where A is an alpha 
character and # is a number. The cells can also accept a leading ampersand (‘&’). The code can have 
less than four numeric digits, but must have the leading alpha character and/or ampersand before digits 
can be entered. 

 

To navigate the grid, one can use the array keys, tab and back tab, or the mouse. The down arrow key 
will automatically move to the beginning of the next line down. There are a number of ways to exit the 
grid in addition to the mouse. To exit the grid and move to the Place of Injury field, press the down 
arrow (when on the last line of the grid), ENTER key, or Alt+P. To move from the grid to the Entity-
Axis Codes field, you must press Alt+E. You can also jump directly to the UC field from anywhere on 
the record by pressing the F7 key. 

 

As data is entered into the grid, the Entity-Axis Codes field is automatically updated with each 
keystroke. 

 

 

Place of Injury 

The Place of Injury field is a single digit field, accepting the values 0-9 or blank. The values are 
defined as follows: 
0 Home 
1 Residential Institution 
2 School, other institutions, Administrative Area 
3 Sports and Recreation Area 
4 Street/highway 
5 Trade and service area 
6 Industrial and construction area 
7 Farm 
8 Other specified places 
9 Unspecified place 
 blank 

 

 

Intentional Reject 

The Reject Field is a single digit field, accepting the values 1-6, 9 or blank. See NCHS Instruction 
Manual 2b for code instructions. 
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Underlying Cause 

The UC Field is where the user can enter the underlying cause of death for the record. The field holds 
up to five characters in the format A####, where A is an alpha character and # is a number. When 
editing ACME rejects, the UC which ACME has chosen will be displayed. The user can choose to 
leave the UC or edit it. The user can jump directly to the UC field from anywhere in the editor by 
pressing the F7 key. 

 

 

ACME Reject 

The ACME Reject code indicates why a given record has been rejected. THIS CODE SHOULD 
NOT BE CHANGED. The single-digit code mean: 
0 Not a reject 
1 MICAR reject - dictionary match 
2 ACME reject 
3 MICAR reject – rules application 
4 Reviewed 
 blank 

 

 

Manner of Death 

The Manner of Death field is a single digit field, accepting the values 1-7 and space. The values are 
defined as follows: 
N Natural 
A Accident 
S Suicide 
H Homicide 
P Pending investigation 
C Could not be determine 
 blank 

 

 

Activity 

The Activity Code field is a single digit field, accepting the values 0-4,8,9 and space. The values are 
defined as follows: 
0 While engaged in sports activity 
1 While engaged in leisure activities 
2 While working for income 
3 While engaged in other types of work 
4 While Resting, Sleeping, Eating, or engaging in other vital activities 
8 While engaged in other specified activities 
9 During unspecified activity 
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 blank 

 

 

Was an Autopsy Performed? 

This field holds a single digit code for whether and autopsy was performed or not. The values are 
defined as follows: 
N No 
Y Yes 
U Unknown 

 

 

Were Autopsy Findings Available? 

This field holds a single digit code showing whether autopsy findings were available or not. The values 
are defined as follows: 
N No 
Y Yes 
U Unknown 
X Not Applicable (computer-generated) 

 

 

Certifier 

This field can hold up to thirty (30) characters. The codes are defined as follows: 
D Certifying Physician 
P Pronouncing & Certifying Physician 
M Medical Examiner / Coroner 
[Enter full text for other individual legally allowed to certify] 

 

 

State Data 

The State Specific Data field (optional) is a text field, which can hold up to thirty (30) characters. This 
allows states to enter additional information that will be stored with the record. 

 

 

Tobacco Use Contribute to Death? 

This field holds the single-character code for whether or not tobacco use contributed to death. The 
codes are defined as follows: 
N No 
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Y Yes 
P Probably 
U Unknown 
C Not on certificate 

 

 

Pregnancy? 

This field shows the single-character code for any conditions of pregnancy of the decedent. The codes 
are defined as follows: 

1 Not pregnant within past year 

2 Pregnant at time of death 

3 Not pregnant, but pregnant within 42 days of death 

4 Not pregnant, but pregnant 43 days to 1 year before death 

7 Not on certificate 

8 Not applicable (computer-generated) 

9 Unknown if pregnant within last year 

 

Finding an ACME Record 

Before the Find a Record function can be used, the following actions must have already been 
performed: 

Opening a file (New Certificate File, or Open an Existing File). 

The file must have certificates in it to be searched. 

 

The Find function allows the user to find a particular certificate quickly. This is especially useful when 
editing certificate data. To find a specific certificate: 

1. While the Certificate Information screen is displayed (see Editing an ACME Input File), press 
{F5}. 

 

2. Type in the certificate number of the desired certificate and press {ENTER}. 

A. If the certificate number is in the currently open file, data from that certificate will be 
displayed. 

B. If the certificate number is not in the currently open file, a message will be displayed. 
Press {ENTER}. 
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3. The Certificate Information Screen will be re-displayed. 

 

Deleting an ACME Certificate While Editing 

This procedure can be used when the Certificate Information Screen is displayed. 

Note: Certificates cannot be deleted during "Reject Editing" (see Editing MICAR Rejects Using 
ACME/TRANSAX or Editing ACME Rejects - General Procedure). 

 

To delete the currently displayed certificate: 

1. Access the Certificate Information Screen for the desired certificate (see Editing an ACME Input 
File or Finding an ACME Record). 

 

2. Press {F8} to delete the current certificate. 

 

3. A window will ask for confirmation to delete the specified certificate. 

A. To delete the certificate from the certificate file, press {Y}. The next certificate in the file 
will then be displayed. 

B. To cancel the deletion, press {N}. The certificate will be re-displayed. 

 

4. The Certificate Information Screen will be displayed. 

 

Editing MICAR Rejects Using ACME/TRANSAX 

Before MICAR rejects can be edited, the following actions must have already been performed: 

Opening a file (see Opening an Existing ACME Input File). 
Note #1: Some files may not have MICAR rejects to edit. 
Note #2: Users cannot add records to the MICAR rejects file; MICAR rejects are identified (and this 
file is generated) during MICAR200 processing. 

 

If the current input file has any MICAR rejects, those rejects will need to be edited before continuing 
in ACME/TRANSAX. To edit MICAR rejects: 

1. From the main screen, press {Alt+E} to select the Edit Menu Option. 
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2. Use the up and down arrow keys to highlight the Edit MICAR Rejects function and press 
{ENTER}. Note: If there are no MICAR rejects for this input file, this function will not be 
accessible. 
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3. The Edit Rejected Records screen will be displayed. Make the necessary corrections/edits to the 
MICAR rejects (see Making Changes to MICAR Rejects). 

  

 

4. When the corrections are complete, press {CTRL-F9} to save the changes. It is advisable to save 
changes frequently! A message box will ask if you’ve finished making changes to ALL of the 
records. To reserve the ability to edit more MICAR rejects, press {N}. The changes to the current 
record will be saved and the main screen will be re-displayed. If you’ve finished editing ALL 
MICAR rejects, press {Y}. Another message box will ask for confirmation to merge the MRJ file 
with the AIN file. 

A. To merge the corrected records with the ACME input file, press {Y}. The MRJ file will 
be merged with the AIN file and the main screen will be re-displayed. 

WARNING: If you merge the edited records with the input file, you will no longer be 
able to use the Edit MICAR Rejects function to re-edit MICAR rejects. Any further 
corrections to the MICAR rejects will then require using the Editing ACME input records 
function (see Editing an ACME Input File). 

B. To exit the Edit MICAR Rejects function without merging the rejects, press {N}. The 
current record will be saved and the main screen will be re-displayed. 
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Making Changes to MICAR Rejects 

Files containing records rejected by the MICAR programs are generated in ACME input file format. 
These records must be reviewed and coded in accordance with the NCHS multiple cause coding 
instructions given in Part 2b and Part 2e of the Vital Statistics Instruction Manual (VSIM) series. On 
most certificates, the reject record will have tentative ICD-10 codes for multiple cause data and may 
have codes for the place of injury and the intentional reject items. However, these codes are only 
provisional. The data must be reviewed carefully. Replace any incorrect data with correct multiple 
cause codes.  

 

1. Multiple Cause Codes: 

 

A. Records with one or more terms that did not match the dictionary: 

MICAR assigns ICD-10 code U00 for all terms which did not match the dictionary. These codes must 
be replaced by the correct ICD-10 code or deleted. In addition, all other multiple cause codes must be 
verified for accuracy. 

 

For example: 

Ia 1 HEMORRHAGE 

 b 1 BACK INJURY 

 c 1 INTERCOSTAL SPACE STAB WOUND 

Tentative ICD-10: )S399/S399/U00*&X59 

 

Ia 1 HEMORRHAGE 

 b 1 INTERCOSTAL SPACE STAB WOUND  

 c 1 BACK INJURY 

Tentative ICD-10: R5800/U00/S399*&X59 

 

In the first example, the MICAR system has enough information to make the HEMORRHAGE 
traumatic. However, in the second example, the system did not have enough information to convert the 
HEMORRHAGE to traumatic because the term which was not in the dictionary is reported on line b. 
MICAR rejects must be coded based upon a thorough knowledge of NCHS multiple cause coding 
rules. 
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B. Records with indications of surgery: 

 

In many cases, MICAR will contain an extra ICD-10 code immediately following the code for the 
external cause. Generally, this code must be deleted. It is also important to remember to precede the 
appropriate code with an & as required by multiple cause coding. 

 

C. Records with medical misadventures and drug therapy: 

 

In most cases, MICAR will NOT provide ICD-10 codes for records interpreted as requiring a drug 
therapy code. The multiple cause coder must provide all the codes for these records. 

 

2. Place of Injury: 

The place of injury code is assigned according to ICD-10 specifications (valid codes, blank, 0-9). This 
code is converted and copied from the MICAR input record. This code must be verified and deleted or 
retained based upon multiple cause coding rules. 

 

3. Intentional Reject: 

This code appears to the right of the label REJECT on the reject editor screen. MICAR may assign an 
intentional reject 1 - 5 on records with one or more inconsistencies reported in the duration blocks or a 
9 on records with more than four "due to" relationships. It is the responsibility of the multiple cause 
coder to correct the MICAR code assignment when necessary. 

 

4. Underlying Cause: 

A manual underlying cause (UC) code should not be assigned to the MICAR rejects. The corrected 
reject records will be combined with the records completely processed by the MICAR system and then 
they will be processed by the full ACME program. Additional rejects may occur if a record has an 
ambivalent causal relationship, an intentional reject code 5 or 9, or invalid codes or format errors. If a 
manual UC is assigned, the codes and format will be validated; records with invalid data will reject. In 
addition, the manual UC will be compared with the ACME underlying cause and the records will be 
rejected for review if the codes are different. 

 

5. ACME Reject: 

 The ACME Reject is an action code supplied by the system. As a rule, this code should not be 
changed during MICAR or ACME reject processing. When adding records to an ACME input file, this 
item should be left blank. On records rejected by MICAR, a 1 indicates that the record contains a term 
which is not in the MICAR dictionary; a 3 indicates that MICAR has identified the record as having 
conditions which cannot be handled automatically by the multiple cause rules application program. 
Action code 2 is assigned by the ACME processor. The purpose of action code 2 is to cause the ACME 
program to execute the editing and validation features but to skip the underlying cause selection 
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portion of the program logic. The manual underlying cause code is accepted as the final underlying 
cause-of-death. 

 

Rebuilding MRJ File 

The "MRJ File" is the MICAR Reject File – the file that contains the records rejected during 
MICAR200 processing. If any MICAR Rejects exist, the .MRJ File will still exist. 
 
Before ACME processing can occur, there can be no existing .MRJ File. So to move on to ACME 
processing, the user must edit any MICAR Rejects, and then must save those changes (Alt + F9) 
and merge the .MRJ file into the .AIN file. See Editing MICAR Rejects Using ACME/TRANSAX 
for more information on editing MICAR rejects and merging the .MRJ with the .AIN. 
 
Once the .MRJ File has been merged with the .AIN File, the .MRJ file is deleted. In rare instances 
(e.g., a user accidentally merged the .MRJ with the .AIN before MICAR Reject editing was 
complete), a user may wish to "back up" a step and recreate the .MRJ File. 
 
In such a case, the user can use the Rebuild MRJ File function to recreate the .MRJ File (prior to 
ACME processing). The user would then need to finish editing all of the MICAR Rejects before 
continuing on to ACME processing. 
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Editing an ACME Input File 

Before an ACME input file can be edited, the following actions must have already been performed: 

Opening a file (New Input File or Open an Existing Input File). 

 

Some input files will need to be edited. This may include editing existing certificates in the file and 
adding new certificates to a file. Follow the steps below to access the Edit ACME Input File function. 
For help adding certificates, see Adding certificates Using ACME/TransAX. 

1. From the main screen, press {Alt+E} to select the Edit menu option. 

 

2. Use the up and down arrow keys to highlight the Edit All Input Records function and press 
{ENTER}. Note: You must have a file open for this function to be active. 

  

 

3. Use {Page Up} to move to the previous record and {Page Down} to move to the next record. Edit 
the fields on the edit screen as necessary (see Master Hotkey List for more information on shortcut 
keys). See Fields on the ACME Edit Screen for specific information on valid field contents. 

 

4. To save the records and exit the Edit All Input Records function, press {Alt+F9}. The main screen 
will be re-displayed. 
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5. To exit the Edit All Input Records function without saving, press {Alt+C} or {ESC}. Press {Y} to 
confirm that you want to exit without saving. The main screen will be re-displayed. 

 

Quality Control Records in ACME/TRANSAX 

Edit QC File in ACME/TRANSAX 

This feature was designed to be used by NCHS, mostly for training and quality-control purposes. 
With "Edit QC File," ACME forces the system reject code for all records in the file to "2." When 
the system reject code is "2," ACME processing will not produce a UC code, so such records will 
be "skipped" during processing and will be rejected if they do not already contain a UC code 
(supplied by the user, not generated by ACME). Because the Edit QC function forces the system 
reject code to "2" for all records, the only processing ACME does on a QC file is to validate that 
the multiple cause and underlying cause codes are valid ICD codes. 

  

 

The QC (quality-control) feature should not typically be used by states, as it serves a rather 
specific training purpose for NCHS. 
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Entering Quality Control (QC) Certificates 

Before entering certificates for Quality Control (QC), the following actions must have already been 
performed: 

Opening a file (see Creating a New ACME Input File or Opening an Existing ACME Input File). 
Note: you should be sure that the file you open is a QC file. 

1. From the main screen, press {Alt+T} to select the Tools Menu Option. 

2. Use the up and down arrow keys to highlight the Edit QC function and press {ENTER}. 

3. A dialogue box will be displayed asking you to enter a "skip value." New records added in the QC 
mode will automatically be incremented by this "skip" amount. Enter a skip value and press 
{ENTER}. 
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4. The QC edit screen will be displayed. When new records are added, they will be incremented 
using the skip value. Normal edit functions and hot keys will be active (see Editing an ACME 
Input File). To exit the QC edit screen, press {Alt+F9} to save changes to the QC file, or {ESC} to 
exit the QC edit screen without saving. 
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Undo "2" in ACME/TRANSAX 

By design, if a user uses the Edit QC function, the certificates will now be unprocessable (the only 
validation will be to verify that codes are valid, existing codes). If Edit QC was done in error, this 
can be a major problem. The Undo "2" feature will go through a file and change any system reject 
codes from "2" (such as those set to "2" by the Edit QC function) to "0" - which will make it 
possible to process those records again. This feature may be needed by states who (against advice 
to the contrary) used the Edit QC function, but to ill effect. 

  

 

NOTE: When the Undo 2 is complete and system reject codes that were "2" have been set to "0" 
the Process menu may still be inactive (greyed out). This can happen if the file has been 
previously processed (ACME processing) and a reject file resulted. No processing is available 
while rejects remain. If the previous ACME processing was rendered invalid because the system 
reject codes were altered (e.g., mistaken use of Edit QC), the reject file(s) should be deleted in 
order to reactivate the Process menu. One simple way to do that is to open/edit the file and save it 
(Ctrl-F9), which will delete the associated reject file(s). 

 

ALSO NOTE: The Undo "2" function simply resets the system reject code for every record in a 
file from "2" to "0." Any system reject codes other than "2" (e.g., "1", ‘3") are left unaltered. 
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Processing ACME Input 

Running a Sequence Check on an ACME Input File 

Before a sequence check can be done, the following actions must have already been performed: 

Opening a file (see Creating a New ACME Input File or Opening an Existing ACME Input File). 
MICAR rejects must be edited (see Editing MICAR Rejects Using ACME/TRANSAX). 
 

The Sequence Check Function creates a file (named filename.SSQ) containing a report showing 
certificate numbers in one of three different formats. 

• A ‘’standard report" will display all of the missing certificate numbers in ascending order. 

• A "series report" (the default choice) will display all of the missing certificate numbers in 
ascending order, grouped into series based on the first digit (e.g., all certificates beginning with 
"1" would be grouped together). 

• An "actual report" is a report showing all of the certificates actually present in the database. 
Rather than being a "missing certificates" report (like the "standard report"), the actual report 
shows the certificates that are actually present in the database. 

Together, these reports can reveal if there are missing, extra, duplicate, or out-of-sequence certificates 
in the database file. The Sequence Check can be used only when a file is currently open. To use the 
sequence check: 

1. From the main screen, press {Alt+T} to select the Tools Menu Option. 

 

2. Use the up and down arrow keys to highlight the Sequence Check Function. Press {ENTER}. 

 

3. A window will be displayed requesting a beginning certificate number and an ending certificate 
number. ACME automatically fills in the first and last certificate numbers for the current file. To 
change these certificate numbers: 

A. Use the {TAB} key to place the cursor in the desired field. 

B. Type in either the beginning certificate number (the starting certificate number for the 
sequence check), the ending certificate number (the ending certificate number for the 
sequence check), or both. Click "OK." 
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C. Choose the type of report you wish to generate (standard, series, or actual) in the options 
box. Series report is the default. 

1. The output of the sequence check (filename.SSQ) will then be displayed. Use the up and down arrow 
keys to scroll through the output (or {Page Up} and {Page Down}). Press the {ESC} key to close the 
output window. Click the Print button to print the report. 

  

"Total Prior Records" = the # of records in the file BEFORE the Beginning Certificate Number. 

"Total Future Records" = the # of records in the file AFTER the Ending Certificate Number. 
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Processing an ACME Input File 

Before processing an ACME file, the following actions must have already been performed: 

Opening a file (see Creating a New ACME Input File or Opening an Existing ACME Input File). 
MICAR rejects must be edited (see Editing MICAR Rejects Using ACME/TRANSAX). 
 

To process an ACME input file: 

1. From the main screen, press {Alt+P} to select the Process Menu Option. 

  

 

2. Use the up and down arrow keys to highlight the Process ACME Input function and press 
{ENTER}. 

 

3. A progress bar will be displayed showing the number of records that have been processed. 
Processing can be halted by pressing the {ESC} key. 

 

4. When processing is finished, a message window will be displayed. 

 

5. Press {ENTER} to return to the main screen. 
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Editing and Processing ACME Rejects 

Viewing ACME Stats 

Before ACME stats can be viewed, the following actions must have already been performed: 

Opening a file (see Creating a New ACME Input File or Opening an Existing ACME Input File). 
MICAR rejects must be edited (see Editing MICAR Rejects Using ACME/TRANSAX). 
 The ACME file must be processed (see Processing an ACME Input File). 

 

After the ACME input file has been processed, the statistics of the processing should be viewed to 
check for any discrepancies. To view the ACME Stats: 

1. From the main screen, press {Alt+V} to select the View/Reports Menu Option. 

 

2. Use the up and down arrow keys to highlight the ACME Stats function and press {ENTER}. 

 

3. The statistics report will be displayed. Use the {Page Up} and {Page Down} keys to scroll up and 
down through the report. Use the right and left arrow keys to move the window horizontally 
through the report. 
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4. When you finish viewing the report, press the {ESC} key or click the cancel button to exit. Click 
on the Print button to print the report. 

 

Viewing ACME Reject Error Messages 

Before ACME rejects can be viewed, the following actions must have already been performed: 

Opening a file (see Opening an Existing ACME Input File). 
Editing Micar Rejects, if any existed (see Editing MICAR Rejects Using ACME/TRANSAX). 
Processing an ACME Input File. 
 
Note: View ACME Rejects will only be available if there ARE ACME rejects for the current file. 

 

1. From the main screen, press {Alt+V} to select the View/Reports Menu Option. 

 

2. Use the up and down arrow keys to highlight the ACME Rejects function and press {ENTER}. 

 

3. A report window will be displayed. Use the {Page Up} and {Page Down} keys, or the scroll bars 
and mouse, to scroll through the report. 

  

 

4. To print the report, press the "Print" button. To exit the report, press the {ESC} key or the "Close" 
button. 
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5. The main screen will be re-displayed. 

 

List of ACME Reject Error Messages 

  

 

1. The following error messages indicate a need to correct the multiple cause codes and/or format, and 
to manually assign an underlying cause. 

Format Error 

TOO MANY LINES 

TOO MANY *S 

TOO MANY CODES PER LINE 

 

Code Error 

INVALID DIGIT IN CODE 

WRONG LENGTH CODE 

INVALID CODE XXXX 
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2. The following messages indicate a need to manually assign an underlying cause. 

Cause Not Addressed in Tables 

NO CAUSAL ENTRY FOR CODE XXXX 

 

Intentional Reject 

REJECT CODE = 5 (inconsistent duration which ACME cannot resolve) 

REJECT CODE = 9 (more than four "due to" relationships) 

 

Invalid ACME Underlying Cause 

INVALID UC - XXXX 

INVALID MANUAL UC = XXXX (applicable only to second pass processing) 

 

Other 

CIRCULAR LINKAGE LOOP 

 

3. Messages indicating a need to verify and possibly correct the ACME underlying cause assignment. 

Ambivalent Table Entries 

IS XXXX DUE TO YYYY MAYBE 

DS XXXX YYYY MAYBE 

SENDC XXXX YYYY MAYBE 

SENMC XXXX YYYY ZZZZ MAYBE 

IDDC XXXX YYYY ZZZZ MAYBE 

LMP XXXX YYYY MAYBE 

SMP XXXX YYY MAYBE 

LDP XXXX YYYY MAYBE 

 

ACME/Manual Discrepancy 

MANUAL UNDERLYING CAUSE = XXXX 

ACME UNDERLYING CAUSE = YYYY 
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In these cases, the ACME assignment is conditional. If in the review of the record the conditional 
underlying cause is found to be correct, no correction need be made. 

 

4. Messages which may accompany the above types but are informational in nature and give the logic 
followed in assigning the underlying cause. Such messages require no action. The following list is 
organized by selection/modification rule for sake of clarity. 

Selection Rule 

IS XXXX DUE TO YYYY YES 

IS XXXX DUE TO YYYY NO 

SELECT INITIAL TUC = XXXX - GENPRIN 

SELECT TUC = XXXX - RULE 1 

SELECT TUC = XXXX - RULE 2 

NO TUC BY GENPRINT - APPLY RULE 1 

NO TUC - REJECTED 

 

Rule 3 

DS XXXX YYYY 

DSC XXXX YYYY ZZZZ 

 

Rule A (senility) 

SENDC XXXX YYYY ZZZZ 

SENMC XXXX YYYY ZZZZ 

SENILITY DISCARDED TUC = XXXX 

 

Rule A (ill-defined) 

XXXX IS ID 

TUC IS ILL-DEFINED 

TUC NOT MODIFIED BY ID: TUC = XXXX 

SELECT MODIFIED TUC = XXXX 

IDDC XXXX YYYY ZZZZ 

SELECT TUC - XXXX - ILL DEF 

LAST ID TUC DISCARDED: USE TUC XXXX 
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Rule B 

XXXX IS TRIVIAL 

XXXX IS FROM PART II 

NO BETTER CODE - REVERT TO PREVIOUS TUC XXXX 

LAST TUC DISCARDED. USE TUC = XXXX 

XXXX IS TREATMENT - RULE B 

SELECT TUC = XXXX - RULE B 

XXXX IS N-CODE OR INVALID 

BAD TUC: REVERT TO TREATMENT = XXXX - RULE B 

 

Rule C 

LMP XXXX YYYY 

LMC XXXX YYYY ZZZZ 

LDP XXXX YYYY 

LDC XXXX YYYY ZZZZ 

SELECT TUC = XXXX - RULE C 

 

Rule D 

SMP XXXX YYYY 

SMC XXXX YYYY ZZZZ 

SDC XXXX YYYY ZZZZ 

SELECT TUC = XXXX - RULE D 

 

Recode E-Codes 

CANNOT DELETE LAST CODE = XXXX - E-CODE 

RECODE E-CODE XXXX 

CHOOSE AMP-CODE OVER E-CODE = XXXX - E-CODE 

REVERT TO ORIGINAL E-CODE = XXXX - E-CODE 
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Priority to Ampersand 

TUC IS POISONING - PREFER XXXX - AMP E-CODE 

TUC IS MED CARE - PREFER XXXX - AMP E-CODE 

TUC IS N-CODE. PREFER XXXX - AMP E-CODE 

TUC IS INVALID. PREFER XXXX - FIRST AMP CODE 

NO GOOD AMP - REVERT TO PREVIOUS TUC XXXX 

REVERT TO AMP CODE XXXX 

 

Other 

XXXX CONVERTED TO YYYY 

MANUAL UC = XXXX ACME UC = XXXX 

TUC = XXXX 

IGNORE INCONSISTENT DURATION 

 

 

Abbreviations: 

ACME UC ACME-assigned Underlying Cause code 

AMP Ampersanded code 

DS Direct Sequel 

DSC Direct Sequel Combination 

E-CODES External Cause of Injury and Poisoning Code 

ID Ill-Defined condition 

IDDC Ill-Defined Due To Combination 

LDC Linkage Due To Position Condition 

LDP Linkage Due To Position Preference 

LMC Linkage With Mention Of Combination 

LMP Linkage With Mention Of Preference 

MANUAL UC Manually assigned Underlying Cause code 

MED-CARE Medical Care Code 

N-CODES Nature of Injury and Poisoning Code 
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NON-ID Non-Ill-Defined condition 

SDC Specificity Due To Position Combination 

SENDC Senility Due To Combination 

SENMC Senility with Mention of Combination 

SMC Specificity With Mention Of Combination 

SMP Specificity With Mention Of Preference 

TUC Temporary Underlying Cause 

TUC2 second Temporary Underlying Cause 

XXXX code 

YYYY code 

ZZZZ code 

 

 

Editing ACME Rejects - General Procedure 

Before ACME rejects can be edited, the following actions must have already been performed: 

Opening a file (see Creating a New ACME Input File or Opening an Existing ACME Input File). 

MICAR rejects must be edited (see Editing MICAR Rejects Using ACME/TRANSAX). 

The file must be processed (see Processing an ACME File). 

 

ACME/TRANSAX is designed to reject records with invalid formats or codes, intentional reject codes 
(5 and 9), and records that can be assigned only a conditional underlying cause of death. These rejects 
will need to be edited and re-processed (see Processing ACME Rejects). The screens displayed and the 
keys used for Editing ACME rejects are the same as those used for editing MICAR rejects (see Editing 
MICAR Rejects Using ACME/TRANSAX). To edit ACME rejects: 

1. From the main screen, press {Alt+E} to select the Edit Menu Option. 

 

2. Use the up and down arrow keys to highlight the Edit ACME Rejects function and press 
{ENTER}. The Edit Records screen will be displayed. 

 

3. Make corrections as necessary to correct the ACME rejects (see the Master Hotkey List for helpful 
shortcut keys). 
 
NEW:  Pressing {F7} will jump directly to the UC Field, where you can enter the correct 
underlying cause. 
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4. To view the reject messages, press {Alt+M}. Alt+M is a toggle control. Pressing Alt+M will 
toggle the view messages feature on and off. To edit codes other than the UC, you can now edit 
the Entity String directly below the Certificate Number field, or you can press Alt+M to toggle off 
the message view if you want to edit codes directly in the grid. 

 

5. To save the corrections, press {Alt-F9}. The main screen will be re-displayed. Note: You can save 
changes and then go back to make more corrections later as long as the file has not been re-
processed. For instructions on how to re-process the correct batch, see Processing ACME Rejects. 

 

Using Error Messages to Edit ACME Rejects 

Correction Instructions: 

1. Obtain the certificate(s) and any available additional information. 

 

2. For each record in the file, you MUST do one of the following: 

A. Manually assign an underlying cause of death 

B. Correct an erroneous conditional underlying cause assignment made by ACME 

C. ACME is allowed to keep the conditional assignment made if the assignment is correct. This 
is the default option and requires no action by the individual processing the reject lists. 

If the Error Messages indicate invalid codes, you should also modify multiple cause codes as 
necessary.  

 

3. The following table lists what corrective action should be taken with a given error message. 

 

TABLE OF MESSAGES REQUIRING ACTION 
 

 

Error Message 

Correct Multiple 
Cause Codes 
and/or Format 

Manually Assign 
Underlying Cause 

Check ACME 
Underlying Cause & 
Manually Assign if 
Incorrect 

TOO MANY LINES X X  

TOO MANY *’S X X  

TOO MANY CODES PER 
LINE 

X X  

INVALID DIGIT IN CODE X X  
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WRONG LENGTH CODE X X  

INVALID CODE XXXX X X  

INVALID CODE IN 
PARENTHESES 

X X  

NO ENTRY IN TABLE C 
FOR CODE XXXX 

 X  

REJECT CODE = 5  X  

REJECT CODE = 9  X  

XXXX IS INVALID 
UNDERLYING CAUSE 

 X  

INVALID MANUAL 
UNDERLYING CAUSE = 
XXXX (second-pass processing 
only) 

 X  

CIRCULAR LINKAGE LOOP  X  

CAN XXXX BE DUE TO 
YYYY 

MAYBE  X 

XXXX DS YYYY MAYBE  X 

XXXX SENDC YYYY MAYBE  X 

XXXX SENMC YYYY ZZZZ MAYBE  X 

XXXX IDDC YYYY ZZZZ MAYBE  X 

XXXX LMP YYYY MAYBE  X 

XXXX SMP YYYY MAYBE  X 

XXXX LDP YYYY MAYBE  X 

MANUAL UNDERLYING 
CAUSE = XXXX 

  X 

ACME UNDERLYING 
CAUSE = YYYY 

  X 

    

 

Processing ACME Rejects 

Before ACME rejects can be processed, the following actions must have already been performed: 

Opening a file (see Creating a New ACME Input File or Opening an Existing ACME Input File). 
MICAR rejects must be edited (see Editing MICAR Rejects Using ACME/TRANSAX). 
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The file must be processed (see Processing an ACME Input File). 

 

To process ACME rejects: 

1. From the main screen, press {Alt+P} to select the Process Menu Option. 

 

2. Use the up and down arrow keys to highlight the Process ACME Rejects function and press 
{ENTER}. 

 

3. A progress bar will be displayed showing the number of records that have been processed. 
Pressing the {ESC} key will halt processing. 

 

4. When processing is finished, a message window will be displayed. 

 

5. Press {ENTER} to return to the main screen. 

 

TRANSAX Processing 

Processing a TRANSAX File 

Before TRANSAX processing will be available, the following actions must have already been 
performed: 

Opening a file (see Creating a New ACME Input File or Opening an Existing ACME Input File). 
MICAR rejects must be edited (see Editing MICAR Rejects Using ACME/TRANSAX). 
The ACME file must be processed (see Processing an ACME Input File). 
ACME rejects must be edited (see Editing ACME Rejects), if necessary. 
ACME rejects must be processed (see Processing ACME Rejects), if necessary. 

 

ACME processing produces a TRANSAX input file that will then need to be processed. Remember 
that all of the ACME rejects must be edited before TRANSAX processing can be performed. The steps 
for Processing a TRANSAX File are very similar to those for Processing an ACME Input File, but 
(because all rejects have been reconciled) no rejects are generated. 

 

1. From the main screen, press {Alt+P} to select the Process Menu Option. 

 

2. Use the up and down arrow keys to highlight the Run TRANSAX function and press {ENTER}. 
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3. A progress bar will be displayed showing the number of records that have been processed. 
Pressing the {ESC} key will halt processing. 

 

4. When processing is finished, a message window will be displayed. NOTE: The ASCII output file 
will be created automatically. 

 

5. Press {ENTER} to return to the main screen. 

 

Viewing TRANSAX Stats 

Before TRANSAX stats can be viewed, the following actions must have already been performed: 

Opening a file (see Creating a New ACME Input File or Opening an Existing ACME Input File). 
MICAR rejects must be edited (see Editing MICAR Rejects Using ACME/TRANSAX). 
The ACME file must be processed (see Processing an ACME Input File). 
ACME rejects must be edited (see Editing ACME Rejects), if necessary. 
ACME rejects must be processed (see Processing ACME Rejects), if necessary. 
 TRANSAX processing must have been performed (see Processing a TRANSAX File). 

 

The directions for viewing TRANSAX statistics are very similar as those for Viewing ACME Stats. To 
view TRANSAX stats: 

 

1. From the main screen, press {Alt+V} to select the View/Reports Menu Option. 

 

2. Use the up and down arrow keys to highlight the TRANSAX Stats function and press {ENTER}. 

 

3. The TRANSAX stats will be displayed. Use the {Page Up} and {Page Down} keys to scroll up 
and down through the report. Use the right and left arrow keys to move the window horizontally 
through the report. 

 

4. When you finish viewing the report, press the {ESC} key or click on the Cancel button. To print 
the report, click on the Print button. 

 

Running a Sequence Check on a TRANSAX Output File 

A sequence check can be performed on the TRANSAX output file (filename.TRX - generated 
automatically during TRANSAX processing). The procedure for this is nearly identical for running a 
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sequence check on an input file: 

1. From the main screen, press {Alt+T} to select the Tools Menu Option. 

 

2. Use the up and down arrow keys to highlight the TRANSAX Sequence Check function and press 
{ENTER}. 

 

3. A sequence check window will be displayed with the starting and ending certificate numbers in 
the file. Check the certificate numbers to be sure they are correct. 

  

 

4. Change the starting and ending certificate numbers, if necessary: 

A. Use the {TAB} key to highlight either the beginning or ending certificate number. 

 

B. Type in the new certificate number. 

 

5. To begin the sequence check, click the "OK" button. 

 

6. A report window will be displayed. Use the {Page Up} and {Page Down} keys, or the scroll bars 
and mouse, to scroll through the report. 

 

7. To print the report, press the "Print" button. To exit the report, press the {ESC} key or the "Close" 
button. 
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8. The main screen will be re-displayed. 

 

Viewing Rare Causes 

Before Rare Causes can be viewed, the following actions must have already been performed: 

Opening a file (see Creating a New ACME Input File or Opening an Existing ACME Input File). 
MICAR rejects must be edited (see Editing MICAR Rejects Using ACME/TRANSAX). 
The ACME file must be processed (see Processing an ACME Input File). 
ACME rejects must be edited (see Editing ACME Rejects), if necessary. 
ACME rejects must be processed (see Processing ACME Rejects), if necessary. 
TRANSAX processing must have been performed (see Processing a TRANSAX File). 

 

The Rare Causes can be viewed in the same manner as Viewing ACME Stats. The certificates will be 
displayed as lines of code with the assigned ICD Codes in the entity axis positions as shown in the ACME 
Input File Format. To view rare causes: 

 

1. From the main screen, press {Alt+V} to select the View/Reports Menu Option. 

 

2. Use the up and down arrow keys to highlight the Rare Causes function and press {ENTER}. 

 

3. The Rare Causes will be displayed. Use the {Page Up} and {Page Down} keys to scroll up and down 
through the report. Use the right and left arrow keys to move the window horizontally through the 
report. Note: the report does not highlight the rare causes for you. You must identify the codes 
yourself. 

 

4. When you finish viewing the report, press the {ESC} key or click on the Cancel button. To print the 
report, click on the Print button. 

Rerun TRANSAX 

Once ACME processing is complete - meaning the software has produced a TRANSAX file - this 
menu option (found under the Process menu) will be available. It is not necessary to run this item: 
the function is primarily for NCHS use. 

 

Some users have mistakenly run this option because they believed the file was not done until all 
items in the process menu were complete (meaning grayed out and inaccessible). 

NOTE: This item will remain available as long as there is a TRANSAX file. It remains true that 
once the user has used ACME to create a TRANSAX (.TRX) file, the processing is complete and 
the file(s) should be sent to NCHS. 
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Copy Transax 

 

The Copy Transax function of ACME/TRANSAX, found under the Tools menu, is very 
straightforward – it makes a copy of the existing .TRX file and moves it into the MMDS Backup 
Directory. 

 

To use the Copy Transax function: 

 

1. Under Tools menu, choose "Copy Transax". 

 

2. The .TRX file will be copied into the Backup Directory. 

 

ACME/TRANSAX Backups 

Creating ACME/TRANSAX Backups 

Before ACME/TRANSAX backups can be made, the following actions must have already been 
performed: 

Opening a file (see Creating a New ACME Input File or Opening an Existing ACME Input File). 
 

After processing the data files, a backup should be made of the files that have been used and generated 
by ACME/TRANSAX. All of the data and the associated files (including the TRANSAX output file) 
will be backed up. It is also recommended to create a backup at the end of each day. To create a 
backup: 

1. From the main screen, press {Alt+B} to select the Backup Menu Option. 

 

2. Use the up and down arrow keys to highlight the Backup All Files function and press {ENTER}. 

 

3. A Backup Dialog box will appear with a display box containing the Backup Directory, any floppy 
disk drives on your computer, and an option to choose another location. Click to select one of 
those destinations. 
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4. Once your destination is selected, you may Click on the Start button to begin the backup, the 
Close button to abort the Backup, or the Help button for more information. 

 

5. Clicking on the Start button will begin the backup process (filename.SBK). If a previous backup 
exists, you will be prompted to either abort the backup or replace the previous backup. If you 
choose to replace the previous backup, that prior backup file will be renamed before the current 
backup is performed (filename.AB$); Thus one accidental "replace" during backup can still be 
recovered (see the topic on Recovery Files in the System Manager’s section for more 
information). While the backup is underway, the title of the dialog box will change to "Working." 
When the backup is complete a "Backup Successful" message will appear. 

 

6. The main screen and Menu Bar will be re-displayed. 

 

Creating ACME/TRANSAX Backups for NCHS 

Before backups can be created, the following actions must have already been performed: 

Open a file (New Certificate File, or Open an Existing File). 
ACME processing AND TRANSAX processing (Process An ACME Input File and Process a 
TRANSAX File). 

Please note that the file must have certificates in it in order to create the backup. 

 

After all editing and processing has been finished, backups of the certificate data should be made (see 
Creating ACME/TRANSAX Backups). A second backup, with ONLY selected files, should then be 
done using this Backup for NCHS function. These backup files can then be sent to NCHS for further 
processing. 
Note: the Backup for NCHS function is NOT A COMPLETE BACKUP! For a complete backup, use 
the Backup All Files function. Backup for NCHS should not be relied upon as the only regular backup 
routine. 
This Backup for NCHS function will create a ssyylll.ZIP file (ss = state code, yy = year, 1lll = 
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shipment number) containing a MICAR200 file. This information will be pulled automatically from 
the Header information. You must update your header information, particularly the shipment number, 
for each batch. 

 

1. From the main screen, press {Alt+B} to select the Backup Menu Option. 

 

2. Use the up and down arrow keys to highlight the Send Files to NCHS function and press 
{ENTER}. 

 

3. A Backup Dialog box will appear with a display box containing the Backup Directory, any floppy 
disk drives on your computer, and an option to choose another location. Click to select one of 
those destinations.  

 

4. Once your destination is selected, you may Click on the Start button to begin the backup, the 
Close button to cancel the Backup, or the Help button for more information. 
 

5. Clicking on the Start button will begin creating the backup file (filename.ZIP). If a previous 
backup exists, you will be prompted to either cancel the current backup process or to continue. If 
you continue, the older backup will be replaced. When the backup is complete a "Backup 
Successful" message will appear. 

 

6. The main screen and Menu Bar will be re-displayed. 

 

 

Generating Reports in ACME/TRANSAX 

ACME Reports 

ACME/Transax creates reports detailing aspects of the cause of death data for a given file in many 
different ways. A list of the available reports is given below (note that some of these reports are 
covered in other areas of the help documentation). Because these reports are based on information 
collected during various steps in ACME/TRANSAX processing, not all reports will be available 
until a final TRANSAX output file is created (menu items for unavailable reports will be grayed 
out and inaccessible). 

MICAR Rejects (covered in Viewing MICAR Rejects Using ACME/TRANSAX). 

 

ACME Rejects (covered in Viewing ACME Reject Error Messages). 
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ACME Stats (covered in Viewing ACME Stats). 

 

TRANSAX Stats (covered in Viewing TRANSAX Stats). 

 

ACME Input: To access this report, click the menu option View and choose ACME Input. This 
report shows ACME information from EVERY record in the .AIN file. 

 

Ucode: This report, only available AFTER final TRANSAX processing, simply lists the final 
Underlying Cause for every record in the TRANSAX file. 

 

Rare Causes (covered in Viewing Rare Causes). 

 

Exiting ACME/TRANSAX 

Closing an ACME/TRANSAX File 

Before accessing some functions (e.g., re-setting the data path), you must close an open 
ACME/TRANSAX file. To close an ACME/TRANSAX file: 

1. From the main screen, press {Alt+F} to select the File Menu Option. 

 

2. Use the up and down arrow keys to highlight the Close File function and press {ENTER}. 

 

3. The currently open file will be closed. The filename will disappear from the status bar at the top of 
the main screen. To open a new file, see Opening an Existing ACME Input File. 

 

Exiting ACME/TRANSAX 

There are numerous ways to exit ACME/TRANSAX. For shortcut keys such as {Alt+X} and {ESC}, 
see the Master Hotkey List. 
To exit ACME/TRANSAX through the File Menu: 

1. From the main screen, press {Alt+F} to select the File Menu Option. 

 

2. Use the up and down arrow keys to highlight the Exit ACME/TRANSAX Function and press 
{ENTER}. 
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3. A message window will be displayed. 

A. To exit ACME/TRANSAX, press {Y}. The ACME/TRANSAX program will close. 

B. To cancel the exit, press {N}. The main screen will be re-displayed. 

 

System Manager's Guide 

Purpose of System Manager's Help Documentation 

The System Manager’s section of this help documentation contains some of the more technical 
information and overarching system topics, such as: 

• Installation 

• data paths / file management 

• data flow 

• specifics about input/output files. 

As you would expect, the System Manager’s section covers setup, coordination, and data flow from the 
perspective of a System Manager. This section contains information applicable to each of the programs 
in the MMDS software suite (SuperMICAR, MICAR200, and ACME/TRANSAX). For further help 
with the MMDS software, see Technical Support for MMDS Software.  

 

Installing the MMDS Software 

To install the MMDS software, you will need: 

1. The latest version of the MMDS software on CD-ROM. 

2. These installation instructions (shipped as an enclosure with your software and also contained in 
the System Manager’s Guide section of the help documentation). 
 

Steps for installing: 

1. Insert the CD-ROM into the CD-ROM drive. The AutoRun feature should automatically begin the 
installation process. If the setup does not automatically begin, then you will have to start the install 
process by double-clicking on Setup.exe located on the CD-ROM (go under Start, Run, and type 
"d:\setup.exe" where "d" is the letter of your CD-ROM drive). 

 

2. The Setup screen will now ask if you to select the destination directory for the software. 
"C:/WinMMDS" is the default directory in which the files will be installed. If you need to change 
the directory, click the Browse button and choose an alternative directory. Note: If you choose a 
directory other than the default directory, you should be sure to verify the path settings (go under 
Tools | Options) the first time you run each of the MMDS programs. Click Next to continue. 
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3. The setup screen will then ask you to choose a Setup type. You can choose from typical, 
compact, or custom (default is typical). Select the setup you wish and click Next to continue. 

  

 

A. A typical installation will install the entire MMDS software suite, including 
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SuperMICAR (along with UtilsMICAR), MICAR200, and ACME/TRANSAX. 

 

B. A compact installation will install only the data entry package: SuperMICAR. 

 

C. A custom installation allows you to select which of the programs will be installed. If you 
click Next, a new dialog box will appear where you can select which program(s) to 
install. Click Next to continue. 

  

 

4. The Select Program Folder screen will appear and give you the chance to rename the folder in 
your Start Menu where the programs icons will be placed (default = "WinMMDS"). To change the 
name, type over the default folder. Click Next to continue. 
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5. A confirmation screen will display your installation choices. Click Back to change any of your 
installation choices, or click Next to continue. 

  

 

6. Setup will copy the necessary files and install the icons. 
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7. When the installation is finished, click Finish to end the MMDS software setup. To run one of the 
MMDS programs, click onto Start | Programs | WinMMDS (your folder name from step 4) and 
choose the program you want to run (e.g., SuperMICAR). 
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File Naming Conventions 

SuperMICAR files must be exactly seven characters. For consistency, it is recommended that each 
state use a file naming convention that allows the system manager to easily identify each file by its 
name. NCHS uses a file name convention that identifies each file by its state abbreviation, lot number, 
data year, and coder status. Thus, each filename would look like this: 
 

SSYYLLL.xxx, where 
 

SS is the state abbreviation. 

YY is the 2-digit data year. 

LLL is the shipment number. 

.xxx is the file extension that identifies each type of file. For more information about file types 
used by the MMDS software, see Files Used by MMDS Software. 

Using the NCHS file naming convention, the file for: 
Alabama, shipment A12, in year 2000 

would have the name: 
AL00A12.DBF. 

While the states are free to use any file naming convention they desire, the file name convention 
described above is used to name the backup file when backing up a batch for shipment to NCHS (The 
Backup for NCHS functions will rename the files to match this convention, drawing their information 
from the header information). 
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Work Flow Diagram 

  

 

Files Used by MMDS Software 

The MMDS software uses a wide variety of file names and file types. These are detailed below. 

 

MMDS Files Include: 

Input files are used to begin work. 
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Working files are used by the programs. 

Output files are used to send files to next stage. 

Backup files are used to save and transmit data. 

Report files are used to show results. 

Configuration files store operational information. 

Help files contain tips for software use. 

Table files are used in processing. 

 

Data Entry Input Files 

SuperMICAR 

• Uses filename.DBF for Open and Create functions. This is a database file containing some of the 
certificate data. Note: The three Data Entry Working Files (see below) must accompany this file in 
order for the Input Files to work properly. 

• Uses filename.S10 for Import function. This is an ASCII file used to take data already captured as 
text into a SuperMICAR database file. 

 

Data Entry Working Files 

SuperMICAR uses the following working files along with the filename.DBF files. These three files 
plus the filename.DBF MUST be present for the filename.DBF file to work properly. 

• filename.FPT contains some certificate data not found in the DBF file. It is a database file. 

• filename.CDX is the index for the database files. 

• filename.HDR is the file containing the header information for each file. 

Note: The system will keep these three files plus the filename.DBF together. If you ever have to 
manually copy these files, it is imperative you copy all four of them. A DBF alone is not sufficient to 
use or from which to recover data! 

• filenameA.dbf, filenameA.cdx, and filenameA.fpt combine to hold Additional Information (AI). 

 

Data Entry Output Files 

SuperMICAR uses the following file extension for output files. 

• filename.10N is the output file. It is a "flat file" (ASCII text). The file is created after processing 
by using the Generate MICAR 200 File function. The file is then used by MICAR200. 
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Data Entry Backup Files 

SuperMICAR 

• filename.SBK files are created by Backup All function. 

• filename.SUP files are created by Backup for NCHS function and are renamed by the software. 

• filename.SB$ files are safe "restore" backups, generated when a previous backup exists to prevent 
data loss. 

• filename.SU$ files are "2nd generation" backups. If a backup file already exists, then upon further 
backup, that information is "pushed" into the filename.SU$ file. 

 

Data Entry Report Files 

SuperMICAR generates report files used to present information. 

• filename.SSQ files are created by sequence checks in SuperMICAR. 

• filename.SER files contain error listing and processing information in SuperMICAR. 

• filename.POI files contain place of injury listings. 

• filename.SPL files contain misspellings report(s). 

• filename.SIL files contain ILLEGIBLEs report(s). 

• filename.DUR files contain non-unit durations report(s). 

• PRINT.TXT file contains the text of the latest Print All Certificates request. 

• PRINTREJ.TXT file contains the text of the latest Print Rejected Certificates request. 

• MICTIME.RPT file contains the Coder Statistics report. 

• MICLOAD.RPT file contains the import validations report. 

 

MICAR200 Input Files 

• filename.10N file for Open function. This is an ASCII file containing all the information from the 
data entry software. 

 

MICAR200 Output Files 

• filename.AIN is the output file 

• The filename.AIN file is created by the Process All Records function. This contains the records 
ready for ACME processing. This is an ASCII file. 

• A filename.MRJ file may also be created if the option to "Code Multiple Cause in ACME" is set to 
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"YES." If this option is set to "No" the MRJ file will not be created. This contains the records 
requiring coding for data entry errors or multiple cause coding. This is an ASCII file. 

These files are then used by ACME/TRANSAX. 

 

MICAR200 Report Files 

• filename.SSQ files are created by the Sequence Check function. This is an ASCII file. 

• filename.1ST and filename.2ST files contains the statistics reports from MICAR100/200 
Processing and may be viewed with the View MICAR 100 Statistics and View MICAR 200 
Statistics functions. 

 

ACME/TRANSAX Input Files 

• Uses filename.AIN for the Open Input File function. This is an ASCII file. 

 

ACME/TRANSAX Working Files 

• filename.MRJ file is used by the Edit MICAR Rejects function. This is an ASCII file. 

• filename.ARJ file contains ACME rejects and is used by the Edit ACME Rejects function. This is 
an ASCII file. 

• filename.TIN file is the TRANSAX input file and is used by the Process TRANSAX function. 
This is an ASCII file. 

 

ACME/TRANSAX Output Files 

• filename.TRX is the output file for ACME/TRANSAX. This is an ASCII file. 

• The filename.TRX file is generated by the Process TRANSAX function. 

• The filename.TRX file is the final output file of the MICAR system. 

 

ACME/TRANSAX Backup Files 

• filename.ABK files are created by the Backup All Files function. 

• filename.ZIP files are created by the Backup for NCHS function and are renamed by the software. 

• filename.AB$ files are safe "restore" backups, generated when a previous backup exists to prevent 
data loss. 
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ACME/TRANSAX Report Files 

• filename.SSQ file is created by the ACME Sequence Check function. This is an ASCII file. 

• filename.AMS file contains ACME Messages and is created by the Process ACME Input function. 
This is an ASCII file. 

• filename.AST file contains ACME Statistics information and is created by the View ACME Stats 
function. This is an ASCII file. 

• filename.RAR file is created IF you have rare causes. This is an ASCII file. 

 

MMDS Configuration files 

Configuration files store useful program information such as path settings and last file open. 

• MMDS2003.ini stores the valid path and other configuration settings for all programs. 

 

MMDS HELP Files 

• MMDSHelp.HLP is the help file; It is activated by choosing "Contents" or "Index" under the Help 
Menu or by pressing {F1}. This file can also be run independent of the MMDS software. 

• MMDSHelp.CNT is the associated Table of Contents file for the electronic help file. 

• RoboEx32.dll is a "helper" file necessary to properly run the electronic help documentation. 

 

Table Files 

The MMDS system relies on a large number of tables to maintain accurate processing. These are 
installed in the TABLES directory. Each of the .DBF files has a corresponding .CDX file and a 
corresponding .DAT file as well. None of these files should be modified by the user. 

 

SuperMICAR Tables 

Bbd.DBF The BBD.DBF file contains an entity reference number (ERN) dictionary for 
over 150,000 medical causes of death. These are used during processing to look 
up entity reference numbers. The BBD.DAT file looks up text to find a matching 
ERN. 

Ern.DBF The ERN table 

Extern10.DAT A textual definition of the External Cause prompts. This file is read to create the 
menus and selections taken from the External Cause prompts. This file is 
installed in the <TABLES> directory. 

Dict.DBF A list of words recognized by SuperMICAR and their attributes. 

Lexicon.DBF A list of words used by the spell checker. 
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Ruledata.DBF A list or words and weightings used for external processing. 

Thesaur.DBF A list of words and their synonyms. 

States03.TXT A list of state abbreviations and codes. 

 

MICAR200 Tables 

Abbrev.FIL Text file of common medical term abbreviations. 

Aspatin.W99 Asphyxiation anchor table. 

Aspstin.W99 Asphyxiation subanchor table. 

BBD.DBF Table takes TEXT and returns associated ERN. 

Cantin.W99 Cancer table. 

Cvtern.W99 Table takes ERN and returns associated ICD code. This table also contains 
the rules control flags, which drive decision-making. 

Delword.FIL Text file of words the system is allowed to drop during lookup. 

Eccvtin.W99 E-code conversion table. 

ERN.DBF Table takes ERNs and returns associated TEXT. 

Ext-ern.DBF Table containing ERNs that denote Nature of Injury. 

Histcan.W99 Histiological cancer table. 

Histsyn.W99 Synonymous subanchor for Histiological cancer table. 

Icatin.W99 Intent of Certifier anchor table. 

Icstin.W99 Intent of Certifier subanchor table. 

Ipsyns.W99 Infectious & Parasitic Disease synonyms table. 

Iptable.W99 Infectious & Parasitic Disease table. 

Lst1fil.W99 Surgery table 1. 

Lst2fil.W99 Surgery table 2. 

Lptable.W99 L-prompt table. 

Mcatin.W99 Malignant Cancer anchor table. 

Mcstin.W99 Malignant Cancer subanchor table. 

Rhdtin.W99 Rheumatic heart disease table. 

Rmcalc.W99 Relating and Modifying exceptions for Calculus table. 

Rmedema.W99 Relating and Modifying exceptions for Edema table. 
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Rmhemex.W99 Relating and Modifying exceptions for hemorrhage table. 

Rmsyns.W99 Relating and Modifying synonyms anchor table. 

Rmtable.W99 Relating and Modifying anchor table. 

Subern.FIL Binary file of out-dated ERNs, with new equivalent ERNs. 

Synonym.FIL Text file of synonyms for common medical terms. 

Vcodes.W99 ICD-10 code validation table. 

 

ACME/TRANSAX Tables 

Conv.2K3 The table used to convert artificial ICD-10 codes to original ICD-10 codes 
for a selected underlying cause 

Taba.2K3 A file of ACME causal relationship tables.  

Tabb.2K3 A file of ACME causal modification tables. 

Triv.2K3 A TRANSAX file containing pointers to the modification tables.  

Vcodes.2K3 A list of valid ICD-10 codes.  

Traxtab.2K3 TRANSAX table. 

States03.TXT A list of state abbreviations and codes. 

 

Importing from an ASCII File 

SuperMICAR has the ability to read certificate data files created by some other data entry packages, 
but this data must "imported" into a format that the MMDS software can recognize. Neither 
ACME/TRANSAX nor MICAR200 need an import function because the input files are in ASCII 
format (no import is necessary). 

 

SuperMICAR can import from a valid S10 SuperMICAR import file format, a flat ASCII file whose 
format is specified. This is identical to the SEX SuperMICAR export file format. Note that since the 
SuperMICAR file retains the original text from the certificate, the literals, this results in a duplicate of 
that record. 

 

To import data from a file using SuperMICAR: 

1. Press {Alt+F} to select the File Menu Option. 

 

2. Use the up and down arrow keys to highlight the Import function. Press {ENTER}. 
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3. If a file is currently open, a window will be displayed asking you to confirm that the file should be 
closed before the import is done. Selecting "Yes" will close the open file and continue the import. 
Selecting "No" will abort the import function. 

 

4. An Import file dialog box will be displayed. This is very similar to the Open File dialog box and 
works the same way except that the files shown will be different. SuperMICAR will display all 
*.S10 files in the directory. The initial directory shown will be the data directory as set in the 
Tools|Options function.  

  

5. The following fields will be displayed on the file selection window: 

Look In: Used to select the directory of files to be listed. Defaults to the current Data Path as set 
in Tools|Options. Clicking on the list arrow at the right side of that field will allow you to browse 
through directories. 

List of files: Displays all files of the appropriate extensions in the currently selected directory. 

File Name: Allows user to enter a specific filename or will display the name of the selected file. 

Files of Type: Restricted to the appropriate file type only. 

Open and Cancel Buttons: Used to accept selected file or to cancel open file operation. 

 

6. To select a file from the List of files for processing: 

A. Use the {TAB} key to put the cursor in the List of files field and use the up and down 
arrow keys to highlight the desired filename. The list will scroll up or down to display 
additional files. Press ENTER to proceed with opening the selected file. 

or 

B. Use the mouse to click on the file shown in the List of files field and either double-click on 
the file or click on the OK button to proceed with processing the selected file. 
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NOTE: You can only select one file. Choosing multiple files at once is not possible. 

 

7. Once a valid file has been selected it will be imported into a database and other required database 
files (DBF, FPT, CDX, HDR etc) will be created. A progress bar will be displayed showing what 
percentage of the file has been imported. When the import is complete, a message will be 
displayed. Press {ENTER}.  

 

8. When the formatted file has been read, a message window will be displayed. If there were any 
errors detected during field validation, a report of those errors will be stored in a file called 
"MICLOAD.RPT." The following errors may be reported as a result of field validation: 

"Invalid Certificate Number" (the certificate number is not exactly 6 digits) 

"Data Year and/or State Code does not match that of first record" (value for data year or state does not 
match that of the first record) 

"Invalid Age Specification (changed to unknown)" (age equals "000" or does not have exactly 3 digits) 

"Invalid Injury Date (changed to unknown)" (injury date is not in valid date format) 

 

Here is a sample of the MICLOAD report (MICLOAD.RPT): 

        SuperMICAR Import Error Listing          
 
Certificate 076001: Invalid Age Specification (changed to unknown) 
Certificate 076072: Invalid Age Specification (changed to unknown) 
Certificate 076109: Invalid Age Specification (changed to unknown) 
Certificate 076170: Invalid Age Specification (changed to unknown) 
Certificate 076264: Invalid Age Specification (changed to unknown) 
Certificate 076382: Invalid Age Specification (changed to unknown) 
Certificate 076433: Invalid Age Specification (changed to unknown) 
 

9. Press "OK" to re-display the main screen. The imported file will be open and ready for use. The 
original text file remains but a set of DBF files using the same filename have been created. 

 

Exporting to ASCII Files 

SuperMICAR has the ability to export its data in its entirety into an ASCII file format, identical to the 
S10 format. This can be useful for providing text files of the original certificate data for use with 
mainframes, queries and import into other software. ACME and MICAR200 provide for no export 
functions beyond their typical processing. 

 

Before files can be exported, the following steps must have already been performed: 

A certificate file must be open and have certificates in it (see Creating a New SuperMICAR File, or 
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Opening an Existing SuperMICAR File. 

 

1. Only the file that is currently open can be exported. To open a file, see OPENING A 
CERTIFICATE FILE FOR PROCESSING in the SuperMICAR User’s Guide Manual. The 
formatted file will be written to [filename].SEX, where [filename] is the name of the currently 
open file. 

 

2. With the file open, choose the File | Export to ASCII menu option. 

 

3. A progress bar will be displayed showing what percentage of the processing is complete. 

 

4. When the new files has been created, a message window will be displayed. Press {ENTER}. 
WARNING: The Additional Information data from SuperMICAR is given in the same format 
described in the S10 file format. All of the certificate data will be written out, followed by 
the AI data. A single line of three asterisks (***) will separate the certificate data from the AI. 
For example: 

All Certificate Data 

*** 

All Additional Information 

 

5. The main screen will be re-displayed. 

6. The file is exported into the data directory as set in the Tools|Options. It will be named after 
the original filename with an SEX extension. 

 

Regenerating a File Index 

Occasionally, the file index may be damaged and need to be repaired. The Regenerate File Index 
function of SuperMICAR rebuilds the file index from the data file. 

To regenerate file indexes, you must be running SuperMICAR: 

1. Press {Alt+T} to select the Tools Menu Option. 

 

2. Use the up and down arrow keys to highlight the Regenerate File Index function and press 
{ENTER}. 

 

3 A message will be displayed, stating that the index is being regenerated. 
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4. When the file index has been completely rebuilt, the main screen will be re-displayed. 

 

Merging Several Files Into One File 

SuperMICAR can perform two distinctly different merge functions. The "Merge Multiple (New File)" 
function allows the user to create a brand new file by merging multiple files together (The user must 
provide the filename for the new file being created). For more information on the "Merge File Into 
Open File" function, which allows the user to merge another file into the file that is currently open, see 
Merging a File Into an Open File. 

 

SuperMICAR and ACME/TRANSAX allow you to merge together several files into one file. This can 
be useful for combining files worked on by several coders before processing or to combine monthly 
files into an annual file. You can only merge files in the current data directory. If you wish to change 
directories, exit Merge and use Tools|Option to change the data path. 

 

Note: This merge methodology creates the new merged file and leaves your original files untouched, 
which is different from the Merge File Into Open File function in SuperMICAR. 

 

SuperMICAR merges DBF files. ACME/TRANSAX merges TRANSAX files, so for the 
ACME/TRANSAX merge, you must have already finished Processing a TRANSAX File. 

 

To Merge Several Files Into One File: 

1. Press {Alt+F} to select the File menu option. 
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2. Use the up and down arrow keys to highlight the Merge Multiple (New File) function and press 
{ENTER}. 

 

 

3. A Create File Name dialog will be displayed. You must give a name to the final merged file. This 
name cannot duplicate an already existing file. Once you have entered the filename, press ENTER. 

 

4. A Merge function dialog will appear. In the large field on the left, all files of the appropriate type will 
be displayed in the Mergeable Files List. This will be DBF files if you are in SuperMICAR and the 
TRX files if you are in ACME/TRANSAX. In the large field on the left will appear the files you select 
to merge in the Destination List. This will be empty at the start. 
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5. To move a single file, click to select it and then click on the single > button (or you can just double-
click on the filename). You will see the file removed from the left-hand list and appear in the right-
hand list. It can be sent back by clicking on it and clicking the single < button (or just double-clicking 
the filename). The double >> and double << buttons will transfer ALL FILES in the chosen direction. 

 

6. Once all the files you wish to merge have been placed in the destination window, click on OK to merge 
the files. 

CAUTION: The files will be merged in the order they are listed. When a duplicate record (e.g., 
another certificate #000467) is encountered, the newly-encountered record will OVERWRITE the 
previous record. Therefore, you should be sure that any update files appear last in the merge list. 

Note: All of the files must have identical State and Data Years (see Editing SuperMICAR Header 
Information) for the merge to be valid; if the chosen files are from different states or different data 
years, the merge will not be performed. 

 

7. A Header Information Screen will be displayed, giving the user the chance to make any necessary 
changes to the header information. Note that the shipment number will be blank and the correct 
shipment number should be inserted at this time. 

 

8. A window will be displayed indicating that the merge is underway. 

 

9. When the merge is completed, a message will be displayed indicating whether the merge was 
completed successfully. 
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10. A sequence check window will be displayed. The beginning and ending certificate numbers are already 
drawn from the newly-created merge file. You may change those values if necessary. Press {ENTER}. 

 

11. The output of the sequence check will be displayed. Use the up and down arrow keys (or {Page Up} 
and {Page Down}) to scroll through the output. Press {ENTER}. To print a copy of this report, press 
{Alt+P} (or click on the "Print" button). Press {Alt+C} or {ESC} (or click on the "Close" button) to 
close the output window. 

 

12. The main screen will be re-displayed. 

 

Merging a File Into an Open File 

SuperMICAR can perform two distinctly different merge functions. The "Merge File Into Open 
File" function allows the user to merge a file into the currently open file. This is distinct from 
"Merge Multiple (New File)," which allows users to create a brand-new file by merging together 
more than one existing files (the user must provide the filename for the new file being created). 
For more information on the "Merge Multiple (New File)" function, see Merging Several Files 
Into One File. 
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The "Merge File Into Open File" function will merge an existing file into the currently open file. 

  

 

1. With a file open, the user can select "Merge File Into Open File" from the File menu. At the dialogue 
box, select the file to merge into current file: 
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Note: The file being merged into the open file must have identical State and Data Year information 
(see Editing SuperMICAR Header Information) for the merge to be valid; if the files are from different 
states or different data years, the merge will not be performed. 

 

2. A window will be displayed indicating that the merge is underway. 

 

3. When the merge is completed, a message will be displayed indicating whether the merge was 
completed successfully. 

 

4. A sequence check window will be displayed. The beginning and ending certificate numbers are already 
drawn from the newly-created merge file. You may change those values if necessary. Press {ENTER}. 

 

5. The output of the sequence check will be displayed. Use the up and down arrow keys (or {Page Up} 
and {Page Down}) to scroll through the output. Press {ENTER}. To print a copy of this report, press 
{Alt+P} (or click on the "Print" button). Press {Alt+C} or {ESC} (or click on the "Close" button) to 
close the output window. 

 

6. The main screen will be re-displayed. 

 

The Unified Data Directory 

The MMDS for Windows software uses a unified data directory. The files are kept in one location as 
they go through data entry and then processing with MICAR 200 and even on to ACME/TRANSAX. 
This greatly simplifies the task of monitoring data paths. Because the software was designed for use 
with this unified data directory, and because files are often shared between different programs in the 
software suite, it is very important that the data paths reflect this unified approach. See Setting MMDS 
Options for more information. 

 

While you can use the Options functions to maintain different paths and different directory structures 
than the default settings, it is recommend that the unified data path be used. 

 

Setting MMDS Options 

Each program has a series of options that need to be set for the program to run properly. In each case 
you can set all the options by checking under the Tools menu for the Options function. 

This will bring up a dialog box with all the available options listed. 

Note: Some Options functions will be inaccessible while you have a file open (e.g., you cannot change 
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the data directory with a file currently open). To change inaccessible directories, close the current file. 

Default Directories 

During installation, the programs of the MMDS suite are written to shared directory. Each of the 
programs uses that install directory as a default for storing the files it needs to operate. You can 
change the directories using the Options menu if necessary. The default data, table, and backup 
directories used during a standard installation are: 
Data Path: C:\WinMMDS\Data 
Table Path: C:\WinMMDS\Tables 
Backup Path: C:\WinMMDS\Backup 

Other SuperMICAR Options 

Coder Statistics ON: Check this box if you want the coder stats on while using SuperMICAR. Once 
you’ve chosen to turn coder stats on, you must enter a coder ID (any combination of eight characters 
or less). To turn coder statistics off, uncheck that box on the options screen. 

Other MICAR200 Options 

Multiple Cause Coding: This sets whether the MRJ file will be generated by Process All Records. 
This should normally be set to Yes. Default is set to Yes. 

 

Backups 

SuperMICAR and ACME/TRANSAX have backups functions. These are functionally identical and 
differ only slightly in the final output products (backup files). See the sections on SuperMICAR and 
ACME/TRANSAX for more program-specific information on using the backup functions. 

 

When any backup occurs, the data files are copied from the data directory into one backup file in either 
the backup directory or the selected floppy drive. The backup files themselves are compressed to save 
space. The backup files use PKZIP compression and can be manually opened with that program. 

 

Backup All Files 

This function will backup all files of the given filename in the data directory. 

The files will be output as a single backup file in the backup path or to a floppy depending on 
what you choose. The extension for the backup files will vary depending on the program: 
SuperMICAR uses filename.SBK 
ACME/TRANSAX uses filename.ABK 

The filename will remain the same as named by the user. 

 

This function is useful for doing daily backups. It is highly recommended you do a backup at least 
once daily. 
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When the Backup All Files function is used, a check box appears on the dialog box to "Remove 
files when done." Check this box to delete the data files after the backup is complete and the data 
files have been verified. Because the box defaults to unchecked, the files will not be removed 
unless you specifically check the box. Removing files is useful when work on a batch is done. 
This function should not be used when the file still has work yet to be finished. 

 

Backup for NCHS 

In both programs, this function will backup the files of the given filename NCHS wants from your 
data directory. 

Both programs will rename the files and the backup file to match NCHS specifications. This 
information will be independent of what filename you had given. The filename information will 
be drawn from the header information, so it is imperative that you update the header 
information for each file before performing this backup. Specifically the program will draw 
the state, the year and the shipment number to construct the filename in the following format: 
SSYYLLL. The file extension will vary from program to program: 
SuperMICAR uses filename.SUP 
ACME/TRANSAX uses filename.ABK 

 

This function is to be used for sending files to NCHS when the user is finished with them. 

 

Recovery Files 

In doing a backup, SuperMICAR and ACME/TRANSAX check for a previous backup. If one exists 
you will be prompted whether you want to continue. 

If you choose NOT to continue, the backup is cancelled. 

If you choose to continue, the previous backup file is renamed and a new one created. At this point 
there are TWO backup files, the older one and the most recent. This way any given backup file is an 
accurate representation of the file(s) at a moment in time. The older "recovery" file will have the same 
filename as the backup but the extensions will be different: 
SuperMICAR uses SB$ and SU$ extensions 
ACME/TRANSAX uses AB$ and ZI$ extensions 

These files can be restored using the restore function (see Restoring from Backup) in case of 
emergency. They provide one additional level of backup safety. 

 

Restoring from Backup 

The Restore function works very similarly to an Open file function (see, for example, Opening an 
Existing SuperMICAR File). The primary difference is the Restore function extracts the files from a 
backup file and copies them into the data directory. 
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Networks and the MMDS software 

The MMDS software can accept network drives and directories for any of these paths. However there 
are some things to consider. See the help section on Troubleshooting Common Problems (e.g., Avoid 
Networked Tables) for more discussion on problems arising from improper use of the MMDS for 
Windows software on network drives. 

Data Path to a network drive is acceptable but NOT recommended. Keep in mind that your users 
will be unable to work on these files while the network is down or experiencing instability. We 
recommend keeping the data path on the hard drive to enable reliable and swift access even during 
network interruptions. 

Backup Path to network drive is acceptable and recommended. This allows you to share files, using 
Restore to get the data when starting a batch and Backup to return the files to the network file when 
done. In the meantime, while the files are being worked on, they reside on the PC. This allows for 
continuous work and sharing of data with minimal impact (both in space used and access time) on the 
networks. Backup path should NEVER be set to the same directory as the data. 

Table Path to the network drives is acceptable but NOT recommended. While it will function, the 
addition of network lag times will GREATLY slow down processing and the high volume of calls to 
those tables in processing may affect network performance. Also, network failures during processing 
will cause the access to the tables to be lost, killing the processing in mid-stream. We strongly 
recommend keeping table files on the PC’s hard drive. 

Program files on network drives is unacceptable because this creates the possibility of multiple users 
running the same program from the same location at the same time. MMDS software will not work 
properly under this setup. It is recommended that the program files be kept on the PC’s hard drives. 

 

Contact Information 

NCHS maintains a support staff to assist with any questions or issues that arise when using our 
software. See Technical Support for MMDS Software for more information. 

 

MMDS History 101: From DOS to Windows 

Versions of the MMDS software prior to version 2000 (January 2000) were DOS applications, MMDS 
version 2000 was the first Windows version of the software. There were several advantages to 
upgrading from a DOS program to a 32-bit Windows program. The Windows operating system is very 
common in the market, familiar to most users, and offers a stable operating platform. By migrating to 
32-bit technology, the MMDS software no longer depended on outdated technology. 

For the most part, the Windows versions of the MMDS software behaved the same as the older DOS 
versions. While some changes were unavoidable, the Windows versions of the MMDS software 
generally maintained the same keystrokes and functionality as the older DOS versions. 
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Troubleshooting Common Problems 

Avoid Networked Tables 

Placing the MMDS table files on a network for shared use should be avoided for the following 
reasons: 

• The speed with which the MMDS software will perform any processing or "lookups" will be greatly 
diminished. 

• The high volume of operations required by the MMDS software during processing may impact 
overall network performance (or even cause "timeout" errors with other network software). 

• Many MMDS functions will be unavailable if the network system goes down. 

 

 

Networked Executables are Risky 

The "executable" files consist of the MMDS files with the extension ".exe" (e.g., Supermicar.exe). 
These executable files should generally not be stored on network drives: 

• The programs do not support two users working off the same executable file at the same time. In 
other words, multiple "instances" of the executable files are not allowed. 

• It is recommended to have the program executables and data on the "local" PC workstation. It IS 
advised that backup files be stored on a network. 

 

Networked Data Concerns 

Multiple users cannot access the same .dbf file at the same time using the MMDS software. If a 
.dbf file is being used already, subsequent users attempting to access the file will see what looks 
like an empty batch, as if no certificates have been entered. 

 

Large Fonts are BAD! 

Windows allows users to customize their displays for fonts, colors, and resolution. This 
customization, however, can have undesirable effects on programs (such as the MMDS software). 

The latest version of the MMDS software automatically accommodates for varying end-user 
resolution settings, but the software does NOT handle the LARGE FONTS setting well at all. 
Setting the user’s system to LARGE FONTS will obscure the data entry screens in all the MMDS 
programs so that they will become unusable. To avoid this problem, please set user machines to 
SMALL FONTS. 
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CODEBASE ERROR 

One of the more common errors users of the MMDS software have experienced is called a 
CODEBASE ERROR: 

 

• Files created (or even worked on) with MMDS software version 2000.03 have the highest likelihood 
of producing this CODEBASE ERROR. 

• Typically the CODEBASE ERROR will occur during processing or in data entry mode. 

The files which produce the CODEBASE ERROR can be fixed, however, using a common 
(FoxPro) database utility program. If you have a file that produces a CODEBASE ERROR, we 
suggest you send the file to NCHS (see Technical Support for MMDS Software) to have the file(s) 
quickly "repaired" and sent back to you. 

 

When this CODEBASE ERROR occurs in files later than MMDS software version 2000.03, there 
is typically an external cause for the error: 

• The error could indicate trouble reading or writing due to: limited access rights to a network, low hard 
drive space available, or some other disk-space-related problem. 

• The error could indicate a file corruption due to power failure or improperly shutting down the user’s 
PC while an MMDS file was open. 

• Other network instability could cause corruption of the MMDS file. 

 

Note: NCHS is currently working to build a routine into the MMDS software that will correct such 
corruption problems automatically (without requiring files to be sent back to NCHS). 

 

Auto-Open Woes 

One particular default behavior for SuperMICAR and ACME is referred to as "auto-open." This 
means the programs normally open with the file status the same as it was when the user exited 
program. This means that if the user had a file (e.g., .dbf) open when he/she quit using the MMDS 
software, the software (e.g., SuperMICAR) will attempt to re-open that same working file 
automatically when the program is next run. 

The benefit of this approach is that if data entry or coding on a particular file takes several days, the user 
will not have to go through the File | Open process every time he/she re-starts the MMDS software. 
 

The detriment to this approach is that even if the file is corrupted, the MMDS software will attempt to re-
open that damaged file each time the program (e.g., SuperMICAR) is launched. Thus a user might be stuck 
watching SuperMICAR lock-up trying to open a corrupt data file whenever SuperMICAR is run. 

 

Because shutting down and re-starting SuperMICAR will only result in the same problem (SuperMICAR 
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will continue to attempt to open the corrupt file), the "Auto-Open Last File" feature can be disabled. 
Disabling this feature requires editing the MMDS2003.INI file using any text editor (such as Notepad or 
DOSEdit). 

 

To disable the Auto-Open Last File feature: 

1. Close all MMDS programs, and open the MMDS2003.INI file using the text editor of your choice 
(e.g., Notepad). The file (MMDS2003.INI) will be found in the same location as the executables - 
typically C:\WinMMDS. 

2. This .INI file holds information used by the programs of the MMDS software suite. Therefore, each 
program has it’s own "section" (e.g., "[SuperMICAR]"). Find the section(s) for the program for which 
you want to disable the Auto-Open Last File feature. 

3. Within each section (e.g., "[SuperMICAR]"), you’ll find the following line:  
"AutoOpenLastFileOpened=true". In order to disable the feature, change the "true" to "false". 

4. In the next line (last line of the section), remove any file path information following the equal sign. 
Thus the line should be: "LastFileOpened=". 

  
 

Uncorrupting Files Using FoxPro 

CODEBASE ERRORS can often be corrected without data loss. Here are some important tips 
when trying to fix corrupt files: 

• SuperMICAR database files are, for the most part, FoxPro database files. However, the words "for the 
most part" are very important! 

• Using Windows-based FoxPro (such as FoxPro 6.0) will allow you to access the SuperMICAR .dbf 
files directly. 
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The FoxPro commands to rebuild SuperMICAR data files are shown below: 

  

 

"For the Most Part?" 

SuperMICAR database files violate a field length rule employed in FoxPro (in one place - the 
"output to MICAR200" field). Consequently, if a SuperMICAR database is repaired (uncorrupted) 
using FoxPro (e.g., by using the above commands), the size of that field is automatically "fixed" 
by FoxPro to a shorter length. If left this way, that will prevent the SuperMICAR database file 
from producing valid output to MICAR200. 

 

Fixing the FoxPro "Fix" 
After using the FoxPro commands to create the fixfile.dbf (note: FoxPro also produces 
accompanying .fpt and .cdx files), this fixfile can be turned back into a SuperMICAR file. This 
involves using SuperMICAR to export the file to an ASCII file, preparing files for import, and 
using SuperMICAR to import an S10 file: For more detailed information on this procedure, please 
contact NCHS Technical Support (see Technical Support for MMDS Software). 
 

Troubleshooting: "My Work is Gone!" 

If a user calls you and says, "Help! My work is gone!" here are some likely causes to consider: 

The paths on the user’s system are set strangely or incorrectly. Check to see if the data paths have 
been changed - this could give you clues as to where to look for the file(s). Another tip: use 
searches (e.g., Windows Explorer under Tools | Find | Files or Folders) to find the files by name 
but in unexpected locations. 

The file was misnamed. Check the data directory for oddly-named files that are dated the same 
times/dates that the "missing" file was thought to have been saved. 

 

Accidental Restore/Backup 

Sometimes a user begins a new day’s work but discovers work he/she KNOWS was done 
yesterday is not in the file. In this situation the file is there, but work the user knows was 
completed is gone. This situation often reveals that the user inadvertently did a Restore instead of 
a File | Open or a Restore instead of a Backup. 

Restore instead of File | Open. If the user properly backup up the file at the end of the day and then 
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mistakenly restored the file (instead of opening it) at the start of the new day, then there is a 
reasonably good chance of recovering the data. 

Restore instead of Backup. If the user mistakenly did a Restore at the end of the day (instead of a 
Backup), then the user has pulled in old files to overwrite the work done that day. In this case, full 
recovery of the data is less likely. A good indicator that the user has restored instead of backing up 
is the date/time stamp of the backup files: 
• If the .dbf and .fpt files have a recent time/date (indicating the time/date of the last 
backup) and the other files are older (especially by a day or more), then it is likely there was an 
inadvertent Restore. In this case, go through the backup files, and the safety backups, to see if 
those files contain some of the lost work. If not, the work probably cannot be recovered. 
 

Troubleshooting: Missing Files 

If the missing file is a .dbf or .fpt file: 
• Look for a backup copy of the batch. Without a backup copy, this information cannot be 
recreated without re-entering the data. 

• If the file was sent to you, ask your user to resend and list the files needed. 

• If the file is on a local PC, check that PC and all related backups. For the missing file(s) 

 
If the missing file was a .cdx file, the menu item "Tools | Rebuild Index" can re-create the missing 
file (as long as all the other files are in place). But in order to even access the Rebuild Index menu 
item, you’ll need to create a "fake" .cdx file - because if no .cdx file exists, SuperMICAR will not 
even allow the file to be opened. 

1. Use File | New to create a new batch (which will include a "fake" .cdx file) 

2. Rename that "fake" .cdx to match your missing filename.cdx. 

3. Open the batch in SuperMICAR (File | Open). 

4. Choose the menu item Tools | Rebuild Index. 

 

Troubleshooting: Everything Rejected? 

If every record in an ACME file is rejected, look at the reject codes showing on the edit screen: 

If they are all reject code "2," then it is likely that the "Edit QC File" option under the Tools menu 
was improperly chosen at some point. 

To correct this, chose the Tools | Undo "2" menu item and reprocess the file. 

 

Be Very Careful with MICAR200 

Do not reprocess a file in MICAR200 if you have done any reject coding in ACME! 

MICAR200 produces a new .ain file from the original data entry. 
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The .ain file stores the work you did coding multiple cause and underlying cause in ACME. 

If MICAR200 Process All is rerun after ACME coding, you will lose that coding because the 
existing .ain will be overwritten. 
 

Alt-F9 Saves 

In ACME can be important that users press Alt-F9 to save work periodically. ACME does not 
save the file between each record (e.g., Page Down). Instead, all current work is stored in memory 
until F9 is used (or File | Save is chosen from the menu). 

Therefore, if the user’s PC crashes, or the power goes out, or any other problem forces an 
unconventional shut-down of ACME, all the work stored only in memory (rather than on the hard 
drive) will be lost. 

In this regard, ACME behaves unlike SuperMICAR, where going on to the next record 
automatically saves that record to the hard drive. 
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MMDS File Formats 

SuperMICAR Input File Record Format 

The Additional Information data from SuperMICAR is given in the same format described in the 
following table. All of the certificate data will be written out, followed by the AI data. A single line of 
three asterisks (***) will separate the certificate data from the AI. For example: 

All Certificate Data 

*** 

All Additional Information 

 

SuperMICAR Input Record Format 

 

Variable Position Length Description 

Date of death – Year  01-04 4 Year of Death (Numeric) 

State of death 05-06 2 Alpha, see FIPS Table 5-2; NCHS part 8 
Instruction Manual  

Certificate Number 07-12 6 6-digit number, padded with 0's on left 
(000001-999999) 

Coder Status 13 1 Numeric: Valid codes 0 - 9 

Lot 14-17 4 NCHS ID Information, Numeric, 0001-9999 
(States commonly use "book number") 

Section Number 18 1 NCHS ID Information. Numeric, 0-9 

Shipment Number 19-21 3 NCHS ID Information, Alpha\Numeric 
(Usually month of death or month of receipt) 

Receipt Date 22-29 8 NCHS ID Information. Data inserted at the 
time file is received by NCHS-MMDDYYYY 

PGM Version Control 30-33 4 Version number for the SuperMICAR program 
(computer-generated) 

 

Date of Death - Month 34-35 2 Date of death (month): 01-12. 99 

Date of Death - Day 36-37 2 Date of Death (day): 01-31, 99 

Sex 38 1 Male..................................M 
Female ..............................F 
Unknown ..........................U 
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Age: units 39 1 Years.................................1 
Months..............................2 
Weeks ...............................3 
Days..................................4 
Hours ................................5 
Minutes .............................6 

Unknown ..........................9 

Age: number of units 40-42 3 001 - 135, 999 

Cause of Death Part I 
Line a 

43-162 120 Literal information reported on Line a 

Cause of Death Part I 
Interval, Line a 

163-182 20 Duration reported on Line a 

Cause of Death Part I 
Line b 

183-302 120 Literal information reported on Line b 

Cause of Death Part I 
Interval, Line b 

303-322 20 Duration reported on Line b 

Cause of Death Part I 
Line c 

323-442 120 Literal information reported on Line c 

Cause of Death Part I 
Interval, Line c 

443-462 20 Duration reported on Line c 

Cause of Death Part I 
Line d 

463-582 120 Literal information reported on Line d 

Cause of Death Part I 
Interval, Line d 

583-602 20 Duration reported on Line d 

Cause of Death Part II 603-842 240 Literal information reported in Part II 

Did Tobacco Use 
Contribute to Death? 

843 1 Yes....................................Y 
No .....................................N 
Probably............................P 
Unknown ..........................U 
Not on certificate ..............C 
Blank ................................blank 

Pregnancy 844 1 Not pregnant within past year.......1 
Pregnant at time of death ..............2 
Not pregnant, but pregnant 
within 42 days of death.................3 
Not pregnant, but pregnant 
43 days to 1 year before death ......4 
Unknown if pregnant within 
past year........................................9 

Blank ............................................ blank 

N/A: computer generated.............. 8 
Not on certificate .......................... 7 
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If Female (edit flag: 
from EDR only) 

845 1 Edit Passed..................................0 
Edit failed, data queried 
& verified....................................1 
Edit failed, data queried 
but not verified............................2 

Manner of Death 846 1 Natural ........................................N 
Accident......................................A 
Suicide ........................................S 
Homicide ....................................H 
Pending Investigation .................P 
Could Not be Determined...........C 
Blank ..........................................blank 

 

Date of Injury 
  Month (2)  
  Day (2)  
  Year (4) 

847-854 8 Numeric or blank if no injury reported. 
2 digit month (01-12, 99, blank) 
2 digit day (01-31, 99, blank) 
4 digit year  (4-digit year, 9999, blank) 
If any portion is not reported ............. 99 

 

Time of Injury 855-858 4 0000-2400, 9999, blank 

Units of Time 859 1 AM..................................A 
PM ..................................P 
Military time (24 hour) ...M 
Blank ..............................blank 
 

Place of Injury-literal 860-909 50 Full text for Place of Injury 

Injury at Work? 910 1 Yes .............................................Y 
No ..............................................N 
Unknown: ...................................U 
Blank ..........................................blank 
N/A (computer generated) ..........X 

 

Describe How Injury 
Occurred-literal 

911-1160 250 Literal information reported in How Injury 
Occurred block 

If Transportation 
Accident, Specify 

1161-1190 30 Driver/Operator ................DR 
Passenger ..........................PA 
Pedestrian .........................PE 
Enter Full Text 

Was an Autopsy 
Performed? 

1191 1 Yes....................................... Y 
No ........................................ N 
Unknown ............................. U 
Blank ...................................  

Were Autopsy Findings 
Available to Complete 
theCause of Death? 

1192 1 Yes....................................Y 
No .....................................N 
Unknown ..........................U 
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Blank ................................ 
N/A: Computer generated.X 

Certifier 1193-1222 30 Certifying Physician ..............D 
Pronouncing and 
Certifying Physician ..............P 
Medical Examiner/Coronor ...M 
Enter full text for other individual legally 
allowed to certify 

Date of surgery: 
Applicable to states 
with a surgery block, 
otherwise blank 

   

Date of surgery - month 1223-1224 2 01-12, 99 (unknown), blank 

Date of surgery - day 1225-1226 2 01-31, 99, blank 

Date of surgery - year 1227-1230 4 4-digit year, 9999, blank 

Incomplete Data Flag 1231 1 Information entered is incomplete 
     (computer-generated)............... 1 
Otherwise...................................... blank 

Line Ib "Due to" Flag 1232 1 "Due to" deleted by certifier ........ 1 
Otherwise...................................... blank 

Line Ic "Due to" Flag 1233 1 "Due to" deleted by certifier ........ 1 
Otherwise...................................... blank 

Line Id "Due to" Flag 1234 1 "Due to" deleted by certifier ........ 1 
Otherwise...................................... blank 

Part II "Due to" Flag 1235 1 "Due to" deleted by certifier ........ 1 
Otherwise...................................... blank 

Activity at time of death 
(computer-generated) 

1236 1 While Engaged in Sports 
  Activity ..................................... 0 
While Engaged in Leisure 
  Activities................................... 1 
While Working for Income......... 2 
While Engaged in Other 
  types of Work .......................... 3 
While Resting, Sleeping, 
  Eating, or engaging in  
  other vital activities ................. 4 
While Engaged in Other 
  specified Activities .................. 8 
During Unspecified Activity ...... 9 

 

Place of Injury 
(computer-generated) 

1237 1 Home ........................................ A  
Farm.......................................... B 
Residential Institution............... C  
Military Residence.................... D  
Hospital..................................... E  
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School, Other Institution, 
  Administrative Area ............... F  
Industrial & Construction ......... G  
Garage/Warehouse.................... H  
Trade and Service Area ............ I  
Mine/Quarry ............................. J  
Street/Highway ......................... K  
Public Recreation Area............. L  
Institutional Recreation Area.... M  
Sports & Recreation Area......... N  
Other Building .......................... O  
Other Specified Place ............... P  
Unspecified Place ..................... Q  
Blank ........................................ blank 

 

Auxiliary state file # 1238-1249 12 000000000001-999999999999, blank 

State Specific Data 1250-1279 30 Optional. Any information entered through 
SuperMICAR for state use only 
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MICAR100 Input File Record Format 

Variable Position Length Description 

Date of Death – Year 01-04 4 Year of Death (Numeric) 

State of Death 05-06 2 Alpha, see FIPS Table 5-2; NCHS Part 8 
Instruction Manual 

Certificate Number 07-12 6 6-digit number, padded with 0's on left 
(000001-999999) 

Coder Status 13 1 Numeric: Valid codes 0 - 9 

Lot 14-17 4 NCHS ID Information, Numeric, 0001-
9999 
(States commonly use "book number") 

Section Number 18 1 NCHS ID Information. Numeric, 0-9 

Shipment Number 19-21 3 NCHS ID Information, Alpha\Numeric 
(Usually month of death or month of 
receipt) 

Receipt Date 22-29 8 NCHS ID Information. Date inserted at the 
time file is received by NCHS-
MMDDYYYY 

PGM Version Control 30-33 4 Version number for the SuperMICAR 
program (computer-generated) 

 

Date of Death - Month 34-35 2 Date of death (month): 01-12. 99 

Date of Death - Day 36-37 2 Date of Death (day): 01-31, 99 

Sex 38 1 Male ................................. M 
Female ............................. F 
Unknown.......................... U 

Age: units 39 1 Years................................ 1 
Months ............................. 2 
Weeks .............................. 3 
Days ................................. 4 
Hours ............................... 5 
Minutes ............................ 6 

Unknown.......................... 9 

Age: number of units 40-42 3 001 - 135, 999 

Incomplete data flag 
(computer-generated) 

43 1 Information entered is  
incomplete-reject record 
for manual review ....................1 
Blank........................................blank 
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Conditions and Durations 44-343 300 Free format field. See MICAR Instruction 
Manual 2g. Information provided through 
use of Entity-Reference Numbers (ERNs). 

Did Tobacco Use Contribute 
to Death? 

344 1 Yes ................................Y 
No .................................N 
Probably........................P 
Unknown.......................U 
Not on certificate ..........C 
Blank.............................blank 

 

Pregnancy 345 1 Not pregnant within past year .......1 
Pregnant at time of death ..............2 
Not pregnant, but pregnant 
within 42 days of death.................3 
Not pregnant, but pregnant 
43 days to 1 year before death ......4 
Unknown if pregnant within 
past year ........................................9 

Blank......................................... blank 

N/A: computer generated.......... 8 
Not on certificate ...................... 7 

If Female (edit flag: from 
EDR only) 

346 1 Edit Passed...............................0 
Edit failed, data queried 
& verified.................................1 
Edit failed, data queried 
but not verified.........................2 

Manner of Death 347 1 Natural ........................................N 
Accident......................................A 
Suicide ........................................S 
Homicide.....................................H 
Pending Investigation .................P 
Could Not be Determined ...........C 
Blank...........................................blank 

 

Date of Injury-month 348-349 2 01-12, 99, blank 

Date of Injury-day 350-351 2 01-31, 99, blank 

Date of Injury-year 352-355 4 4-digit year, 9999, blank 

Time of Injury 356-359 4 0000-2359 (military), 9999, blank 

Injury at Work? 360 1 Yes .............................................Y 
No ..............................................N 
Unknown 
   (computer-generated)...............U 
Blank...........................................blank 
Not Applicable 
   (computer-generated)...............X 
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Describe How Injury 
Occurred 

361-420 60 Free format field. See MICAR Instruction 
Manual 2g. Information provided through 
use of Entity-Reference Numbers (ERNs). 

Was an Autopsy Performed? 421 1 Yes .......................................Y 
No ........................................N 
Unknown..............................U 
Blank....................................blank 

Were Autopsy Findings 
Available to Complete the 
Cause of Death? 

422 1 Yes .........................................Y 
No ..........................................N 
Unknown................................U 
Blank...................................... 
N/A: Computer generated ......X 

Certifier 423-452 30 Certifying Physician ..............D 
Pronouncing and 
Certifying Physician ..............P 
Medical Examiner/Coronor ...M 
Or Enter full text for other individual 
legally allowed to certify 

Date of surgery: Applicable 
to states with a surgery 
block, otherwise blank 

   

Date of surgery - month 453-454 2 01-12, 99, blank 

Date of surgery - day 455-456 2 01-31, 99, blank 

Date of surgery - year 457-460 4 4-digit year, 9999, blank 

Activity at time of death 461 1 While Engaged in Sports 
  Activity ..................................... 0 
While Engaged in Leisure 
  Activities................................... 1 
While Working for Income......... 2 
While Engaged in Other 
  types of Work .......................... 3 
While Resting, Sleeping, 
  Eating, or engaged in  
  other vital activities .................. 4 
While Engaged in Other 
  specified Activities .................. 8 
During Unspecified Activity ...... 9 
Blank........................................... blank 

 

Place of Injury (computer-
generated if file generated 
by SuperMICAR) 

462 1 Home ........................................ A  
Farm.......................................... B 
Residential Institution ............... C  
Military Residence.................... D  
Hospital..................................... E  
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School, Other Institution, 
  Administrative Area................ F  
Industrial & Construction ......... G  
Garage/Warehouse.................... H  
Trade and Service Area............. I  
Mine/Quarry ............................. J  
Street/Highway ......................... K  
Public Recreation Area ............. L  
Institutional Recreation Area .... M  
Sports & Recreation Area ......... N  
Other Building .......................... O  
Other Specified Place................ P  
Unspecified Place ..................... Q  
Blank......................................... blank 

 

Auxiliary state file # 463-474 12 000000000001-999999999999, blank 

State Specific Data 475-504 30 Optional. Any information entered through 
SuperMICAR for state use only 
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MICAR200 Input File Record Format 
 

Variable Position Length Description 

Date of death – Year  01-04 4 Year of Death (Numeric) 

State Code 05-06 2 Alpha, see FIPS Table 5-2; NCHS Part 8 
Instruction Manual 

Certificate Number 07-12 6 6-digit number, padded with 0's on left 
(000001-999999) 

Coder Status 13 1 Numeric: Valid codes 0 - 9 

Lot 14-17 4 NCHS ID Information, Numeric, 0000-
9999 
(States commonly use "book number") 

Section Number 18 1 NCHS ID Information. Numeric, 0-9 

Shipment Number 19-21 3 NCHS ID Information, Alpha\Numeric 
(Usually month of death or month of 
receipt) 

Receipt Date 22-29 8 NCHS ID Information. Data inserted at the 
time file is received by NCHS-
MMDDYYYY 

PGM Version Control – 
SuperMICAR 

30-33 4 Version number for the SuperMICAR 
program (computer-generated) 

 

Date of Death - Month 34-35 2 01-12, 99 

Date of Death - Day 36-37 2 01-31 (based on month), 99 

Sex 38 1 Male ................................. M 
Female ............................. F 
Unknown.......................... U 

Age: units 39 1 Years................................ 1 
Months ............................. 2 
Weeks .............................. 3 
Days ................................. 4 
Hours ............................... 5 
Minutes ............................ 6 

Unknown.......................... 9 

Age: number of units 40-42 3 001 - 135, 999 

Maximum Conditions flag 43 1 More than 20 conditions reported or 
incomplete in SuperMICAR 

Condition Codes (ERN) 
 

44-193 150 
 

Max of 15 codes, 10 positions each code 
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   Position 1-2 
   Position 3-4 
   Position 5-10 
 

  (2) 
  (2) 
  (6) 
 

   Line Number (01-10) 
   Position on the line (1-8) 
   Entity-Reference Number (ERN) 
 

Duration Codes 
 
   Position 1-2 
   Position 3-4 
   Position 5-7 
 

194-298 105 
 
  (2) 
  (2) 
  (3) 

Max of 15 codes, 7 positions each code 
 
   Line Number (01-10) 
   Position on the line (1-8) 
   Duration 
 

Did Tobacco Use Contribute 
to Death? 

299 1 Yes ................................Y 
No .................................N 
Probably........................P 
Unknown.......................U 
Not on certificate ..........C 
Blank.............................blank 

 

Pregnancy 300 1 Not pregnant within past year .........1 
Pregnant at time of death ................2 
Not pregnant, but pregnant 
within 42 days of death...................3 
Not pregnant, but pregnant 
43 days to 1 year before death ........4 
Unknown if pregnant within 
past year ..........................................9 

Blank.............................................  

N/A: computer generated..............8 
Not on certificate ..........................7 

If Female (edit flag: from 
EDR only) 

301 1 Edit Passed.................................. 0 
Edit failed, data queried 
& verified.................................... 1 
Edit failed, data queried 
but not verified............................ 2 

Manner of Death 302 1 Natural ........................................ N 
Accident...................................... A 
Suicide ........................................ S 
Homicide..................................... H 
Pending Investigation ................. P 
Could Not be Determined ........... C 
Blank........................................... blank 

 

Date of Injury-month 303-304 2 01-12, 99, blank 

Date of Injury-day 305-306 2 01-31, 99, blank 

Date of Injury-year 307-310 4 4-digit year, 9999, blank 

Time of Injury 311-314 4 0000-2359 (military), 9999, blank 
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Injury at Work? 315 1 Yes ..........................................Y 
No ...........................................N 
Unknown..................................U 
Blank........................................blank 
N/A (computer-generated) .......X 

 

Was an Autopsy Performed? 316 1 Yes ...........................................Y 
No ............................................N 
Unknown..................................U 
Blank........................................ 

Were Autopsy Findings 
Available to Complete the 
Cause of Death? 

317 1 Yes ...........................................Y 
No ............................................N 
Blank........................................blank 
N/A (computer-generated) .......X 

Title of Certifier 318-347 30 Certifying Physician ..............D 
Pronouncing and 
Certifying Physician ..............P 
Medical Examiner/Coronor ...M 
Enter full text for other individual legally 
allowed to certify 

Date of surgery: Applicable 
to states with a surgery 
block, otherwise blank 

   

Date of surgery - month 348-349 2 01-12, 99, blank 

Date of surgery - day 350-351 2 01-31, 99, blank 

Date of surgery - year 352-355 4 4-digit year, 9999, blank 

Activity at time of death 
(computer-generated) 

356 1 While Engaged in Sports 
  Activity ..................................... 0 
While Engaged in Leisure 
  Activities................................... 1 
While Working for Income......... 2 
While Engaged in Other 
  types of Work .......................... 3 
While Resting, Sleeping, 
  Eating, or engaged in 
  other vital activities................... 4 
While Engaged in Other 
  specified Activities .................. 8 
During Unspecified Activity ...... 9 
Not applicable............................. blank 

 

Place of Injury 
(computer-generated) 

357 1 Home ........................................ A  
Farm.......................................... B 
Residential Institution ............... C  
Military Residence.................... D  
Hospital..................................... E  
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School, Other Institution, 
  Administrative Area................ F  
Industrial & Construction ......... G  
Garage/Warehouse.................... H  
Trade and Service Area............. I  
Mine/Quarry ............................. J  
Street/Highway ......................... K  
Public Recreation Area ............. L  
Institutional Recreation Area .... M  
Sports & Recreation Area ......... N  
Other Building .......................... O  
Other Specified Place................ P  
Unspecified Place ..................... Q  
Blank......................................... blank 

 

No. of codes on each line 358-381 24 12 codes, 2-digits each 

Lowest Used Line in Part I 382-383 2 Numberic, 01-09 

Absolute Lowest Used Line 384-385 2 Numeric, 01-12 

Instruction flag (1) 386 1 Cancer secondary 

Instruction flag (2) 387 1 Part II info from manner of death box 

Instruction flag (3) 388 1 Reserved 

Auxiliary state file # 389-400 12 000000000001-999999999999, blank 

State Specific Data 401-430 30 Optional. Any information entered through 
SuperMICAR for state use only 
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ACME Input File Record Format 
 

Variable Position Length Description 

Date of Death - Year 01-04 4 Year of Death (Numeric) 

State of Death 05-06 2 Alpha, see FIPS Table 5-2; NCHS Part 8 
Instruction Manual 

Certificate Number 07-12 6 6-digit number, padded with 0's on left 
(000001-999999) 

Coder Status 13 1 Numeric: Valid codes 0 - 9 

Lot 14-17 4 NCHS ID Information. Numeric, 0001-9999 
(States commonly use "book number") 

Section Number 18 1 NCHS ID Information, Numeric, 0-9 

Shipment Number 19-21 3 NCHS ID Information, alphanumeric 
(Usually month of death or month of receipt) 

Receipt Date-Month 22-23 2 01-12, blank (inserted at NCHS) 

Receipt Date-Day 24-25 2 01-31, blank (inserted at NCHS) 

Receipt Date-Year 26-29 4 >= Year of death, blank (inserted at NCHS) 

PGM Version Control – 
SuperMICAR 

30-33 4 SuperMICAR version number (computer-
generated) 

PGM Version Control – 
MICAR200 

34-37 4 MICAR200 version number (computer-
generated) 

Age: units 38 1 Years......... 1 
Months ...... 2 
Weeks ....... 3 
Days .......... 4 
Hours ........ 5 
Minutes ..... 6 
Unknown... 9 

Age: number of units 39-41 3 001-135, 999 

Manner of Death 42 1 Natural ....................................N 
Accident ..................................A 
Suicide ....................................S 
Homicide .................................H 
Pending Investigation .............P 
Could Not be Determined .......C 
Blank........................................blank 

 

Intentional Reject 43 1 1-6, 9 or Blank - See NCHS Instruction 
Manual Part 2b for code structure 
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ACME System Reject 
Codes 

44 1 MICAR reject - dictionary match .....1 
ACME reject .....................................2 
MICAR reject- rules application .......3 
Reviewed ...........................................4 
Not Rejected ......................................0 
Blank..................................................blank 

 

Place of Injury (ICD10 
codes) 

45 1 Home ................................................0 
Residential Institution .......................1 
School, Other Institution, 
  Administrative Area ........................2 
Sports & Recreation Area .................3 
Street/Highway .................................4 
Trade and Service Area .....................5 
Industrial & Construction Area .........6 
Farm ..................................................7 
Other Specified Place ........................8 
Unspecified Place .............................9 
Blank..................................................blank 

 

Manual Underlying Cause 
Code 

46-50 5 From input; Blank if not coded. Fifth 
position reserved for use if ICD becomes 5 
digit codes. 

Entity-axis Codes 51-170 120 120 positions; For coding instructions, refer 
to Part 2b Instructional Manual; for data 
entry instructions, refer to Part 2d 
Instructional Manual. 

Was an Autopsy 
Performed? 

171 1 Yes ................................Y 
No .................................N 
Unknown.......................U 

 

Were Autopsy Findings 
Available to Complete 
theCause of Death? 

172 1 Yes .......................................Y 
No ........................................N 
Unknown..............................U 
X (computer-generated) .......N/A 

 

Did Tobacco Use 
Contribute to Death? 

173 1 Yes .......................................Y 
No ........................................N 
Probably...............................P 
Unknown..............................U 
Not on certificate .................C 

 

Pregnancy 174 1 Not pregnant within past year ...... 1 
Pregnant at time of death.............. 2 
Not pregnant, but pregnant 
within 42 days of death ................ 3 
Not pregnant, but pregnant 
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43 days to 1 year before death...... 4 
Unknown if pregnant within 
past year ....................................... 9 

N/A (computer generated) .......... 8 
Not on certificate ........................ 7 

If Female (edit flag: from 
EDR only) 

175 1 Edit Passed....................... 0 
Edit failed, data queried 
& verified......................... 1 
Edit failed, data queried 
but not verified................. 2 
Blank................................ blank 

Date of Injury-month 176-177 2 01-12, 99, blank 

Date of Injury-day 178-179 2 01-31, 99, blank 

Date of Injury-year 180-183 4 4-digit year, 9999, blank 

Time of Injury 184-187 4 0000-2359 (military), 9999, blank 

Injury at Work 188 1 Yes ............................................. Y 
No .............................................. N 
Unknown..................................... U 
Blank........................................... blank 
N/A (computer-generated) .......... X 

 

Title of Certifier 189-218 30 Certifying Physician ..............D 
Pronouncing and 
Certifying Physician ..............P 
Medical Examiner/Coronor ...M 
Enter full text for other individual legally 
allowed to certify 

Activity at time of death 
(computer-generated) 

219 1 While Engaged in Sports 
  Activity ..................................... 0 
While Engaged in Leisure 
  Activities................................... 1 
While Working for Income......... 2 
While Engaged in Other 
  types of Work .......................... 3 
While Resting, Sleeping, 
  Eating, or engaged in 
  other vital activities .................. 4 
While Engaged in Other 
  specified Activities .................. 8 
During Unspecified Activity ...... 9 
Blank........................................... blank 

 

Auxiliary State file # 220-231 12 000000000001-999999999999, blank 

State Specific Data 232-261 30 (Optional) Any information entered through 
SuperMICAR for state use only 
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ACME Message File Format 

Note: The first record of the file will be a standard ACME input record (see the ACME INPUT 
FORMAT). The second through last records will have the format given below. 
 

Variable Position Length Description 

Date of Death – Year 01-04 4 Year of Death (Numeric) 

State of Death 05-06 2 Alpha, see FIPS Table 5-2; NCHS Part 
8 Instruction Manual 

Certificate Number 07-12 6 6-digit number, padded with 0's on left 

Message Number 13-14 2 Numeric 00-99 

Blank Space 15-16 2 Blank 

Message Text 17-195 180 Message text. This will be truncated to 
save space 
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TRANSAX Input File Record Format 

Variable Position Length Description 

Date of Death – Year 01-04 4 0000-9999 (Numeric) Year of Death 

State of Death 05-06 2 Alpha, see FIPS Table 5-2; NCHS Part 8 
Instruction Manual 

Certificate Number 07-12 6 6-digit number, padded with 0's on left 
(000001-999999) 

Coder Status 13 1 Numeric: Valid codes 0 - 9 

Lot 14-17 4 NCHS ID Information, Numeric, 0001-9999 
(States commonly use "book number") 

Section Number 18 1 NCHS ID Information, Numeric, 0-9 

Shipment Number 19-21 3 NCHS ID Information, alphanumeric 
(Usually month of death or month of receipt) 

Receipt Date-Month 22-23 2 01-12, blank (inserted at NCHS) 

Receipt Date-Day 24-25 2 01-31, blank (inserted at NCHS) 

Receipt Date-Year 26-29 4 >= Year of death, blank (inserted at NCHS) 

PGM Version Control – 
SuperMICAR 

30-33 4 SuperMICAR version number (computer-
generated) 

PGM Version Control – 
MICAR200 

34-37 4 MICAR200 version number (computer-
generated) 

PGM Version Control –
ACME/TRANSAX 

38-41 4 ACME/TRANSAX version number 
(computer-generated) 

Manner of Death 42 1 Natural ..........................................N 
Accident ........................................A 
Suicide ..........................................S 
Homicide .......................................H 
Pending Investigation ...................P 
Could Not be Determined .............C 
Blank..............................................blank 

 

Intentional reject 43 1 1-6, or blank. See NCHS Instruction Manual, 
Part 2b for code structure 

ACME system reject codes 44 1 MICAR reject-dictionary 
match ...................................1 
ACME reject........................2 
MICAR reject-rule 
application............................3 

Record reviewed ..................4 



 194

Not rejected..........................0 
Blank....................................  

 

Place of Injury (computer-
generated) 

45 1 Home .............................................. 0 
Residential Institution ..................... 1 
School, Other Institutions, 
  Administrative Area ...................... 2 
Sports & Recreation Area ............... 3 
Street/Highway ............................... 4 
Trade and Service Area ................... 5 
Industrial & Construction Area ....... 6 
Farm ................................................ 7 
Other Specified Place ...................... 8 
Unspecified Place ........................... 9 
Blank................................................ blank 

 

Manual Underlying Cause 
Code 

46-50 5 From input; Blank if not coded. Fifth 
position reserved for use if ICD becomes 5 
digit codes. 

ACME Underlying Cause 
Code  

51-55 5 ACME-selected underlying cause code. Fifth 
position reserved for use if ICD becomes 5 
digit codes. 

Entity-Axis codes 

 
   1. Part/line number(s) 
 
 
 
 
 
 
 
   2. Sequence within line 
 
   3-6. ICD code 
 
   7. Reserved position 
 
 
 
 
 
   8. E-code indication 

56-215 160 
 
 
 
 
 
 
 
 
 
(1) 
 
(4) 
 
(1) 
 
 
 
 
 
(1) 

Maximum of 20 codes. 8 positions each. 
 
Format for each of 8 positions: 
   Part I. Line a .............................. 1 
   Part I. Line b .............................. 2 
   Part I. Line c .............................. 3 
   Part I. Line d .............................. 4 
   Part I. Line e .............................. 5 
   Part II ......................................... 6 
 
1-8 maximum number of codes per line 
 
 
 
Used for NCHS "created" codes; blank for 
all other codes. NOTE: created codes should 
be converted to actual ICD-10 code if the EA 
field is moved to the final mortality data 
record. 
 
& 
blank 
The value coded in the 8th position should 
not be moved to the final mortality data 
record 

Was an Autopsy 
Performed? 

216 1 Yes ................................................ Y 
No ................................................. N 
Unknown....................................... U 
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Were Autopsy Findings 
Available to Complete 
Cause of Death? 

217 1 Yes ................................................ Y 
No ................................................. N 
Unknown....................................... U 
N/A (computer-generated) ............ X 
 

Did Tobacco Use 
Contribute to Death? 

218 1 Yes ................................................ Y 
No ................................................. N 
Probably........................................ P 
Unknown....................................... U 
Not on Certificate.......................... C 
 

Pregnancy 219 1 Not pregnant within past year .............1 
Pregnant at time of death ....................2 
Not pregnant, but pregnant 
within 42 days of death.......................3 
Not pregnant, but pregnant 
43 days to 1 year before death ............4 
Unknown if pregnant within 
past year ..............................................9 
N/A (computer generated) ................. 8 
Not on certificate ............................... 7 

If Female (edit flag: from 
EDR only) 

220 1 Edit Passed.............................0 
Edit failed, data queried 
& verified...............................1 
Edit failed, data queried 
but not verified.......................2 
Blank......................................blank 

Date of Injury-month 221-222 2 01-12, 99, blank 

Date of Injury-day 223-224 2 01-31, 99, blank 

Date of Injury-year 225-228 4 4-digit year, 9999, blank 

Time of Injury 229-232 4 0000-2359 (military), 9999, blank 

Injury at Work? 233 1 Yes ........................................... Y 
No ............................................ N 
Unknown: ................................. U 
Blank......................................... blank 
N/A (computer generated) ........ X 

 

Title of Certifier 234-263 30 Certifying Physician ..............D 
Pronouncing and 
Certifying Physician ..............P 
Medical Examiner/Coronor ...M 
Enter full text for other individual legally 
allowed to certify 

Activity at time of death 
(computer-generated) 

264 1 While Engaged in Sports 
  Activity ..................................... 0 
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While Engaged in Leisure 
  Activities................................... 1 
While Working for Income......... 2 
While Engaged in Other 
  types of Work .......................... 3 
While Resting, Sleeping, 
  Eating, or engaged in  
  other vital activities .................. 4 
While Engaged in Other 
  specified Activities .................. 8 
During Unspecified Activity ...... 9 
Blank........................................... blank 

 

Auxiliary State file # 265-276 12 000000000001-999999999999, blank 

State Specific Data 277-306 30 (Optional) Any information entered through 
SuperMICAR for state use only 
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TRANSAX Output File Record Format 

Variable Position Length Description 

Date of Death - Year 01-04 4 Year of Death (Numeric) 

State Code 05-06 2 Alpha, see FIPS Table 5-2; NCHS Part 8 
Instruction Manual 

Certificate Number 07-12 6 6-digit number, padded with 0's on left 
(000001-999999) 

Coder Status 13 1 Numeric: Valid codes 0 - 9 

Lot 14-17 4 NCHS ID Information, Numeric, 0001-
9999 (States commonly use "book number") 

Section Number 18 1 NCHS ID Information, Numeric, 0-9 

Shipment Number 19-21 3 NCHS ID Information, alphanumeric 
(Usually month of death or month of 
receipt) 

Receipt Date-Month 22-23 2 01-12, blank (inserted at NCHS) 

Receipt Date-Day 24-25 2 01-31, blank (inserted at NCHS) 

Receipt Date-Year 26-29 4 >= Year of death, blank (inserted at NCHS) 

PGM Version Control – 
SuperMICAR 

30-33 4 SuperMICAR version number (computer-
generated) 

PGM Version Control – 
MICAR200 

34-37 4 MICAR200 version number (computer-
generated) 

PGM Version Control –
ACME/TRANSAX 

38-41 4 ACME/TRANSAX version number 
(computer-generated) 

Manner of Death 42 1 Natural ........................................... N 
Accident ......................................... A 
Suicide ........................................... S 
Homicide ........................................ H 
Pending Investigation ..................... P 
Could Not be Determined .............. C 
Blank............................................... blank 

 

Intentional reject 43 1 1-6, or blank. See NCHS Instruction 
Manual, Part 2b for code structure 

ACME system reject codes 44 1 MICAR reject-dictionary 
match....................................1 
ACME reject ........................2 
MICAR reject-rule 
application............................3 
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Record reviewed ..................4 
Not rejected..........................0 
Blank.................................... 

 

Place of Injury  (computer-
generated) 

45 1 Home ............................................. 0 
Residential Institution ................... 1 
School, Other Institutions, 
  Administrative Area .................... 2 
Sports & Recreation Area ............. 3 
Street/Highway ............................. 4 
Trade and Service Area ................. 5 
Industrial & Construction Area ..... 6 
Farm .............................................. 7 
Other Specified Place .................... 8 
Unspecified Place .......................... 9 
Blank..............................................  

 

Manual Underlying Cause 
Code 

46-50 5 From input; Blank if not coded. Fifth 
position reserved for use if ICD becomes 5 
digit codes. 

ACME Underlying Cause 
Code  

51-55 5 ACME-selected underlying cause code. 
Fifth position reserved for use if ICD 
becomes 5 digit codes. 

Entity-Axis codes 

 
   1. Part/line number(s) 
 
 
 
 
 
 
 
   2. Sequence within line 
 
   3-6. ICD code 
 
   7. Reserved position 
 
 
 
 
 
   8. E-code indication 

56-215 160 
 
 
 
 
 
 
 
 
 
(1) 
 
(4) 
 
(1) 
 
 
 
 
 
(1) 

Maximum of 20 codes. 8 positions each. 
 
Format for each of 8 positions: 
   Part I. Line a............................... 1 
   Part I. Line b .............................. 2 
   Part I. Line c............................... 3 
   Part I. Line d .............................. 4 
   Part I. Line e............................... 5 
   Part II ......................................... 6 
 
1-8 maximum number of codes per line 
 
 
 
Used for NCHS "created" codes; blank for 
all other codes. NOTE: created codes 
should be converted to actual ICD-10 code 
if the EA field is moved to the final 
mortality data record. 
 
& 
blank 
The value coded in the 8th position should 
not be moved to the final mortality data 
record 

TRANSAX conversion flag 216 1 Conversion using  



 199

(computer-generated) non-ambivalent table entries ............ 3 
Conversion using 
ambivalent table entries ................... 4 
Duplicate entity-axis codes 
deleted; no other action involved ..... 5 
Artificial code conversion; 
no other action.................................. 6 
No action (blank) ............................. blank 
 

Record-Axis Codes 
 
   1-4. ICD code 
 
   5. Reserved position 

217-316 100 
 
(4) 
 
(1) 

Maximum of 20 codes. 5 positions each: 
 
 
 
5th position blank. Reserved for use if five-
digit codes are implemented (NCHS 
"created" codes are converted to actual 
ICD-10 codes). 
 

Was an Autopsy Performed? 317 1 Yes ................................................ Y 
No.................................................. N 
Unknown....................................... U 
 

Were Autopsy Findings 
Available to Complete 
Cause of Death? 

318 1 Yes ................................................ Y 
No.................................................. N 
Unknown....................................... U 
N/A (computer-generated) ............ X 
 

Did Tobacco Use Contribute 
to Death? 

319 1 Yes ................................................ Y 
No.................................................. N 
Probably ........................................ P 
Unknown....................................... U 
Not on Certificate.......................... C 
 

Pregnancy 320 1 Not pregnant within past year ............ 1 
Pregnant at time of death ................... 2 
Not pregnant, but pregnant 
within 42 days of death ...................... 3 
Not pregnant, but pregnant 
43 days to 1 year before death............ 4 
Unknown if pregnant within 
past year ............................................. 9 
N/A: computer generated ................... 8 
Not on certificate................................ 7 

If Female (edit flag: from 
EDR only) 

321 1 Edit Passed .............................. 0 
Edit failed, data queried 
& verified ................................ 1 
Edit failed, data queried 
but not verified........................ 2 
Blank....................................... blank 

Date of Injury-month 322-323 2 01-12, 99, blank 
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Date of Injury-day 324-325 2 01-31, 99, blank 

Date of Injury-year 326-329 4 4-digit year, 9999, blank 

Time of Injury 330-333 4 0000-2359 (military), 9999, blank 

Injury at Work? 334 1 Yes ..............................................Y 
No ...............................................N 
Unknown: ....................................U 
Blank ........................................... 
N/A (computer generated)...........X 

 

Title of Certifier 335-364 30 Certifying Physician...............D 
Pronouncing and 
Certifying Physician...............P 
Medical Examiner/Coronor....M 
Enter full text for other individual legally 
allowed to certify 

Activity at time of death 
(computer-generated) 

365 1 While Engaged in Sports 
  Activity .....................................0 
While Engaged in Leisure 
  Activities ...................................1 
While Working for Income .........2 
While Engaged in Other 
  types of Work ...........................3 
While Resting, Sleeping, 
  Eating, or engaged in  
  other vital activities ..................4 
While Engaged in Other 
  specified Activities ...................8 
During Unspecified Activity ......9 
Blank...........................................blank 

 

Auxiliary State file # 366-377 12 000000000001-999999999999, blank 

State Specific Data 378-407 30 (Optional) Any information entered through 
SuperMICAR for state use only 
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Hotkeys 

SuperMICAR Hotkey List 

Hotkeys Accessible from Main Screen  

File: New Ctrl + F2 

 
Open F2 

 
Close Ctrl 

+ F4

 
Import Shift 

+ F8

 
Export Shift 

+ F7

 
Delete Ctrl 

+ D 

 
Restore Alt 

+ F8

 
Exit Alt 

+ X 

Edit: Certificates F4 

 
Delete Certificates F8 

Process: All Records Ctrl 
+ P 

View/Re
ports 

Print All 
Certificates 

F7 

Backup: All Alt 
+ F7

Tools: Sequence Check Ctrl 
+ S 

 
Filter Ctrl 

+ F 

 
Build ARJ File Ctrl 

+ A 

 
Change Certificate 
Digits 

Ctrl 
+ C 

Help: Contents F1 
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Hotkeys Accessible from Certificate Edit Screen  

Help (context) F1 

Function Key List Alt + F1 

Find Certificate F5 

Show Processed Info F6 

Print Certificate F7 

Delete Certificate F8 

Additional Information (AI) F9 

Goto Part I Alt + 1 

Goto Part II Alt + 2 

Goto State-Specific Data Alt + S 

Goto Certifier Field Alt + C 

Mark Out (Due To) Alt + D 

Incomplete Alt + I 

Wipe Field Alt + W 

End Editing/Adding Alt + F9 

End Editing/Adding Esc 

Beginning of Field Home 

End of Field End 

Next Field Tab, or Enter, or Down Arrow 

Previous Field Shift + Tab, or Up Arrow 

First Field Ctrl + Home 

Last Field Ctrl + End 

Next Record Page Down 

Previous Record Page Up 

First Record Ctrl + Page Up 

Last Record Ctrl + Page Down 
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MICAR200 Hotkey List 

File Open F2 

File Close Ctrl + F4 

Exit Alt + X 

Help Contents F1 
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ACME/TRANSAX Hotkey List 

Hotkeys Accessible from Main Screen  

Create New File Ctrl + F2 

Open File F2 

Close File Ctrl + F4 

Edit / Browse Certificate F4 

Help Contents F1 

 

Hotkeys Accessible from Certificate Edit Screen  

Find Record F5 

Delete Record F8 

Next Record Page Down 

Previous Record Page Up 

First Record Ctrl + Page Up 

Last Record Ctrl + Page Down 

Show Messages Alt + M 

Goto Part II Alt + 2 

Goto MUC F7, or Alt + U 

Delete Cell Ctrl + D 

Wipe Field Ctrl + W 

Add Line Ctrl + Enter 

Delete Line Ctrl + Backspace 

End Editing End 

Next Field Tab 

Next Line Down Arrow 

Previous Field Shift + Tab, or Up Arrow 

First Field Ctrl + Home 

Last Field Ctrl + End 

Move Cursor Left Left Arrow 
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Move Cursor Right Right Arrow 

Delete previous character Backspace 

Delete next character Delete 
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NCHS codes 

NCHS State Code List 
 
State Abbreviation  State Abbreviation 

Alabama AL  Montana MT 

Alaska AK  Nebraska NE 

Arizona AZ  Nevada NV 

Arkansas AR  New Hampshire NH 

California CA  New Jersey NJ 

Colorado CO  New Mexico NM 

Connecticut CT  New York NY 

Delaware DE  New York City YC* 

Dist. of Columbia DC  North Carolina NC 

Florida FL  North Dakota ND 

Georgia  GA  Ohio OH 

Hawaii HI  Oklahoma OK 

Idaho ID  Oregon OR 

Illinois IL  Pennsylvania PA 

Indiana IN  Rhode Island RI 

Iowa IA  South Carolina SC 

Kansas KS  South Dakota SD 

Kentucky KY  Tennessee  TN 

Louisiana LA  Texas TX 

Maine ME  Utah UT 

Maryland MD  Vermont VT 

Massachusetts MA  Virginia VA 

Michigan MI  Washington WA 

Minnesota MN  West Virginia WV 

Mississippi MS  Wisconsin WI 

Missouri MO  Wyoming WY 
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Territory/Area Abbreviation  Territory/Area Abbreviation 

American Samoa AS  US Minor Outlying 
Islands: 
   Baker Island 
   Howland Island 
   Jarvis Island 
   Johnston Atoll 
   Kingman Reef 
   Midway Islands 
   Navassa Island 
   Palmyra Atoll 
   Wake Island 

UM** 

Federated States 
of Micronesia 

FM    

Guam  GU    

Marshall Islands MH    

Northern Mariana 
Islands 

MP    

Palau PW    

Puerto Rico PR    

Virgin Islands 
(US) 

VI    

 

 * Code YC is used for occurrence data only. When coding residence data on the demographic file, code 
NY (New York) must be used. 

 ** Not recognized as a valid USPS State abbreviation 
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Place Codes for SuperMICAR 

A. Home 

Excludes: Abandoned or derelict house (P) 
Home under construction, but not yet occupied (G) 
Institutional Place of Residence (C) 

About home 

Private driveway to home 

Apartment 

Private Garage 

Boarding house 

Private Garden to home 

Cabin 

Private Walk to home 

Farm house 

Private Wall to home 

Hogan 

Residence 

Home for the sick 

Swimming pool in private home or garden 

Home premises 

Trailer camp or court 

Home sidewalk 

Yard to home 

Home swimming pool 

Yard NOS 

Hospice 

House (residential) 

Noninstitutional place of residence 

Penthouse 
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B. Farm 

Excludes: Farm House and Home Premises of Farm (A) 

Barn NOS 

Barnyard 

Corncrib 

Cornfield 

Dairy (farm) NOS 

Farm buildings 

Farm pond or creek 

Farmland under cultivation 

Field, numbered or specialized 

Gravel pit on farm 

Orange grove 

Pasture 

Range NOS 

Silo 

State farm 

Ranch NOS 

 

C. Residential Institution 

Almshouse 

Children’s home 

Dormitory 

Fraternity house 

Institution (any type) 

Jail 

Nurse’s home 

Nursing home 

Old people’s home 

Orphanage 
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Prison camp 

Prison 

Reform school 

State school 

Sorority house 

 

D. Military Residence 

Army Camp 

Military reservation 

 

E. Hospital 

Hospital 

 

F. School, Other Institution, Administrative Area 

Excludes: Building Under Construction (G) 
Residential Institution (C) 
Sports and Athletic Areas (N) 

Armory 

Assembly hall 

Campus 

Child center 

Clubhouse 

Church 

Cinema 

College 

Country club (grounds) 

Court house 

Dance hall 

Day nursery 

Drive in theatre 

Fire house 
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Gallery 

Health resort 

Institute of Higher Learning 

Kindergarten 

Library 

Mission 

Movie house 

Music Hall 

Night club 

Opera house 

Police precinct 

Police station or cell 

Post office 

Private club 

Public Hall 

Salvation army 

School (grounds) (yard) 

School (private) (public) (state) 

Theatre 

Turkish bath 

University 

YMCA 

YWCA 

Youth center 

 

G. Industrial and Construction Areas 

Building under construction 

Coalyard 

Construction job 

Dairy processing plant 
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Dockyard 

Dry dock 

Electric tower 

Factory (building) (premises) 

Foundry 

Grain elevator 

Highway under construction 

Industrial yard 

Loading platform - factory 

Logging operation area 

Mill pond 

Oil field 

Oil rig and other offshore installations 

Oil well 

Plant, industrial 

Power-station (coal) (nuclear) (oil) 

Produce building 

Railroad track or trestle 

Railway yard 

Sawmill 

Sewage disposal plant 

Shipyard 

Shop 

Substation (power) 

Subway track 

Tannery 

Wharf 

Workshop 
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H. Garage/Warehouse 

Excludes: Garage in Private Home (A) 

Body shop 

Garage NOS 

Garage - place of work 

Loading platform - store 

Warehouse 

 

I. Trade and Service Area 

Excludes: Garage in Private Home (A) 

Airport 

Bank 

Bar 

Cafe 

Casino 

Electric company 

Filling station 

Funeral Home 

Garage away from highway except home 

Garage building (for car storage) 

Gas station 

Hotel 

Motel 

Market (grocery or other commodity 

Office (building) 

Radio/Television broadcasting station 

Restaurant 

Salvage Lot, Named 

Shop, commercial 

Shopping center (Shopping mall) 
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Station (bus) (railway) 

Store 

Subway (stairs) 

Tourist court 

Tourist home 

 

J. Mine/Quarry 

Coal pit 

Gravel pit 

Sand pit 

Tunnel under construction 

 

K. Street/Highway 

Alley 

Bridge NOS 

Freeway 

Interstate 

Motorway 

Pavement 

Roadside 

Road 

Sidewalk NOS 

Named Street/Highway/Interstate 

 

L. Public Recreation Area 

Beach - NOS (Private) (Named) 

Beach resort 

Boy’s camp 

Holiday camp 

Lake resort 
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Mountain cabin 

Mountain resort 

Named lake 

Park (any) (Amusement) (Public) 

Playground NOS 

Resort NOS 

Seashore resort 

Vacation resort 

 

M. Institutional Recreation Area 

Playground, school 

 

N. Sports and Athletics Area 

Excludes: Swimming Pool or Tennis Court in private home or garden (A) 

Baseball field 

Basketball court 

Cricket ground 

Dude ranch 

Fives court 

Football field 

Golf course 

Gymnasium 

Hockey field 

Hunting cabin 

Ice palace 

Racecourse 

Riding school 

Rifle range - NOS 

Skating rink 

Sports palace 
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Sports ground 

Stadium 

Swimming pool (public) (private) 

Tennis court 

 

O. Other Building 

Building NOS 

 

P. Other Specified Place 

Abandoned gravel pit 

Abandoned public building or home 

Air force firing range 

Bar pit or ditch 

Beach NOS 

Camp 

Camping grounds 

Canal 

Caravan site NOS 

Cemetery 

City dump 

Damsite 

Derelict house 

Desert 

Ditch 

Dock NOS 

Excavation site 

Fairgrounds 

Field NOS 

Forest 

Fort 
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Harbor 

Hill 

Irrigation canal or ditch 

Junkyard 

Lake NOS 

Manhole 

Marsh 

Mountain 

Named city 

Named town 

Nursery NOS 

Open field 

Parking lot 

Parking place 

Pier 

Pipeline (oil) 

Place of business NOS 

Pond or pool (natural) 

Powerline pole 

Prairie 

Private property 

Public place NOS 

Public property 

Railway line 

Reservoir (Water) 

River 

Sea 

Seashore NOS 

Sewer 

Specified address 
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Stream 

Swamp 

Woods 

Zoo 

 

Q. Unspecified Place 

Bed 

Commode 

Country 

Downstairs 

Fireplace 

Jobsite 

Near any place 

On job 

Parked car 

Sofa 

Table 

Tree 
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Place Codes for ACME/TRANSAX 

ACME/TRANSAX uses numeric codes to represent the alpha place of injury codes specified in 
SuperMICAR. The numeric equivalents to the letter codes are: 

 

Numeric 
Code 

Description Letter Code(s) 

0 Home A 

1 Residential Institution C, D 

2 School, other institution and public administrative area E, F, M 

3 Sports and athletics area N 

4 Street and highway K 

5 Trade and service area H, I 

6 Industrial and construction area G, J 

7 Farm B 

8 Other specified places L, O, P 

9 Unspecified place Q 

Blank Not applicable blank 
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Activity Codes 

0 While engaged in sports activity 

Physical exercise with a described functional element such as: 

. golf 

. jogging 

. riding 

. school athletics   

. skiing 

. swimming 

. trekking 

. waterskiing 

 

1 While engaged in leisure activity 

Hobby activities 

Leisure time activities with an entertainment element such as going to the cinema, to a dance or to 
a party  

Participation in sessions and activities of voluntary organizations 

 
Excludes: sport activities (.0) 

 

2 While working for income 

Paid work (manual)(professional) 

Transportation (time) to and from such activities 

Work for salary, bonus and other types of income 

 

3 While engaged in other types of work 

Domestic duties such as: 

. caring for children and relatives 

. cleaning 

. cooking 
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. gardening 

. household maintenance 

Duties for which one would not normally gain an income  

Learning activities, e.g. attending school session or lesson 

Undergoing education 

 

4 While resting, sleeping, eating and other vital activities 

Personal hygiene 

 

8 While engaged in other specified activities 

 

9 During unspecified activity 

 

Blank blank 

 


